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Lời nói đầu

Trong nh÷ng n¨m gÇn ®©y, cïng víi sù ph¸t triÓn cña C«ng nghÖ th«ng 

tin, m¹ng m¸y tÝnh ®ang ®−îc ph¸t triÓn réng r·i, mét trong nh÷ng øng dông 

phæ biÕn trªn m¹ng m¸y tÝnh lµ Internet vµ c¸c dÞch vô trë nªn kh«ng thÓ thiÕu 

trong cuéc sèng hiÖn ®¹i. §Ó phôc vô viÖc häc tËp nghiªn cøu cña sinh viªn 

cao ®¼ng CNTT, t¸c gi¶ biªn so¹n gi¸o tr×nh ThiÕt kÕ Web. Gi¸o tr×nh bao gåm 

5 ch−¬ng, mçi ch−¬ng ®Òu cã phÇn kiÕn thøc lý thuyÕt vµ c©u hái nghiªn cøu 

cô thÓ. 

Ch−¬ng 1: Giíi thiÖu chung 

Giíi thiÖu c¸c kh¸i niÖm c¬ b¶n vÒ m¹ng m¸y tÝnh, Internet, ®Þa chØ IP, 

giao thøc truyÒn th«ng vµ c¸c kh¸i niÖm kh¸c. 

Ch−¬ng 2: C¸c thµnh phÇn c¬ b¶n cña HTML 

Tr×nh bµy kh¸i niÖm ng«n ng÷ ®¸nh dÊu siªu v¨n b¶n, c¸c thµnh phÇn c¬ 

b¶n vµ cÊu tróc cña mét tËp tin HTML. Giíi thiÖu c¸c vÊn ®Ò liªn quan ®Õn 

viÖc sö dông có ph¸p vµ hiÖu øng cña ng«n ng÷ ®¸nh dÊu siªu v¨n b¶n, ®Ó lËp 

tr×nh Web. 

Ch¬ng 3: Thao t¸c víi phÇn mÒm t¹o Web

Giíi thiÖu vÒ viÖc øng dông phÇn mÒm Macromedia Dreamweaver MX 

®Ó thiÕt kÕ c¸c trang web tÜnh c¬ b¶n.

Ch−¬ng 4: Nh÷ng kiÕn thøc c¬ b¶n vÒ VBScript 

Giíi thiÖu ng«n ng÷ kÞch b¶n phæ biÕn hiÖn nay lµ VBScript. H−íng 

dÉn c¸c b−íc tiÕn hµnh khai b¸o, lËp tr×nh vµ sö dông ng«n ng÷ kÞch b¶n trong 

HTML. 

Ch−¬ng 5: Liªn kÕt trang web ®Õn hÖ c¬ së d÷ liÖu – X©y dùng c¸c trang 

web ®éng c¬ b¶n.  

Giíi thiÖu lËp tr×nh Web ®éng víi c«ng nghÖ ASP (Active Server Page). 

C¸c kh¸i niÖm c¬ b¶n, c¸c ®èi t−îng c¬ b¶n trong ASP, øng dông vµo lËp tr×nh 

mét trang Web ®éng cô thÓ. 



Giíi thiÖu ADO (ActiveX Data Object), c¸c ®èi t−îng cña ADO, c¸ch thøc 

kÕt 

nèi víi c¬ së d÷ liÖu

Ch¬ng 6: ThiÕt kÕ web ®éng b»ng Macromedia Dreamweaver

Híng dÉn c¸ch x©y dùng trang Master – Detail trong Dreamweaver ®Ó 

x©y dùng mét trang web ®éng c¬ b¶n.

Gi¸o tr×nh ThiÕt kÕ Web h−íng dÉn c¸ch x©y dùng mét øng dông Web 

tõ c¬ b¶n ®Õn n©ng cao b»ng c«ng nghÖ HTML vµ ASP. §−îc biªn so¹n víi  

ph−¬ng ch©m ®¶m b¶o tÝnh logic, khoa häc, thiÕt thùc, dÔ hiÓu nh»m trang 

bÞ cho sinh viªn nh÷ng kiÕn thøc c¬ b¶n, phôc vô cho nghiªn cøu, thiÕt kÕ, lËp 

tr×nh mét øng dông Web hoµn chØnh. 

Tµi liÖu nµy ®−îc tham kh¶o tõ mét sè tµi liÖu cña c¸c t¸c gi¶ trong n−íc, 

tæng hîp vµ l−îc dÞch tõ mét sè tµi liÖu chuyªn ngµnh cña n−íc ngoµi, nªn mét 

sè thuËt ng÷ Tin häc kh«ng thÓ thay thÕ b»ng tiÕng ViÖt. §Ó tiÖn cho viÖc 

tr×nh bµy ý t−ëng xuyªn suèt cña tµi liÖu, t¸c gi¶ ®Ó nguyªn b¶n thuËt ng÷ 

tiÕng Anh  vµ  gi¶i  thÝch  b»ng thuËt  ng÷  tiÕng ViÖt  nÕu cã  côm tõ  t−¬ng 

®−¬ng. 

Trong gi¸o tr×nh nµy cã kÌm theo mét sè file phôc vô cho qu¸ tr×nh häc 

tËp, v× vËy sinh viªn cÇn liªn hÖ víi gi¸o viªn gi¶ng d¹y ®Ó lÊy c¸c file phôc vô 

trong  qu¸  tr×nh  häc  tËp  hoÆc  liªn  hÖ  víi  t¸c  gi¶  theo  ®Þa  chØ 

hieulv68@yahoo.com.

Tuy cã nhiÒu cè g¾ng trong c«ng t¸c biªn so¹n, nh−ng vÉn kh«ng tr¸nh 

khái thiÕu sãt. Trong ph¹m vi h¹n hÑp cña cuèn tµi liÖu nµy, kh«ng thÓ ®Ò cËp 

®−îc tÊt c¶ nh÷ng vÊn ®Ò nãng hæi trong lÜnh vùc thiÕt kÕ vµ lËp tr×nh Web 

®ßi hái. 

RÊt mong sù ®ãng gãp phª b×nh tõ b¹n ®äc, ®Ó tµi  liÖu ®−îc hoµn 

chØnh h¬n. 

Mäi ý kiÕn gãp ý, xin göi vÒ Tr−êng cao ®»ng nghÒ c¬ ®iÖn – Khoa 

CNTT. 

 

T¸c gi¶

mailto:hieulv68@yahoo.com


Chương 1

Giới thiệu chung

Ch¬ng nµy nh¾c l¹i mét sè kh¸i niÖm vÒ m¹ng m¸y tÝnh. Nh chóng ta ®· 

biÕt, website ®îc ph¸t triÎn trªn m«i trêng m¹ng vµ cô thÓ lµ m«i trêng internet. 

NÕu øng dông website cña chóng ta kh«ng cã m«i trêng m¹ng th× øng dông 

web cña chóng ta kh«ng kh¸c g× mét phÇn mÒm desktop.

Môc tiªu

Sau khi häc xong ch¬ng nµy, chóng ta sÏ:

 Ph©n lo¹i ®îc c¸c giao thøc sö dông trªn m¹ng m¸y tÝnh.

 Ph©n lo¹i ®îc c¸c lo¹i ®Øa chØ IP.

 Ph©n tÝch ®îc c¸c bíc chÝnh trong qu¸ tr×nh ph¸t triÓn website.

 Ph©n biÖt ®îc c¸c kh¸i niÖm URL, Hyperlink, Web Server ...

 Ph©n biÖt ®îc c¸c lo¹i website.



1. M ng máy tínhạ

1.1 Định nghĩa

Trong  qu¸  tr×nh  khai  th¸c,  sö  dông  m¸y  tÝnh  c¸  nh©n  (Personal 

Computer-PC), viÖc trao ®æi, sö dông th«ng tin cña mét x· héi ph¸t triÓn cã 

nhu cÇu to lín. Khi c¸c m¸y vi tÝnh ch−a cã sù liªn kÕt víi nhau, th× viÖc trao 

®æi th«ng tin mÊt rÊt nhiÒu thêi gian ®Ó sao chÐp, g©y nhiÒu phiÒn phøc. 

§Ó gi¶i quyÕt vÊn ®Ò trªn víi ®µ ph¸t triÓn cña nÒn c«ng nghiÖp m¸y tÝnh, c¸c 

thiÕt bÞ ®Æc biÖt vµ m¹ng m¸y tÝnh ra ®êi lµ mét tÊt yÕu. 

V× vËy, m¹ng (network) lµ mét tËp hîp c¸c hÖ thèng m¸y tÝnh vµ c¸c 

thiÕt bÞ m¹ng, chia sÎ d÷ liÖu, ch−¬ng tr×nh, tµi nguyªn th«ng qua mét ®−êng 

truyÒn kÕt nèi truyÒn th«ng dïng chung, trªn c¬ së mét hÖ ®iÒu hµnh m¹ng.  

H×nh 1.1: M¹ng m¸y tÝnh ®iÓn h×nh

§−êng truyÒn lµ mét hÖ thèng c¸c thiÕt bÞ truyÒn dÉn vËt lý ®Ó 

chuyÓn t¶i c¸c tÝn hiÖu sãng ®iÖn tõ. 



§−êng truyÒn vËt lý cã thÓ ph©n lµm 2 lo¹i: 

­ H÷u tuyÕn: c¸p ®ång trôc, c¸p ®«i d©y xo¾n, c¸p quang, c¸p ®iÖn tho¹i, 

vµ c«ng nghÖ míi nhÊt hiÖn nay lµ c¸p ®iÖn n¨ng th«ng th−êng. 

­ V« tuyÕn: sãng cùc ng¾n (viba), tia hång ngo¹i... 

1.2 Phân loại

HiÖn nay, th«ng th−êng m¹ng m¸y tÝnh ®−îc ph©n lo¹i nh− sau: 

a. M¹ng côc bé - LAN (Local Area Network) 

C¸c m¸y tÝnh c¸ nh©n vµ c¸c m¸y tÝnh kh¸c trong ph¹m vi mét khu vùc 

h¹n chÕ ®−îc nèi víi  nhau b»ng  c¸c d©y c¸p chÊt l−îng tèt, sao cho nh÷ng 

ng−êi sö dông cã thÓ trao ®æi th«ng tin, dïng chung c¸c thiÕt bÞ ngo¹i vi, vµ sö 

dông c¸c ch−¬ng tr×nh còng nh− c¸c d÷ liÖu ®· ®−îc l−u tr÷ trong mét m¸y tÝnh 

dµnh riªng gäi lµ m¸y dÞch vô tÖp.  

b. M¹ng diÖn réng - WAN (Wide Area Network) 

C¸c m¹ng lín h¬n, gäi lµ m¹ng diÖn  réng (Wide Area Network), dïng c¸c 

®−êng d©y ®iÖn tho¹i hoÆc c¸c ph−¬ng tiÖn liªn l¹c kh¸c ®Ó liªn kÕt l¹c kh¸c 

®Ó liªn kÕt c¸c m¸y tÝnh víi nhau trong ph¹m vi tõ vµi chôc ®Õn vµi ngµn dÆm. 

Sù kh¸c nhau gi÷a LAN vµ WAN: kh¸c nhiÒu vÒ quy m« vµ møc ®é phøc 

t¹p, m¹ng côc bé cã thÓ chØ liªn kÕt vµi ba m¸y tÝnh c¸ nh©n vµ mét thiÕt bÞ 

ngo¹i vi dïng chung ®¾t tiÒn, nh− m¸y in laser ch¼ng h¹n. C¸c hÖ thèng phøc 

t¹p h¬n th× cã c¸c m¸y tÝnh trung t©m (m¸y dÞch vô tÖp) vµ cho phÐp nh÷ng 

ng−êi dïng tiÕn hµnh th«ng tin víi nhau th«ng qua th− ®iÖn tö ®Ó ph©n phèi 

c¸c ch−¬ng tr×nh nhiÒu ng−êi sö dông, vµ ®Ó th©m nhËp vµo c¸c c¬ së d÷ 

liÖu dïng chung. 

c. M¹ng ®« thÞ - MAN (Metropolitan Area Network) 

Lµ mét m¹ng tr¶i dµi trªn mét kh«ng gian ®Þa lý lín h¬n LAN nh−ng nhá 

h¬n WAN. MAN th−êng ®−îc sö dông nh− mét m¹ng cña mét thµnh phè, mét 

khu c«ng nghiÖp. 



d. M¹ng Intranet

Lµ mét m¹ng sö dông néi bé nh− LAN hay WAN thùc hiÖn ®−îc c¸c øng 

dông, nãi c¸ch kh¸c lµ c¸c dÞch vô cña INTERNET, chñ yÕu lµ dÞch vô WEB víi 

giao thøc truyÒn tÖp siªu v¨n b¶n -HTTP. 

e. M¹ng Internet 

Mét hÖ thèng gåm c¸c m¹ng m¸y tÝnh ®−îc liªn kÕt víi nhau trªn ph¹m vi 

toµn thÕ giíi, t¹o ®iÒu kiÖn thuËn lîi cho c¸c dÞch vô truyÒn th«ng d÷ liÖu, nh− 

®¨ng nhËp tõ xa, truyÒn c¸c tÖp tin, th− tÝn ®iÖn tö, vµ c¸c nhãm th«ng tin. 

Internet lµ mét ph−¬ng ph¸p ghÐp nèi c¸c m¹ng m¸y tÝnh hiÖn hµnh, ph¸t triÓn 

mét c¸ch réng r·i tÇm ho¹t ®éng cña tõng hÖ thèng thµnh viªn

2 Internet 

M¹ng Internet ngµy nay lµ mét m¹ng  toµn cÇu, bao gåm hµng chôc triÖu 

ng−êi sö dông, ®−îc h×nh thµnh tõ cuèi thËp kû 60 tõ mét thÝ nghiÖm cña Bé 

quèc phßng Mü. T¹i thêi ®iÓm ban ®Çu ®ã lµ m¹ng ARPAnet cña Ban qu¶n lý 

dù ¸n nghiªn cøu Quèc phßng. ARPAnet lµ mét m¹ng thö nghiÖm phôc vô c¸c 

nghiªn cøu quèc phßng, mét trong nh÷ng môc ®Ých cña nã lµ x©y dùng mét 

m¹ng m¸y tÝnh cã kh¶ n¨ng chÞu ®ùng c¸c sù cè (vÝ dô mét sè nót m¹ng bÞ 

tÊn c«ng vµ ph¸ huû nh÷ng m¹ng vÉn tiÕp tôc ho¹t ®éng).  

M¹ng cho phÐp mét m¸y tÝnh bÊt kú trªn m¹ng liªn l¹c víi mäi m¸y tÝnh 

kh¸c. Kh¶ n¨ng kÕt nèi c¸c hÖ thèng m¸y tÝnh kh¸c nhau ®· hÊp dÉn mäi ng−êi, 

v¶ l¹i ®©y còng lµ ph−¬ng ph¸p thùc tÕ duy nhÊt ®Ó kÕt nèi c¸c m¸y tÝnh cña 

c¸c h·ng kh¸c nhau.  

M¹ng Internet nguyªn thuû ®−îc thiÕt kÕ nh»m môc ®Ých phôc vô viÖc 

cung cÊp th«ng tin cho giíi khoa häc, nªn c«ng nghÖ cña nã cho phÐp mäi hÖ 

thèng ®Òu cã thÓ liªn kÕt víi nã th«ng qua mét cæng ®iÖn tö. Theo c¸ch ®ã, 

cã hµng ngµn hÖ m¸y tÝnh hîp t¸c, còng nh− nhiÒu hÖ thèng dÞch vô th− ®iÖn 

tö cã thu phÝ, nh− MCI vµ Compuserve ch¼ng h¹n, ®· trë nªn thµnh viªn cña 

Internet. Víi h¬n hai triÖu m¸y chñ phôc vô chõng 20 triÖu ng−êi dïng, m¹ng 

Internet ®ang ph¸t triÓn víi tèc ®é bïng næ, mçi th¸ng cã thªm kho¶ng mét triÖu 

ng−êi tham gia míi. 



Ngµy nay Internet cho phÐp hµng tr¨m triÖu ng−êi trªn kh¾p thÕ giíi liªn 

l¹c vµ trao ®æi th«ng tin víi nhau th«ng qua tËp c¸c giao thøc gäi chung lµ bé 

giao thøc TCP/IP (Transmission Control Protocol/Internet Protocol). 

3.  Các giao th c Internet ứ

Ban ®Çu, bé giao thøc Internet (cßn gäi lµ bé giao thøc TCP/IP) ®−îc 

ph¸t triÓn bëi DoD (bé quèc phßng Mü) vµ ®−îc ®−a vµo triÓn khai tõ n¨m 1982 

®Ó cung cÊp dÞch vô t¨ng c−êng tÝn hiÖu trªn c¸c liªn m¹ng lín, kÕt hîp nhiÒu 

kiÓu m¸y tÝnh kh¸c nhau. TCP/IP cho phÐp c¸c lo¹i m¸y tÝnh víi c¸c kÝch cì 

kh¸c nhau liªn kÕt víi Internet ®Ó giao tiÕp víi nhau. Hç trî trªn phÇn lín c¸c hÖ 

thèng, TCP/IP trë thµnh giao thøc chuÈn cña Internet. PhÇn TCP cña giao thøc 

nµy ®¶m b¶o r»ng rÊt c¶ l−îng th«ng tin göi ®i ®Òu ®−îc nhËn ®Çy ®ñ vµ 

chÝnh x¸c. PhÇn IP cung cÊp kü thuËt truyÒn dÉn c¸c gãi th«ng tin tíi ®Þa chØ 

nhËn mét c¸ch cã hiÖu qu¶. Trong nh÷ng n¨m gÇn ®©y, c¸c giao thøc Internet  

ngµy cµng phæ biÕn vµ h×nh thµnh c¸c giao thøc m¹ng phæ dông nhÊt hiÖn 

nay. 

Cã nhiÒu giao thøc kÕt hîp víi bé giao thøc Internet. D−íi ®©y lµ c¸c m« 

t¶ mét sè giao thøc nµy. 

3.1 Giao thức điều khiển phiên truyền

Giao thøc ®iÒu khiÓn phiªn truyÒn (Transmission Control Protocol-TCP) 

lµ mét giao thøc Internet t−¬ng øng víi tÇng giao vËn cña OSI. TCP cung cÊp 

kh¶ n¨ng chuyÓn t¶i h−íng kÕt nèi, song c«ng ®Çy ®ñ (full dupplex). Khi kh«ng 

cÇn phÇn ®iÒu hµnh chung cña mét tiÕn tr×nh chuyÓn t¶i h−íng kÕt nèi th× 

giao thøc gam d÷ liÖu ng−êi dïng (User Datagram Protocol-UDP) cã thÓ ®−îc 

thay thÕ cho TCP ë cÊp chuyÓn t¶i (gi÷a c¸c m¸y chñ). TCP vµ UDP ho¹t ®éng 

t¹i cïng mét tÇng. TCP t−¬ng øng víi SPX trong m«i tr−êng Netware. TCP duy 

tr× mét tuyÕn kÕt nèi logic gi÷a c¸c m¸y tÝnh göi vµ nhËn. Theo c¸ch nµy, tÝnh 

nguyªn vÑn cña phiªn truyÒn ®−îc duy tr×, TCP nhanh chãng ph¸t hiÖn mäi sù 

cè trong phiªn truyÒn ®Ó chØnh lý, nh−ng ng−îc l¹i, TCP kh«ng ch¹y nhanh 

b»ng UDP. TCP cßn cung cÊp tÝnh n¨ng ph©n chia vµ tËp hîp c¸c th«ng ®iÖp, 

®ång thêi cã thÓ chÊp nhËn c¸c th«ng ®iÖp cã kÝch th−íc bÊt kú tõ c¸c giao 

thøc tÇng phÝa trªn. TCP ph©n chia c¸c luång th«ng ®iÖp thµnh c¸c ph©n ®o¹n 

mµ IP cã thÓ ®iÒu khiÓn vµ qu¶n lý. Khi sö dông kÕt hîp víi IP, TCP bæ sung 



dÞch vô h−íng kÕt nèi vµ tiÕn hµnh ®ång bé ho¸ ph©n ®o¹n, bæ sung c¸c sè 

chuçi t¹i møc byte.

Ngoµi ph©n chia th«ng ®iÖp, TCP cßn  cã thÓ duy tr× nhiÒu cuéc ®èi tho¹i 

(conversations) víi c¸c giao thøc tÇng phÝa trªn vµ cã thÓ c¶i thiÖn viÖc sö 

dông b¨ng th«ng m¹ng b»ng c¸ch tæ hîp nhiÒu  th«ng ®iÖp vµo chung mét 

ph©n ®o¹n. Mçi tuyÕn kÕt nèi m¹ch ¶o ®−îc g¸n mét ID kÕt nèi cã tªn lµ cæng 

(port) ®Ó ®Þnh danh c¸c gam d÷ liÖu kÕt hîp víi c¸c tuyÕn kÕt nèi ®ã. 

3.2 Giao thức Internet

Giao thøc Internet  (Internet  Protocol-IP)  lµ  mét giao thøc phi  kÕt nèi 

(connectionless) cung cÊp dÞch vô gam d÷ liÖu vµ c¸c gãi tin IP th−êng ®−îc 

gäi lµ gam d÷ liÖu IP (IP datagram). IP lµ mét  giao thøc chuyÓn gãi tin thùc 

hiÖn tiÕn tr×nh ®Þnh ®Þa chØ vµ chän ®−êng. Mét phÇn ®Çu IP ®−îc nèi vµo 

c¸c gãi tin, ®−îc c¸c giao thøc cÊp thÊp h¬n truyÒn theo d¹ng c¸c khung (frame). 

IP ®Þnh ®−êng c¸c gãi tin th«ng qua c¸c  liªn m¹ng b»ng c¸ch vËn dông 

c¸c b¶ng ®Þnh tuyÕn ®éng (dynamic routing table) ®−îc tham chiÕu t¹i  mçi 

b−íc nh¶y. C¸c phÇn x¸c ®Þnh tuyÕn ®−êng ®−îc tiÕn hµnh b»ng c¸ch tham 

kh¶o th«ng tin thiÕt bÞ m¹ng vËt lý vµ logic, mµ giao thøc ph©n gi¶i ®Þa chØ 

(Address Resolution Protocol-ARP) cung cÊp. 

IP thùc hiÖn t¸ch rêi vµ l¾p ghÐp l¹i c¸c gãi tin theo yªu cÇu giíi h¹n kÝch 

th−íc c¸c gãi tin, ®−îc ®Þnh nghÜa cho c¸c tÇng vËt lý vµ liªn kÕt d÷ liÖu thùc 

thi. IP còng thùc hiÖn tÝnh n¨ng kiÓm tra lçi trªn d÷ liÖu phÇn ®Çu b»ng c¸ch 

tæng kiÓm tra (checksum), mÆc dï d÷ liÖu cña c¸c tÇng phÝa trªn kh«ng ®−îc 

kiÓm tra lçi. 

3.3 Giao thức gam dữ liệu người dùng

Giao thøc gam d÷ liÖu ng−êi dïng (User Datagram  Protocol-UDP) lµ mét 

giao thøc tÇng giao vËn phi kÕt nèi (gi÷a c¸c m¸y chñ). UDP kh«ng cung cÊp 

c¸c tÝn hiÖu b¸o nhËn th«ng ®iÖp, thay vµo ®ã, ®¬n gi¶n lµ nã chØ lµm c«ng 

viÖc chuyÓn t¶i c¸c gam d÷ liÖu. 



Còng nh− TCP, UDP vËn dông c¸c ®Þa chØ cæng ®Ó bµn giao c¸c gam 

d÷ liÖu. Tuy nhiªn, c¸c ®Þa chØ cæng nµy kh«ng kÕt hîp víi c¸c m¹ch ¶o mµ 

chØ ®¬n thuÇn lµ ®Þnh danh c¸c tiÕn tr×nh xö lý cña m¸y chñ côc bé.  

UDP ®−îc sö dông nhiÒu h¬n TCP khi kh¶ n¨ng bµn giao ®¸ng tin cËy 

kh«ng quan träng b»ng kh¶ n¨ng thùc hiÖn cao hoÆc ph¶i gi÷ phÇn ®iÒu hµnh 

chung cña m¹ng ë møc thÊp. Do UDP kh«ng cÇn thiÕt lËp, b¶o tr× vµ kÕt thóc 

c¸c kÕt nèi hoÆc ®iÒu khiÓn luång d÷ liÖu nªn nãi chung nã ch¹y nhanh h¬n 

TCP. 

UDP lµ giao thøc tÇng giao vËn, ®−îc sö dông víi giao  thøc qu¶n trÞ 

m¹ng ®¬n gi¶n (Simple Network Management Protocol-SNMP),  lµ giao thøc 

qu¶n trÞ m¹ng chuÈn, ®−îc dïng víi c¸c m¹ng TCP/IP. UDP cho phÐp SNMP 

cung cÊp tÝnh n¨ng qu¶n trÞ m¹ng víi phÇn ®iÒu hµnh chung ë møc tèi thiÓu. 

3.4 Giao thức phân giải địa chỉ

Ba kiÓu th«ng tin ®Þa chØ d−íi ®©y ®−îc sö dông trªn c¸c m¹ng TCP/IP: 

­ §Þa chØ vËt lý: ®−îc tÇng vËt lý vµ tÇng liªn kÕt d÷ liÖu sö dông. 

­ C¸c ®Þa chØ IP: Cung cÊp c¸c ID m¸y chñ vµ m¹ng logic. C¸c ®Þa chØ 

IP bao gåm bèn con sè ®−îc biÓu diÔn d−íi d¹ng thËp ph©n cã chÊm. 

VÝ dô, 192.123.1.1 lµ mét ®Þa chØ IP. 

­ C¸c tªn nót logic: §Þnh danh c¸c m¸y chñ cô thÓ b»ng c¸c ID ký tù-sè. 

Chóng  gióp  ta  dÔ nhí  h¬n  so  víi  c¸c  ®Þa  chØ  ID  toµn  sè.  VÝ  dô, 

codienhanoi.edu.vn lµ mét tªn nót logic (logical node name).

C¨n cø vµo tªn nót (node) logic mµ giao thøc ph©n gi¶i ®Þa chØ (Address 

Resolution Protocol-ARP) cã thÓ x¸c ®Þnh ®Þa chØ IP kÕt hîp víi tªn ®ã. ARP 

duy tr× c¸c b¶ng d÷ liÖu ph©n gi¶i ®Þa chØ vµ cã thÓ qu¶ng b¸ c¸c gãi tin ®Ó 

ph¸t hiÖn c¸c ®Þa chØ trªn liªn m¹ng. C¸c ®Þa chØ IP do ARP ph¸t hiÖn cã thÓ 

®−îc cung cÊp cho c¸c giao thøc tÇng liªn kÕt d÷ liÖu. 

3.5 Giao thức hệ thống tên miền 



Giao thøc hÖ thèng tªn miÒn (Domain Name System-DNS) cung cÊp 

tÝnh n¨ng ph©n gi¶i tªn/®Þa chØ nh− mét dÞch vô cho c¸c øng dông trªn m¸y 

kh¸ch (client). C¸c hÖ phôc vô DNS cho phÐp con ng−êi dïng tªn c¸c nót logic 

®Ó truy cËp c¸c tµi nguyªn trªn m¹ng.

3.6 Giao thức chuyển thư đơn giản

Giao thøc chuyÓn th− ®¬n gi¶n (Simple Mail Transfer Protocol-SMTP) 

vµ giao thøc th− tÝn phiªn b¶n 3 (Post Office Protocol version 3-POP3) lµ mét 

giao thøc ®Ó ®Þnh ®−êng th− tÝn th«ng qua c¸c m¹ng. Nã sö dông giao thøc 

TCP/IP. 

SMTP kh«ng cung cÊp mét hÖ giao tiÕp th− cho ng−êi dïng. Quy chuÈn, 

qu¶n lý vµ trao ®æi c¸c th«ng ®iÖp cho ng−êi dïng cuèi (End user), tÊt c¶ ®Òu 

ph¶i tiÕn hµnh bëi mét phÇn mÒm trao ®æi th− tÝn ®iÖn tö (nh− Outlook,  

Eudora,...). 

3.7 Giao thức truyền tập tin 

Giao thøc truyÒn tËp tin (File Transfer Protocol-FTP) lµ mét giao thøc 

®Ó dïng chung c¸c tËp tin gi÷a c¸c m¸y chñ nèi m¹ng. FTP cho phÐp ng−êi dïng 

®¨ng nhËp c¸c m¸y chñ ë xa. Nh÷ng ng−êi dïng ®· ®¨ng nhËp cã thÓ xem xÐt 

c¸c th− môc, thao t¸c víi c¸c tËp tin, thùc thi c¸c lÖnh vµ ch¹y c¸c ch−¬ng tr×nh 

trªn m¸y chñ. FTP còng cã kh¶ n¨ng trao ®æi c¸c tËp tin gi÷a c¸c m¸y chñ kh«ng 

®ång bé b»ng c¸ch hç trî mét cÊu tróc yªu cÇu tËp tin ®éc lËp víi c¸c hÖ ®iÒu 

hµnh cô thÓ. 

3.8 HTTP - HyperText Transfer Protocol 

C¸ch thøc ®Ó tr×nh duyÖt WEB cña ng−êi dïng nãi chuyÖn víi ch−¬ng 

tr×nh Web server khi ng−êi dïng sö dung WWW. Hypertext: c¸ch thøc liªn kÕt 

tham chiÕu ®Õn nh÷ng mÉu th«ng tin kh¸c nhau. 

4. Đ a ch  IP ị ỉ

§Þa chØ IP gióp chóng ta cã thÓ nhËn diÖn ®−îc c¸c m¸y mµ kh«ng cÇn 

quan t©m ®Õn c«ng nghÖ m¹ng c¬ së. ¦u ®iÓm cña nã lµ cã thÓ ®¬n gi¶n hãa 

viÖc ®Þnh ®−êng ®i trªn m¹ng. Ngoµi ra, ®Þa chØ IP cßn mang tÝnh toµn côc, 



nÕu m¹ng côc bé nµo ®ã ®−îc nèi vµo Internet, th× toµn bé c¸c m¸y trong m¹ng 

®ã sÏ ®−îc toµn Internet biÕt ®Õn th«ng qua ®Þa chØ IP. 

§Þa chØ IP ®ang ®−îc sö dông hiÖn t¹i (IPv4) cã 32 bit chia thµnh 4 octet 

(mçi octet cã 8 bit, t−¬ng ®−¬ng 1 byte ), c¸ch ®Õm ®Òu tõ tr¸i qua ph¶i bit 0 

cho ®Õn bit 31, c¸c octet t¸ch biÖt nhau bëi dÊu chÊm (.). Mçi octet cã thÓ 

biÓu diÔn b»ng c¸c sè thËp ph©n, nhÞ ph©n hoÆc thËp lôc ph©n. §ia chØ IP 

bao gåm cã 3 thµnh phÇn chÝnh:  

­ Bit nhËn d¹ng líp (Class bit) 

­ §Þnh danh cña m¹ng (Network Identifier – NET ID) 

­ §Þnh danh m¸y chñ (Host Identifier – HOST ID)  

Do tæ chøc vµ ®é lín cña c¸c m¹ng côc bé trong liªn m¹ng kh¸c nhau, ®Ó 

thuËn tiÖn cho viÖc qu¶n lý cÊp ph¸t ®Þa chØ IP ng−êi ta chia ®Þa chØ m¹ng 

thµnh 5 líp. Ký hiÖu lµ A, B, C, D, E

-  Líp A: Sö dông 7 bit ®Þnh danh m¹ng vµ 24 bit ®Ó ®Þnh danh c¸c tr¹m. Líp A 

cho phÐp sö dông 27-2 m¹ng vµ 224 -2 tr¹m trong mçi m¹ng. Líp nµy thÝch hîp 

cho c¸c m¹ng cã sè tr¹m cùc lín. Tæng sè kho¶ng h¬n 2 tØ ®Þa chØ. Vïng ®Þa 

chØ líp A cã  thÓ sö dông gåm tõ 1.0.0.1 ®Õn 126.255.255.254. 

-  Líp B: Sö dông 14 bit ®Þnh danh m¹ng vµ 16 bit ®Ó ®Þnh danh c¸c tr¹m. Líp 

B cho phÐp sö dông 214-2 m¹ng  vµ 216 -2 tr¹m trong mçi m¹ng. Tæng sè 

kho¶ng h¬n 1 tØ ®Þa chØ. Vïng ®Þa chØ líp B cã thÓ sö dông tõ 128.0.0.1 

®Õn 191.254.255.254. 

-  Líp C:  Sö dông 21 bit ®Þnh danh m¹ng vµ 8 bit ®Ó ®Þnh danh c¸c tr¹m. Líp 

C cho phÐp sö dông 221-2 m¹ng vµ 28 -2 tr¹m trong mçi m¹ng. Líp nµy thÝch 

hîp cho c¸c m¹ng nhá, cã sè tr¹m trong mçi  m¹ng kh«ng qu¸ 254. Tæng sè 



kho¶ng h¬n nöa tØ ®Þa  chØ. Vïng ®Þa chØ líp B cã thÓ sö dông tõ 192.0.0.1 

®Õn 223.255.254.254. 

-  Líp D: ®Þa chØ líp nµy ®−îc sö dông cho viÖc qu¶ng b¸ (dïng ®Ó göi IP 

datagram tíi mét nhãm trªn m¹ng sö dông cïng kiÓu ®Þa chØ).  

-  Líp E: ®Þa chØ dù phßng trong t−¬ng lai.

5. Các khái ni m khác ệ

5.1 URL 

URL  (Uniform Resource Locator) lµ c¸ch gäi kh¸c cña ®Þa chØ web. 

URL bao gåm tªn cña giao thøc (th−êng lµ HTTP hoÆc FTP), tiÕp ®Õn lµ dÊu 

hai chÊm (:), hai dÊu g¹ch chÐo (//), sau ®ã lµ tªn miÒn muèn kÕt nèi ®Õn. VÝ 

dô vÒ mét URL lµ “http://www.codienhanoi.edu.vn/diendan” sÏ h−íng dÉn tr×nh 

duyÖt web cña chóng ta sö dông giao thøc giao thøc http ®Ó kÕt nèi ®Õn m¸y 

tÝnh www.codienhanoi.edu.vn, 



më tÖp web ngÇm ®Þnh cã tªn lµ default.htm (hay index.htm) trong th− môc 

“diendan”. Tªn tÖp tin ngÇm ®Þnh kh«ng cÇn gâ vµo URL. Khi gâ URL còng cã 

thÓ bá qua tªn giao thøc http v× tr×nh duyÖt lÊy giao thøc http lµm giao thøc 

ngÇm ®Þnh. 

URL cã mét có ph¸p ®Æc biÖt. TÊt c¶ c¸c URL ph¶i chÝnh x¸c, thËm 

chÝ cã mét ký tù sai hay thiÕu mét dÊu chÊm còng kh«ng ®−îc Web Server 

chÊp nhËn, nhËp sai mét ký tù trong ®Þa chØ URL cã thÓ dÉn chóng ta ®Õn 

mét Web site cã néi dung kh¸c hoÆc nhËn ®−îc th«ng b¸o Web site ®ã kh«ng 

tån t¹i. 

5.2 Hyperlink (siêu liên kết) 

Hyperlink (siªu liªn kÕt) lµ mét thµnh phÇn c¬ b¶n vµ rÊt cÇn thiÕt ®èi víi  

mét siªu v¨n b¶n World Wide Web. Siªu liªn kÕt gióp chóng ta dÔ dµng t×m 

kiÕm c¸c th«ng tin kh¸c nhau vÒ mét chñ ®Ò. Mét siªu liªn kÕt lµ mét phÇn v¨n 

b¶n (hay h×nh ¶nh) cña trang Web, mµ khi kÝch vµo ®ã sÏ tù ®éng thùc hiÖn 

mét trong c¸c thao t¸c sau ®©y: 

­ §−a ®Õn phÇn kh¸c cña trang 

­ §−a ®Õn mét trang web kh¸c trong cïng mét Web site 

­ §−a ®Õn mét trang web kh¸c trong Web site kh¸c 

­ Cho phÐp download mét file 

­ Ch¹y mét øng dông, tr×nh diÔn mét ®o¹n video hoÆc ©m thanh 

H×nh ¶nh minh ho¹ d−íi ®©y lµ mét phÇn cña trang web. Nh÷ng tõ g¹ch d−íi 

thÓ hiÖn c¸c liªn kÕt, chØ cÇn nhÊn chuét vµo siªu liªn kÕt, néi dung tµi liÖu 

mµ nã trá tíi sÏ ®−îc hiÓn thÞ.  



H×nh 1.3. Minh häa mét Hyperlink (siªu liªn kÕt)

5.3 Web Browser (trình duyệt web) 

Web Browser lµ mét c«ng cô hay ch−¬ng tr×nh cho phÐp truy xuÊt vµ 

xem th«ng tin trªn Web. Cã nhiÒu Web Browser ®Ó truy xuÊt Web, mçi tr×nh 

duyÖt cã nh÷ng ®Æc ®iÓm kh¸c nhau vµ chóng hiÓn  thÞ nh÷ng trang Web 

kh«ng hoµn toµn gièng nhau. 

C¸c tr×nh duyÖt web bao gåm cã Internet Explorer, Netscape Navigator 

Communicator, Opera, Mozilla Firefox,... TÊt c¶ c¸c lo¹i tr×nh duyÖt nµy ®Òu 

cã c¸c phiªn b¶n kh¸c nhau, vµ c¸c phiªn b¶n míi nhÊt sÏ cã nhiÒu tÝnh n¨ng h¬n 

c¸c phiªn b¶n tr−íc ®ã. Ngoµi viÖc truy xuÊt Web, c¸c tr×nh duyÖt cßn cho 

phÐp chóng ta thùc hiÖn c¸c c«ng viÖc kh¸c nh−: göi nhËn email, t¶i c¸c tËp tin 

tõ Web Server vÒ, … th«ng qua c¸c Add-on vµ Plugin cña tr×nh duyÖt.  

5.4 Web Server (máy chủ Web) 

Web Server lµ m¸y chñ trong ®ã chøa th«ng tin d−íi  d¹ng trang Web 

(trang HTML cã thÓ chøa ©m thanh, h×nh ¶nh, video, v¨n b¶n, …). C¸c Web 

Server ®−îc kÕt nèi víi nhau th«ng qua m¹ng Internet, mçi Server  cã ®Þa chØ 

duy nhÊt trªn Internet. 

Thµnh phÇn chñ chèt cña Web Server lµ phÇn mÒm. Mçi phÇn mÒm 

Web Server ch¹y trªn mét nÒn t¶ng phÇn cøng vµ mét hÖ ®iÒu hµnh cô thÓ. 

Mét Web Server ph¶i cã cÊu h×nh ®ñ m¹nh ®Ó cung cÊp c¸c dÞch vô cho c¸c 

client, ®¸p øng ®ång thêi nhiÒu yªu cÇu tõ client vµ cã kh¶ n¨ng l−u tr÷ lín cho 

tµi nguyªn Web. 

Nãi vÒ chøc n¨ng vµ hiÖu n¨ng, c¸c Web Server ph©n thµnh 4 nhãm chÝnh: 

­ C¸c m¸y chñ truyÒn th«ng th«ng th−êng. 

­ M¸y chñ th−¬ng m¹i. 

­ M¸y chñ mhãm lµm viÖc. 

­ M¸y chñ dïng cho môc ®Ých ®Æc biÖt.   

C¸c tiªu chuÈn ®¸nh gi¸ mét Web Server: 

­ HiÖu n¨ng: nÒn t¶ng hÖ ®iÒu hµnh vµ xö lý ®a luång. 



­ B¶o mËt: Th«ng qua ®Þa chØ IP,  tªn m¸y chñ cña m¹ng con, th− môc... 



Web Oracle cung cÊp ph−¬ng ¸n b¶o mËt th«ng tin theo tªn ng−êi sö dông 

vµ kho¸ m· ®−îc m· ho¸ hoµn toµn trong qu¸ tr×nh truyÒn th«ng trªn m¹ng. 

­ Truy nhËp vµ tÝch hîp CSDL: HÇu hÕt c¸c Web Server ®Òu sö dông 

giao diÖn CGI, mét sè kh¸c th× dïng giao diÖn lËp tr×nh øng dông (API) 

hoÆc ng«n ng÷ hái ®¸p cã cÊu tróc SQL. 

­ Qu¶n lý vµ qu¶n trÞ Web Server: §Æc tÝnh quan träng cña tiªu chuÈn 

nµy lµ kh¶ n¨ng qu¶n trÞ tõ xa, giao diÖn ®å häa vµ ®iÒu khiÓn cÊu 

h×nh cña m¸y chñ.

5.5 Web Site 

Web Site lµ mét tËp hîp c¸c trang Web liªn quan ®Õn mét c«ng ty, mét 

tËp ®oµn, mét tæ chøc, mét c¸ nh©n hay ®¬n gi¶n chØ lµ mét chñ ®Ò mµ 

nhiÒu  ng−êi  cïng  quan  t©m.  VÝ  dô  Web  Site  cña  ChÝnh  phñ 

(www.chinhphu.org.vn), cña mét c¬ quan (Bé GD&§T-www.moet.edu.vn), b¸o 

chÝ (www.thanhnien.com.vn), cña mét chñ ®Ò (www.thuvientinhoc.vn)... 

5.6 World Wide Web 

World Wide Web (Web) lµ mét dÞch vô hay cßn gäi lµ mét c«ng cô trªn 

Internet ra ®êi gÇn ®©y nhÊt nh−ng ph¸t triÓn nhanh nhÊt hiÖn nay. Nã cung 

cÊp mét giao diÖn v« cïng th©n thiÖn víi ng−êi dïng, dÔ sö dông, thuËn lîi vµ 

®¬n gi¶n ®Ó t×m kiÕm th«ng tin. 

Thùc chÊt Web kh«ng ph¶i lµ mét hÖ thèng cô thÓ víi tªn gäi nh− trªn 

mµ lµ mét tËp hîp c¸c c«ng cô tiÖn Ých vµ siªu giao diÖn (meta-Interface) gióp 

ng−êi sö dông cã thÓ tù t¹o ra c¸c "siªu v¨n b¶n" vµ cung cÊp cho nh÷ng ng−êi  

dïng kh¸c trªn Internet. 

5.7 Phân biệt Inetrnet và WWW 

WWW chØ lµ mét phÇn nhá cña Internet. Internet bao hµm tÊt c¶ phÇn 

cøng vµ phÇn mÒm, bao gåm HTTP, FTP (File Transfer Protocol, sÏ ®Ò cËp 

®Õn sau), Emails vµ Newgroups. WWW chñ yÕu x©y dùng trªn c¸c ký tù vµ 

h×nh ¶nh mµ chóng ta cã thÓ xem b»ng c¸c tr×nh duyÖt Web. 

5.8 Web page 



Web page lµ trang Web, lµ mét lo¹i tËp tin ®Æc biÖt ®−îc viÕt b»ng ng«n ng÷ 

siªu v¨n b¶n HTML. Web page cã thÓ hiÓn c¸c th«ng tin v¨n b¶n, ©m thanh, 

h×nh ¶nh, video, … Trang Web nµy ®−îc ®Æt trªn mét m¸y chñ Web sao cho 

c¸c m¸y kh¸ch cã thÓ truy cËp ®−îc nã, tËp hîp nhiÒu trang Web cã liªn quan, 

rµng buéc ®Õn nhau cho chóng ta mét Web Site.

6.  Cách th c đ  t  ch c xây d ng m t Web Site ứ ể ổ ứ ự ộ

ViÖc x©y dùng mét trang Web ®Ó ®−îc nhiÒu ng−êi quan t©m lµ mét 

c«ng viÖc kh«ng ®¬n gi¶n. ViÖc thiÕt kÕ kh«ng chØ l−u ý ®Õn vÊn ®Ò lµ mäi 

ng−êi cã truy cËp vµo trang Web cña m×nh h¬n mét lÇn hay kh«ng mµ th«ng 

tin trªn ®ã ph¶i phô thuéc hoµn toµn vµo môc ®Ých cña viÖc t¹o chóng. 

§Ó t¹o ®−îc mét site h÷u hiÖu, ta ph¶i chó ý ®Õn nh÷ng vÊn ®Ò sau: 

­ Cã mét môc ®Ých râ rµng: §©y lµ ®iÓm quan träng trong viÖc b¾t ®Çu 

thiÕt kÕ Web. 

­ Lu«n lu«n nghÜ ®Õn nh÷ng client-ng−êi sÏ truy cËp  vµo site: Chóng ta 

ph¶i xÐt ®Õn mét sè ®Æc ®iÓm cña ng−êi truy cËp nh− lµ: løa tuæi, 

nghÒ nghiÖp, së thÝch, thêi gian r¶nh rçi... 

­ Sö dông nh÷ng môc cã kh¶ n¨ng dowload vÒ thËt  nhanh.  Mét trong 

nh÷ng lý do khiÕn nh÷ng ng−êi truy cËp vµo trang Web cña chóng ta 

c¶m thÊy ch¸n n¶n lµ ph¶i ®îi l©u cho viÖc lÊy tin vµ ®ã chÝnh lµ lóc 

ng−êi ta sÏ nhÊn vµo nót Stop.   

­ Cè g¾ng lµm cho Web Site cña m×nh xuÊt hiÖn mét c¸ch trùc quan: 

kh«ng nªn cho qu¸ nhiÒu mµu s¾c hoÆc kh«ng cã mµu s¾c trong trang. 

­ §õng cã cè g¾ng cho mäi thø vµo trong mét trang: Mét trang Web bõa 

bén sÏ g©y ra c¶m gi¸c ch¸n n¶n vµ nhøc m¾t. 

­ Tæ chøc néi dung mét c¸ch th«ng minh: Nªn nhí r»ng site cña m×nh t¹o 

ra kh«ng chØ cã "®é s©u" mét bËc, do vËy chØ cã nh÷ng th«ng tin thËt 

cÇn thiÕt míi cho vµo trang chñ. VÝ dô: giíi thiÖu tªn c«ng ty, môc ®Ých,  

mét sè s¶n phÈm... 



­ KiÓm tra, ch¹y thö site võa thiÕt kÕ mét c¸ch kü tr−íc khi ®−a lªn Web 

Server: Thö kiÓm tra site bëi c¸c tr×nh duyÖt Web, trªn c¸c hÖ ®iÒu 

hµnh kh¸c nhau hay lµ c¸c chÕ ®é kÝch th−íc cöa sæ kh¸c nhau ®Ó 

®¶m b¶o r»ng site cña chóng ta th«ng suèt. 

7  Phân lo i Web ạ

Dùa vµo ®Æc tr−ng, kÕt nèi d÷ liÖu vµ c«ng cô ph¸t triÓn ng−êi ta cã 

thÓ chia ra lµm 2 lo¹i Web sau ®©y: 

7.1 Static pages (Web tĩnh ): 

TÝnh chÊt cña c¸c trang Web nµy lµ chØ bao gåm c¸c néi dung hiÓn thÞ 

cho ng−êi dïng xem. VÝ dô: hiÓn thÞ c¸c trang d¹ng text, h×nh ¶nh ®¬n gi¶n 

ch¼ng h¹n nh− mét cèc cµ phª ®ang bèc khãi... 

7.2 Dynamic Web  (Web động) 

Néi dung cña trang Web ®éng nh− trong 1 trang Web tÜnh, ngoµi ra cßn 

cã  nhóng c¸c ®o¹n m· lÖnh cho phÐp truy nhËp c¬ së d÷ liÖu trªn m¹ng. Tuú 

theo nhu cÇu, øng dông cã thÓ cung cÊp kh¶ n¨ng truy cËp d÷ liÖu, t×m kiÕm 

th«ng tin, …

8. Câu hỏi và bài tập

C©u 1: Ph©n biÖt m¹ng Intranet vµ m¹ng Internet. 

C©u 2: M¹ng Internet sö dông nh÷ng giao thøc nµo? Chøc n¨ng cña chóng? 

C©u 3: CÊu tróc c¸c líp cña ®Þa chØ IP. 

C©u 4: C¸c kh¸i niÖm URL, hyperlinks, web page, web browser, web server. 

C©u 5: Ph©n biÖt Internet vµ World Wide Web. 

C©u 6: C¸ch thøc x©y dùng mét website. 

C©u 7: Ph©n biÖt c¸c lo¹i web



Chương 2

Các thành phần cơ bản của HTML

BÊt kú mét phÇn mÒm øng dông nµo mµ kh«ng hiÓn thÞ ra néi dung 

®Ó ngêi dïng cã thÓ khai th¸c vµ sö dông th× phÇn mÒm ®ã vÒ c¬ b¶n kh«ng 

cßn tÝnh øng dông n÷a. Website còng kh«ng n»m ngoµi quy luËt ®ã. VËy, lµm 

thÕ nµo ®Ó mét Website cã thÓ hiÓn thÞ ®îc néi dung cho ngêi dïng khai th¸c 

vµ sö dông nã? ®ã chÝnh lµ HTML (HyperText Markup Language – Ng«n ng÷ 

®¸nh dÊu siªu v¨n b¶n). BÊt kú mét website dï ®îc viÕt trªn mét ng«n ng÷ nµo 

cuèi cïng nã còng ®îc xö lý vµ ®a vÒ c¸c thÎ ®Þnh d¹ng HTML. 

Môc tiªu

Sau khi häc xong ch¬ng nµy, chóng ta sÏ:

 Tr×nh bµy ®îc cÊu tróc c¬ b¶n cña mét website ®¬n gi¶n.

 BiÕt c¸ch khëi t¹o, lu tr÷ vµ hiÓn thÞ mét website ®· t¹o.

 Sö dông c¸c thÎ ®Þnh d¹ng trong HTML ®Ó thiÕt kÕ mét website tïy ý.

 X©y dùng ®îc mét website tÜnh øng dông trong thùc tÕ.



1. Giới thiệu

1.1 HTML là gì?

Trong phÇn giíi thiÖu, chóng ta ®· biÕt HTML lµ ng«n ng÷ ®¸nh dÊu, 

kh«ng ph¶i lµ ng«n ng÷ lËp tr×nh. Trªn thùc tÕ, HTML ®îc viÕt t¾t bëi côm tõ 

HyperText Markup Language. Chóng ta cã thÓ ¸p dông ng«n ng÷ ®¸nh dÊu nµy 

vµo c¸c trang cña chóng ta ®Ó hiÓn thÞ c¸c tµi liÖu v¨n b¶n, ¶nh, ©m thanh vµ 

phim, vµ hÇu hÕt c¸c lo¹i th«ng tin ®iÖn tö kh¸c. Chóng ta sö dông ng«n ng÷ 

®Ó ®Þnh d¹ng c¸c tµi liÖu vµ liªn kÕt chóng l¹i víi nhau mµ kh«ng phô thuéc 

vµo lo¹i m¸y tÝnh mµ c¸c tËp tin ®· ®îc t¹o ra.

T¹i sao HTML quan träng? Chóng ta biÕt r»ng nÕu chóng ta viÕt mét tµi  

liÖu trong tr×nh xö lý yªu thÝch cña chóng ta vµ göi nã cho chóng ta bÌ, nh÷ng 

ngêi kh«ng cã cïng mét tr×nh xö lý, chóng ta cña chóng ta kh«ng thÓ ®äc c¸c 

tµi liÖu, ph¶i kh«ng? §iÒu nµy còng ®óng cho hÇu hÕt mäi lo¹i h×nh tËp tin 

(bao gåm c¶ c¸c b¶ng tÝnh, c¬ së d÷ liÖu, sæ s¸ch vµ phÇn mÒm). Thay v× sö 

dông mét sè ch¬ng tr×nh m· ®éc quyÒn, m· HTML ®îc viÕt nh ®ång b»ng v¨n 

b¶n mµ bÊt kú tr×nh duyÖt Web hoÆc xö lý tõ c¸c phÇn mÒm cã thÓ ®äc. C¸c 

phÇn mÒm hiÓn thÞ ®iÒu nµy b»ng c¸ch x¸c ®Þnh c¸c yÕu tè cô thÓ cña mét 

tµi liÖu (ch¼ng h¹n nh heading, body, vµ footer), vµ sau ®ã ®Þnh nghÜa c¸ch 

mµ nh÷ng phÇn tö ®ã cÇn ph¶i øng xö. Nh÷ng phÇn tö nµy ®îc gäi lµ thÎ, ®îc 

t¹o  ra  bëi  tËp ®oµn m¹ng toµn cÇu -  World  Wide Web Consortium (W3C). 

Chóng ta sÏ t×m hiÓu thªm vÒ c¸c thÎ trong bµi häc s¾p tíi.

1.2 Tags

§©y lµ nh÷ng phÇn tö cña mét trang web ®îc sö dông ®Ó ®Þnh nghÜa 

c¸c trang nµy nªn  øng xö nh thÕ nµo. Chóng thêng ®îc sö dông thµnh tõng 

cÆp, bao quanh chóng lµ c¸c phÇn tö x¸c ®Þnh.

1.3 World Wide Web Consortium (W3C)

C¸c thµnh viªn cña nhãm nµy ph¸t triÓn c¸c giao thøc ®Ó t¹o thµnh World 

Wide Web. HiÖn nay, W3C ®· cã 180 thµnh viªn tõ th¬ng m¹i, häc tËp, vµ c¸c 

tæ chøc chÝnh phñ trªn toµn thÕ giíi.



1.4 HTML làm việc như thế nào?

M¸y tÝnh cña chóng ta cã mét tr×nh duyÖt Web, ch¼ng h¹n nh Internet 

Explorer hoÆc Mozzila Firefox, ®îc cµi ®Æt trªn nã. Khi chóng ta ®ang t×m 

kiÕm th«ng tin trªn Web, tr×nh duyÖt cña chóng ta ®· t×m thÊy m¸y tÝnh ®· ®îc 

lu tr÷ th«ng tin ®ã. Nã thùc hiÖn ®iÒu nµy b»ng c¸ch sö dông HTTP. C¸c lu tr÷ 

trong m¸y tÝnh, hoÆc m¸y chñ, sau ®ã göi cho c¸c trang web míi (nh lµ mét tËp 

tin v¨n b¶n) vÒ m¸y tÝnh cña chóng ta b»ng c¸ch sö dông cïng mét HTTP. 

Tr×nh duyÖt cña chóng ta míi nh×n thÊy c¸c trang web vµ biªn dÞch c¸c v¨n b¶n 

vµ c¸c thÎ HTML ®Ó hiÓn thÞ cho chóng ta c¸c ®Þnh d¹ng, ®å häa, vµ c¸c v¨n 

b¶n xuÊt hiÖn trªn trang.

L  êi khuyªn  : HTTP kh«ng ph¶i lµ giao thøc duy nhÊt sö dông trªn Internet. Mçi  

giao thøc ®îc sö dông cho mét dÞch vô m¹ng ®Æc biÖt, vÝ dô th ®iÖn tö vµ 

truyÒn t¶i file.

1.5 Tạo trang web đầu tiên

Trong bµi nµy, chóng ta sÏ häc vÒ c¸ch khëi t¹o, lu tr÷ vµ hiÓn thÞ mét 
trang Web ®¬n gi¶n.

1.2.1 Nhập môn

T«i nghÜ r»ng c¸ch tèt nhÊt ®Ó chóng ta häc cïng víi c¸c vÝ dô trong s¸ch 

nµy lµ chóng ta tù t¹o c¸c trang Web riªng cña chóng ta khi chóng ta ®äc. Nh 

chóng ta ®· biÕt trong phÇn giíi thiÖu cña cuèn s¸ch nµy, chóng ta cã thÓ t¹o 

c¸c trang Web hoÆc tµi liÖu HTML víi bÊt kú tr×nh so¹n th¶o v¨n b¶n (bao gåm 

c¶ Microsoft Notepad, MS DOS, Mac SimpleText, vµ UNIX). Cã lÏ chóng ta ®· 

cã Ýt nhÊt mét trong sè c¸c tr×nh so¹n th¶o ®îc cµi ®Æt trªn m¸y tÝnh cña 

chóng ta, ngay c¶ khi chóng ta kh«ng bao giê cã tríc khi nã ®îc sö dông.

Chó ý  :   MÆc dï chóng ta còng cã thÓ t¹o ra c¸c trang Web b»ng c¸ch sö dông 

tõ mét sè tr×nh so¹n th¶o (ch¼ng h¹n nh Microsoft Word) vµ mét sè c¸c ch¬ng 

tr×nh (nh Microsoft FrontPage, Dreamweaver), t«i khuyªn chóng ta trong lóc  

nµy nªn bá qua nh÷ng ch¬ng tr×nh nµy vµ tËp trung vµo viÖc häc HTML. ViÖc 

häc HTML b»ng c¸ch sö dông Dreamweaver  sÏ ®îc th¶o luËn trong ch¬ng 3, 

"Thao t¸c víi phÇn mÒm t¹o Web."



1.2.2 Các thẻ quan trọng

§Ó xem c¸c m· HTML vµ t×m hiÓu c¸c thÎ HTML c¬ b¶n nhÊt, h·y nh×n 

vµo mét tµi liÖu rÊt ®¬n gi¶n, m· HTML. H×nh 2,1 hiÓn thÞ mét trang web ®¬n 

gi¶n trong Microsoft Notepad. Chóng ta cã thÓ viÕt m· gièng nh thÕ nµy  trong 

tr×nh so¹n th¶o cña m×nh ®Ó theo cïng víi c¸c bµi häc.

H×nh 2.1. C¸c thÎ <html> vµ </html> lµ b¾t buéc ®Ó b¹n t¹o ra mét tµi liÖu  

HTML.

Mäi tµi liÖu HTML ®Òu ph¶i b¾t ®Çu víi thÎ <html> vµ kÕt thóc mét tµi liÖu 

bëi thÎ </html>. Ngoµi cÆp thÎ <html> vµ </html>, Trong vÝ dô trªn cßn cã ba 

cÆp thÎ mµ chóng nªn cã trong mäi tµi liÖu HTML.

� CÆp thÎ <head> vµ </head> §îc sö dông ®Ó chØ râ mäi th«ng tin vÒ tµi 

liÖu cña chóng ta. Chóng ta sÏ häc c¸ch lµm thÕ nµo ®Ó thªm mét sè 

th«ng tin trong c¸c bµi häc sau nµy. 

� CÆp thÎ <title> vµ </title> ®îc sö dông ®Ó ®Ó thªm vµo mét tiªu ®Ò ®Ó 

hiÓn thÞ trªn tiªu ®Ò tr×nh duyÖt cña chóng ta. 

� CÆp thÎ <body> vµ </body>  ®îc sö dông ®Ó hiÓn thÞ mäi v¨n b¶n xuÊt 

hiÖn trong trang HTML. 

TÊt c¶ c¸c tµi liÖu HTML ®îc chia thµnh hai phÇn: phÇn ®Çu (head) vµ 

phÇn th©n (body). Bëi v× tiªu ®Ò chøa th«ng tin vÒ tµi liÖu, cÆp thÎ <title> vµ 

</title> ®îc ®Æt trong cÆp thÎ <head> vµ </head>.

VÝ dô 2

NÕu chóng ta ®· t¹o ra mét trang HTML ®¬n gi¶n kh¸c, chóng ta sÏ thÊy 

bèn cÆp thÎ gièng nhau nh trªn vÝ dô 1 ®îc xuÊt hiÖn trong tµi liÖu. ChØ cã 

duy nhÊt lµ v¨n b¶n xuÊt hiÖn gi÷a c¸c cÆp thÎ lµ thay ®æi.

<html>
<head>



      <title>Trang HTML thø 2</title>
</head>
<body>
      <p>§©y lµ trang HTML thø 2<p>
</body>

</html>

M  Ño nhá  : HÇu hÕt c¸c thÎ HTML t¹o thµnh cÆp. Chóng ta sö dông thÎ ®Çu tiªn  

trong cÆp ( Ch¼ng h¹n <html>) §Ó nãi víi  m¸y tÝnh ®Ó b¾t ®Çu ¸p dông 

khu«n d¹ng. Nh·n thø hai ( Ch¼ng h¹n </html>) Yªu cÇu mét dÊu g¹ch chÐo 

phÝa tríc tªn nh·n ®Ó nãi víi m¸y tÝnh ngõng ¸p dông khu«n d¹ng. ThÎ ®Çu tiªn 

th«ng thêng ®îc tham chiÕu tíi bëi tªn bªn trong dÊu mãc (ch¼ng h¹n HTML). 

Chóng ta cã thÓ tham chiÕu tíi thÎ thø hai ®Ó kÕt thóc, hoÆc ®ãng tµi liÖu 

(ch¼ng h¹n kÕt thóc HTML)

1.2.3 Lưu và hiển thị trang

§Ó hiÓn thÞ trang cña chóng ta trong tr×nh duyÖt, chóng ta ph¶i lu nã 

l¹i. Sau khi chóng ta t¹o ra mét tµi liÖu HTML, chóng ta sÏ lu nã l¹i víi ®u«i më 

réng lµ .htm hoÆc .html (vÝ dô: first.htm)

Chóng ta cã thÓ xem tríc bÊt kú tÖp tin HTML trong tr×nh duyÖt cña 

chóng ta, ngay c¶ khi tËp tin ®îc lu tr÷ trªn c¸c m¸y tÝnh cña chóng ta chø 

kh«ng ph¶i lµ trªn mét m¸y chñ web. Trong Internet Explorer, chóng ta cã thÓ 

xem tËp tin míi cña chóng ta ®· gi¶i quyÕt b»ng c¸ch chän Open tõ tr×nh ®¬n 

File (Chóng ta còng cã thÓ më nhanh b»ng c¸ch nhÊp ®óp vµo tÖp tin .htm cña 

chóng ta). H×nh 2.2 cho thÊy c¸ch thøc tr×nh duyÖt Internet Explorer hiÓn thÞ 

tËp tin first.htm mµ chóng ta t¹o ra trong h×nh 2.1.

H×nh 2.2. My First Web Page xuÊt hiÖn trªn tr×nh duyÖt  Internet Explorer.  

Chó ý r»ng, phÇn tiªu ®Ò bao gåm c¸c v¨n b¶n n»m trong cÆp thÎ  <title> vµ 

</title> vµ phÇn th©n cña tr×nh duyÖt bao gåm c¸c v¨n b¶n n»m trong cÆp thÎ  

<body> vµ </body>.



MÑo: MÆc dï chóng ta kh«ng nh×n thÊy chóng, c¸c lÖnh HTML Èn phÝa sau 
cña tÊt c¶ c¸c tµi liÖu mµ chóng ta më ra trong tr×nh duyÖt Web cña chóng ta.  
Chóng ta cã thÓ xem c¸c m· HTML b»ng c¸ch chän tr×nh ®¬n View -> View 
Source cña Internet Explorer (c¸c tr×nh duyÖt kh¸c cã thÓ sö dông lÖnh tr×nh 
®¬n kh¸c nhau). Khi chóng ta t×m thÊy mét trang web mµ chóng ta thÝch,  
chóng ta cã thÓ xem m· nguån ®Ó t×m hiÓu c¸ch sö dông m· HTML ®Ó t¹o ra 
c¸i g× ®ã t¬ng tù.



<HTML>

... Toµn bé néi cña tµi liÖu ®îc ®Æt ë ®©y
</HTML>

<TITLE>Tiªu ®Ò cña tµi liÖu</TITLE>

2. T ng quan v  HTMLổ ề

2.1 Các thẻ định dạng tài liệu

2.1.1 HTML

CÆp thÎ nµy ®îc sö dông ®Ó x¸c nhËn mét tµi liÖu lµ tµi liÖu HTML, tøc 

lµ nã cã sö dông c¸c thÎ HTML ®Ó tr×nh bµy. Toµn bé néi dung cña tµi liÖu ®îc 

®Æt gi÷a cÆp thÎ nµy. 

Có ph¸p:

Tr×nh duyÖt sÏ xem c¸c tµi liÖu kh«ng sö dông thÎ <HTML> nh nh÷ng tÖp tin 

v¨n b¶n b×nh thêng.

2.1.2 HEAD

ThÎ HEAD ®îc dïng ®Ó x¸c ®Þnh phÇn më ®Çu cho tµi liÖu.

Có ph¸p:

2.1.3 TITLE

CÆp thÎ nµy chØ cã thÓ sö dông trong phÇn më ®Çu cña tµi liÖu, tøc lµ 

nã ph¶i n»m trong thÎ ph¹m vi giíi h¹n bëi cÆp thÎ <HEAD>.

Có ph¸p:

2.1.4 BODY

<HEAD>

... PhÇn më ®Çu (HEADER) cña tµi liÖu ®îc ®Æt ë ®©y
</HEAD>



<BODY>
.... phÇn néi dung cña tµi liÖu ®îc ®Æt ë ®©y
</BODY>

ThÎ nµy ®îc sö dông ®Ó x¸c ®Þnh phÇn néi dung chÝnh cña tµi liÖu - 

phÇn th©n (body) cña tµi liÖu. Trong phÇn th©n cã thÓ chøa c¸c th«ng tin 

®Þnh d¹ng nhÊt ®Þnh ®Ó ®Æt ¶nh nÒn cho tµi liÖu, mµu nÒn, mµu v¨n b¶n 

siªu liªn kÕt, ®Æt lÒ cho trang tµi liÖu... Nh÷ng th«ng tin nµy ®îc ®Æt ë phÇn 

tham sè cña thÎ.

Có ph¸p: 

Trªn ®©y lµ có ph¸p c¬ b¶n cña thÎ BODY, tuy nhiªn b¾t ®Çu tõ HTML 3.2 th× 

cã nhiÒu thuéc tÝnh ®îc sö dông trong thÎ BODY. Sau ®©y lµ c¸c thuéc tÝnh 

chÝnh:

BACKGROUND= §Æt mét ¶nh nµo ®ã lµm ¶nh nÒn (background) 

cho v¨n b¶n. Gi¸ trÞ cña tham sè nµy (phÇn sau 

dÊu b»ng) lµ URL cña file ¶nh. NÕu kÝch thíc 

¶nh nhá h¬n cöa sæ tr×nh duyÖt th× toµn bé 

mµn h×nh cöa sæ tr×nh duyÖt sÏ ®îc l¸t kÝn 

b»ng nhiÒu ¶nh.

BGCOLOR= §Æt mÇu nÒn cho trang khi hiÓn thÞ. NÕu c¶ 

hai tham sè BACKGROUND vµ BGCOLOR 

cïng cã gi¸ trÞ th× tr×nh duyÖt sÏ hiÓn thÞ mÇu 

nÒn tríc, sau ®ã míi t¶i ¶nh lªn phÝa trªn.

TEXT= X¸c ®Þnh mµu ch÷ cña v¨n b¶n, kÓ c¶ c¸c ®Ò 

môc.

ALINK=,VLINK=,LINK= X¸c ®Þnh mµu s¾c cho c¸c siªu liªn kÕt trong 

v¨n b¶n. T¬ng øng, alink (active link) lµ liªn 

kÕt ®ang ®îc kÝch ho¹t - tøc lµ khi ®· ®îc 

kÝch chuét lªn; vlink (visited link) chØ liªn kÕt 

®· tõng ®îc kÝch ho¹t; 



<HTML>
<HEAD>
<TITLE>Tiªu ®Ò cña tµi liÖu</TITLE>
</HEAD>
<BODY C¸c tham sè nÕu cã>
... Néi dung cña tµi liÖu
</BODY>
</HTML>

Nh vËy mét tµi liÖu HTML cã cÊu trøc nh sau:

2.2.2. Các thẻ định dạng đề mục H1/H2/H3/H4/H5/H6

HTML hç trî 6 møc ®Ò môc. Chó ý r»ng ®Ò môc chØ lµ c¸c chØ dÉn 

®Þnh d¹ng vÒ mÆt logic, tøc lµ mçi tr×nh duyÖt sÏ thÓ hiÖn ®Ò môc díi mét 

khu«n d¹ng thÝch hîp. Cã thÓ ë tr×nh duyÖt nµy lµ font ch÷ 14 point nhng sang 

tr×nh duyÖt kh¸c lµ font ch÷ 20 point. §Ò môc cÊp 1 lµ cao nhÊt vµ gi¶m dÇn 

®Õn cÊp 6. Th«ng thêng v¨n b¶n ë ®Ò môc cÊp 5 hay cÊp 6 thêng cã kÝch th-

íc nhá h¬n v¨n b¶n th«ng thêng. 

Díi ®©y lµ c¸c thÎ dïng ®Ó ®Þnh d¹ng v¨n b¶n ë d¹ng ®Ò môc:

<H1>... </H1> §Þnh d¹ng ®Ò môc cÊp 1

<H2>... </H2> §Þnh d¹ng ®Ò môc cÊp 2

<H3>... </H3> §Þnh d¹ng ®Ò môc cÊp 3

<H4>... </H4> §Þnh d¹ng ®Ò môc cÊp 4

<H5>... </H5> §Þnh d¹ng ®Ò môc cÊp 5

<H6>... </H6> §Þnh d¹ng ®Ò môc cÊp 6

2.2.3 Thẻ xuống dòng BR

ThÎ nµy kh«ng cã thÎ kÕt thóc t¬ng øng (</BR>), nã cã t¸c dông chuyÓn 

sang dßng míi. Lu ý, néi dung v¨n b¶n trong tµi liÖu HTML sÏ ®îc tr×nh duyÖt 

Web thÓ hiÖn liªn tôc, c¸c kho¶ng tr¾ng liÒn nhau, c¸c ký tù tab, ký tù xuèng 

dßng ®Òu ®îc coi nh mét kho¶ng tr¾ng. §Ó xuèng dßng trong tµi liÖu, b¹n ph¶i 

sö dông thÎ <BR>.

2.2.4 Thẻ PRE

§Ó giíi h¹n ®o¹n v¨n b¶n ®· ®îc ®Þnh d¹ng s½n b¹n cã thÓ sö dông thÎ 

<PRE>. V¨n b¶n ë gi÷a hai thÎ nµy sÏ ®îc thÓ hiÖn gièng hÖt nh khi chóng ®îc 



®¸nh vµo, vÝ dô dÊu xuèng dßng trong ®o¹n v¨n b¶n giíi h¹n bëi thÎ <PRE> sÏ 

cã ý nghÜa chuyÓn sang dßng míi (tr×nh duyÖt sÏ kh«ng coi chóng nh dÊu 

c¸ch)

Có ph¸p:

2.3 Các thẻ định dạng danh sách

2.3.1. Danh sách thông thường

Có ph¸p:

Cã 4 kiÓu danh s¸ch:

� ` Danh s¸ch kh«ng s¾p xÕp ( hay kh«ng ®¸nh sè) <UL>

� Danh s¸ch cã s¾p xÕp (hay cã ®¸nh sè) <OL>, mçi môc trong da 

nh s¸ch ®îc s¾p xÕp thø tù.

� Danh s¸ch thùc ®¬n <MENU>

� Danh s¸ch ph©n cÊp <DIR>

Víi nhiÒu tr×nh duyÖt, danh s¸ch ph©n cÊp vµ danh s¸ch thùc ®¬n gièng 

danh s¸ch kh«ng ®¸nh sè, cã thÓ dïng lÉn víi nhau. Víi thÎ OL ta cã có ph¸p sau:

<PRE>V¨n b¶n ®· ®îc ®Þnh d¹ng</PRE>

<UL>
<LI> Môc thø nhÊt
<LI> Môc thø hai
</UL>

<OL TYPE=1/a/A/i/I> 
<LI>Muc thu nhat
<LI>Muc thu hai
<LI>Muc thu ba

</OL>



trong ®ã:

TYPE  =1 C¸c môc ®îc s¾p xÕp theo thø tù 1, 2, 3...

=a C¸c môc ®îc s¾p xÕp theo thø tù a, b, c...

=A C¸c môc ®îc s¾p xÕp theo thø tù A, B, C...

=i C¸c môc ®îc s¾p xÕp theo thø tù i, ii, iii...

=I C¸c môc ®îc s¾p xÕp theo thø tù I, II, III...

Ngoµi ra cßn thuéc tÝnh START= x¸c ®Þnh gi¸ trÞ khëi ®Çu cho danh s¸ch.

ThÎ < LI > cã thuéc tÝnh TYPE= x¸c ®Þnh ký hiÖu ®Çu dßng (bullet) ®øng tríc 

mçi môc trong danh s¸ch. Thuéc tÝnh nµy cã thÓ nhËn c¸c gi¸ trÞ: disc (chÊm 

trßn ®Ëm); circle (vßng trßn); square (h×nh vu«ng).

2.4 Các thẻ định dạng ký tự

2.4.1. Các thẻ định dạng in ký tự

Sau ®©y lµ c¸c thÎ  ®îc sö dông ®Ó quy ®Þnh c¸c thuéc tÝnh nh in 

nghiªng, in ®Ëm, g¹ch ch©n... cho c¸c ký tù, v¨n b¶n khi ®îc thÓ hiÖn trªn tr×nh 

duyÖt.

<B>... </B>
<STRONG>... </STRONG>

In ch÷ ®Ëm

<I>... </I>
<EM>... </EM>

In ch÷ nghiªng

<U>... </U> In ch÷ g¹ch ch©n

<DFN> §¸nh  dÊu  ®o¹n  v¨n  b¶n  gi÷a  hai  thÎ  nµy  lµ 
®Þnh nghÜa cña mét tõ. Chóng thêng ®îc in 
nghiªng hoÆc thÓ hiÖn qua mét  kiÓu  ®Æc 
biÖt nµo ®ã.

<S>... </S>
<STRIKE>... </STRIKE>

In ch÷ bÞ g¹ch ngang.

<BIG>... </BIG> In ch÷ lín h¬n b×nh thêng b»ng c¸ch t¨ng kÝch 
thíc font hiÖn thêi lªn mét. ViÖc sö dông c¸c thÎ 
<BIG>lång nhau t¹o ra hiÖu øng ch÷ t¨ng dÇn. 
Tuy nhiªn ®èi víi mçi tr×nh duyÖt cã giíi h¹n vÒ 
kÝch thíc ®èi víi mçi font ch÷, vît qu¸ giíi h¹n 
nµy, c¸c thÎ <BIG> sÏ kh«ng cã ý nghÜa.



<SMALL>... </SMALL> In  ch÷  nhá  h¬n b×nh thêng  b»ng c¸ch  gi¶m 
kÝch thíc font hiÖn thêi ®i mét. ViÖc sö dông 
c¸c thÎ <SMALL>lång nhau t¹o ra hiÖu øng ch÷ 
gi¶m dÇn. Tuy nhiªn ®èi víi mçi tr×nh duyÖt cã 
giíi h¹n vÒ kÝch thíc ®èi víi mçi font ch÷, vît qu¸ 
giíi  h¹n nµy, c¸c thÎ  <SMALL> sÏ kh«ng cã ý 
nghÜa.

<SUP>... </SUP> §Þnh d¹ng chØ sè trªn (SuperScript)

<SUB>... </SUB> §Þnh d¹ng chØ sè díi (SubScript)

<BASEFONT> §Þnh nghÜa kÝch thíc  font ch÷ ®îc sö dông 
cho  ®Õn hÕt  v¨n  b¶n.  ThÎ  nµy  chØ cã  mét 
tham  sè  size=  x¸c  ®Þnh  cì  ch÷.  ThÎ 
<BASEFONT> kh«ng cã thÎ kÕt thóc.

<FONT>... </FONT> Chän kiÓu ch÷ hiÓn thÞ. Trong thÎ nµy cã thÓ 
®Æt hai tham sè size= hoÆc color= x¸c ®Þnh 
cì ch÷ vµ mµu s¾c ®o¹n v¨n b¶n n»m gi÷a hai 
thÎ. KÝch thíc cã thÓ lµ tuyÖt ®èi (nhËn gi¸ trÞ 
tõ 1 ®Õn 7) hoÆc t¬ng ®èi (+2,-4...) so víi font 
ch÷ hiÖn t¹i.

2.4.2. Căn lề văn bản trong trang Web

Trong tr×nh bµy trang Web cña m×nh c¸c b¹n lu«n ph¶i chó ý ®Õn viÖc 

c¨n lÒ c¸c v¨n b¶n ®Ó trang Web cã ®îc mét bè côc ®Ñp. Mét sè c¸c thÎ ®Þnh 

d¹ng nh P, Hn, IMG... ®Òu cã tham sè ALIGN cho phÐp b¹n c¨n lÒ c¸c v¨n b¶n 

n»m trong ph¹m vi giíi h¹n bëi cña c¸c thÎ ®ã.

C¸c gi¸ trÞ cho tham sè ALIGN:

LEFT C¨n lÒ tr¸i

CENTER C¨n gi÷a trang

RIGHT C¨n lÒ ph¶i

Ngoµi ra, chóng ta cã thÓ sö dông thÎ CENTER ®Ó c¨n gi÷a trang mét khèi v¨n 

b¶n. 

Có ph¸p: <CENTER>V¨n b¶n sÏ ®îc c¨n gi÷a trang</CENTER>

2.4.3. Các ký tự đặc biệt

Ký tù & ®îc sö dông ®Ó chØ chuçi ký tù ®i sau ®îc xem lµ mét thùc thÓ duy 

nhÊt. Ký tù ; ®îc sö dông ®Ó t¸ch c¸c ký tù trong mét tõ.

Ký tù M· ASCII Tªn chuçi

< &#060 &lt



> &#062 &gt

& &#038 &amp

2.4.4. Sử dụng màu sắc trong thiết kế các trang Web

Mét mµu ®îc tæng hîp tõ ba thµnh phÇn mµu chÝnh, ®ã lµ: §á (Red), Xanh l¸ 

c©y (Green), Xanh níc biÓn (Blue). Trong HTML mét gi¸ trÞ mµu lµ mét sè 

nguyªn d¹ng hexa (hÖ ®Õm c¬ sè 16) cã ®Þnh d¹ng nh sau: #RRGGBB

trong ®ã:

RR - lµ gi¸ trÞ mµu §á.

GG - lµ gi¸ trÞ mµu Xanh l¸ c©y.

BB - lµ gi¸ trÞ mµu Xanh níc biÓn.

Mµu s¾c cã thÓ ®îc x¸c ®Þnh qua thuéc tÝnh bgcolor= hay color=. Sau 

dÊu b»ng cã thÓ lµ gi¸ trÞ RGB hay tªn tiÕng Anh cña mµu. Víi tªn tiÕng Anh, 

ta chØ cã thÓ chØ ra 16 mµu trong khi víi gi¸ trÞ RGB ta cã thÓ chØ tíi 256 

mµu.

Sau ®©y lµ mét sè gi¸ trÞ mµu c¬ b¶n:

Mµu s¾c Gi¸ trÞ Tªn tiÕng Anh

§á
§á sÉm
Xanh l¸ c©y
Xanh nh¹t
Xanh níc biÓn
Vµng
Vµng nh¹t
Tr¾ng
§en
X¸m
N©u
TÝm
TÝm nh¹t
Hång
Da cam
Mµu  ®ång  phôc  h¶i 
qu©n

#FF0000
#8B0000
#00FF00
#90EE90
#0000FF
#FFFF00
#FFFFE0
#FFFFFF
#000000
#808080
#A52A2A
#FF00FF
#EE82EE
#FFC0CB
#FFA500
#000080
#4169E1
#7FFFD4

RED
DARKRED
GREEN
LIGHTGREEN
BLUE
YELLOW
LIGHTYELLOW
WHITE
BLACK
GRAY
BROWN
MAGENTA
VIOLET
PINK
ORANGE
NAVY
ROYALBLUE
AQUAMARINE



Có ph¸p: 

<BODY 
   LINK = color
   ALINK = color
   VLINK = color
   BACKGROUND = url
   BGCOLOR = color
   TEXT = color
   TOPMARGIN = pixels
   RIGHTMARGIN = pixels
   LEFTMARGIN = pixels
>
.... phÇn néi dung cña tµi liÖu ®îc ®Æt ë ®©y

</BODY>

Sau ®©y lµ ý nghÜa c¸c tham sè cña thÎ BODY:

C¸c tham sè ý nghÜa

LINK ChØ ®Þnh mµu cña v¨n b¶n siªu liªn kÕt

ALINK ChØ ®Þnh mµu cña v¨n b¶n siªu  liªn  kÕt  ®ang ®ang 
chän

VLINK ChØ ®Þnh mµu cña v¨n b¶n siªu liªn kÕt ®· tõng më

BACKGROUND ChØ ®Þnh ®Þa chØ cña ¶nh dïng lµm nÒn

BGCOLOR ChØ ®Þnh mµu nÒn

TEXT ChØ ®Þnh mµu cña v¨n b¶n trong tµi liÖu

SCROLL YES/NO - X¸c ®Þnh cã hay kh«ng thanh cuén

TOPMARGIN LÒ trªn

RIGHTMARGIN LÒ ph¶i

LEFTMARGIN LÒ tr¸i

2.4.5. Chọn kiểu chữ cho văn bản

Có ph¸p:



<FONT 
FACE = font-name 
COLOR = color 
SIZE = n >
... 
</FONT>

2.4.6. Khái niệm văn bản siêu liên kết

V¨n b¶n siªu liªn kÕt hay cßn gäi lµ siªu v¨n b¶n lµ mét tõ, mét côm tõ hay mét 

c©u trªn trang Web ®îc dïng ®Ó liªn kÕt tíi mét trang Web kh¸c. Siªu v¨n b¶n lµ 

m«i trêng trong ®ã chøa c¸c liªn kÕt (link) cña c¸c th«ng tin. Do WWW cÊu 

thµnh tõ nhiÒu hÖ thèng kh¸c nhau, cÇn ph¶i cã mét quy t¾c ®Æt tªn thèng 

nhÊt cho tÊt c¶ c¸c v¨n b¶n trªn Web. Quy t¾c ®Æt tªn ®ã lµ URL (Universal 

Resource Locator).

C¸c thµnh phÇn cña URL ®îc minh ho¹ ë h×nh trªn.

�  DÞch vô: Lµ thµnh phÇn b¾t buéc cña URL. Nã x¸c ®Þnh c¸ch thøc tr×nh 

duyÖt cña m¸y kh¸ch liªn l¹c víi m¸y phôc vô nh thÕ nµo ®Ó nhËn d÷ liÖu. Cã 

nhiÒu dÞch vô nh http, wais, ftp, gopher, telnet.

�  Tªn hÖ thèng: Lµ thµnh phÇn b¾t buéc cña URL.  Cã thÓ lµ tªn miÒn ®Çy 

®ñ cña m¸y phôc vô hoÆc chØ lµ mét phÇn tªn ®Çy ®ñ – trêng hîp nµy x¶y ra 

khi v¨n b¶n ®îc yªu cÇu vÉn n»m trªn miÒn cña b¹n. Tuy nhiªn nªn sö dông ®-

êng dÉn ®Çy ®ñ.

�  Cæng: Kh«ng lµ thµnh phÇn b¾t buéc cña URL. Cæng lµ ®Þa chØ socket 

cña m¹ng dµnh cho mét giao thøc cô thÓ. Giao thøc http ngÇm ®Þnh nèi víi 

cæng 8080.

�  §  êng dÉn th   môc  : Lµ thµnh phÇn b¾t buéc cña URL. Ph¶i chØ ra ®êng dÉn 

tíi file yªu cÇu khi kÕt nèi víi bÊt kú hÖ thèng nµo. Cã thÓ ®êng dÉn trong URL 

kh¸c víi ®êng dÉn thùc sù trong hÖ thèng m¸y phôc vô. Tuy nhiªn cã thÓ rót  



gän ®êng dÉn b»ng c¸ch ®Æt biÖt danh (alias). C¸c th môc trong ®êng dÉn 

c¸ch nhau bëi dÊu g¹ch chÐo (/).

Tªn file  :   Kh«ng lµ thµnh phÇn b¾t buéc cña URL. Th«ng thêng m¸y phôc vô ®-

îc cÊu h×nh sao cho nÕu kh«ng chØ ra tªn file th× sÏ tr¶ vÒ file ngÇm ®Þnh trªn 

th môc ®îc yªu cÇu. File nµy thêng cã tªn lµ index.html, index.htm, default.html 

hay default.htm. NÕu còng kh«ng cã c¸c file nµy th× thêng kÕt qu¶ tr¶ vÒ lµ 

danh s¸ch liÖt kª c¸c file hay th môc con trong th môc ®îc yªu cÇu

C¸c tham sè: Kh«ng lµ thµnh phÇn b¾t buéc cña URL. NÕu URL lµ yªu cÇu 

t×m kiÕm trªn mét c¬ së d÷ liÖu th× truy vÊn sÏ g¾n vµo URL, ®ã chÝnh lµ 

®o¹n m· ®»ng sau dÊu chÊm hái (?).URL còng cã thÓ tr¶ l¹i th«ng tin ®îc thu 

thËp tõ form. Trong trêng hîp dÊu th¨ng (#) xuÊt hiÖn ®o¹n m· ®¨ng sau lµ tªn 

cña mét vÞ trÝ (location) trong file ®îc chØ ra.

 §Ó t¹o ra mét siªu v¨n b¶n chóng ta sö dông thÎ <A>.

Có ph¸p:

<A
HREF              =  url
NAME              = name
TABINDEX = n
TITLE            = title
TARGET = _blank / _self

>
... siªu v¨n b¶n

</A>

ý nghÜa c¸c tham sè:

HREF §Þa chØ cña trang Web ®îc liªn kÕt, lµ mét URL nµo ®ã.

NAME §Æt tªn cho vÞ trÝ ®Æt thÎ.

TABLEINDEX Thø tù di chuyÓn khi Ên phÝm Tab

TITLE V¨n b¶n hiÓn thÞ khi di chuét trªn siªu liªn kÕt.

TARGET Më  trang  Web  ®îc  liªn  trong  mét  cöa  sæ  míi  (_blank) 
hoÆc trong cöa sæ hiÖn t¹i (_self), trong mét frame (tªn 
frame).



2.4.7. Địa chỉ tương đối

URL ®îc tr×nh bµy ë trªn lµ URL tuyÖt ®èi. Ngoµi ra cßn cã URL t¬ng 

®èi hay cßn gäi lµ URL kh«ng ®Çy ®ñ. §Þa chØ t¬ng ®èi sö dông sù kh¸c biÖt 

t¬ng ®èi gi÷a v¨n b¶n hiÖn thêi vµ v¨n b¶n cÇn tham chiÕu tíi. C¸c thµnh phÇn 

trong URL ®îc ng¨n c¸ch b»ng ký tù ng¨n c¸ch (ký tù g¹ch chÐo /). §Ó t¹o ra URL 

t¬ng ®èi, ®Çu tiªn ph¶i sö dông ký tù ng¨n c¸ch. URL ®Çy ®ñ hiÖn t¹i sÏ ®îc sö 

dông ®Ó t¹o nªn URL ®Çy ®ñ míi. Nguyªn t¾c lµ c¸c thµnh phÇn bªn tr¸i dÊu 

ng¨n c¸ch cña URL hiÖn t¹i ®îc gi÷ nguyªn, c¸c thµnh phÇn bªn ph¶i ®îc thay 

thÕ b»ng thµnh phÇn URL t¬ng ®èi. Chó ý r»ng tr×nh duyÖt kh«ng göi URL t-

¬ng ®èi, nã bæ sung vµo URL c¬ së ®· x¸c ®Þnh tríc thµnh phÇn URL t¬ng ®èi 

x¸c ®Þnh sau thuéc tÝnh href=. Ký tù ®Çu tiªn sau dÊu b»ng sÏ x¸c ®Þnh c¸c 

thµnh phÇn nµo cña URL hiÖn t¹i sÏ tham gia ®Ó t¹o nªn URL míi.

VÝ  dô,  nÕu  URL  ®Çy  ®ñ  lµ:  http://it-

department.vnuh.edu.vn/HTML/index.htm th×:

� DÊu hai chÊm (:  )   chØ dÞch vô gi÷ nguyªn nhng thay ®æi phÇn cßn l¹i. VÝ 

dô://www.fpt.com/ sÏ t¶i trang chñ cña m¸y phôc vô www.fpt.com víi cïng 

dÞch vô http.

� DÊu g¹ch chÐo (/) chØ dÞch vô vµ m¸y phôc vô gi÷ nguyªn nhng toµn bé ®-

êng dÉn thay ®æi. VÝ dô /Javascript/index.htm sÏ t¶i file  index.htm cña 

th môc Javascript trªn m¸y phôc vô www.it-department.vnuh.edu.vn.

� Kh«ng cã dÊu ph©n c¸ch chØ cã tªn file lµ thay ®æi. VÝ dô index1.htm sÏ 

t¶i  file  index1.htm ë  trong  th môc  HTML  cña  m¸y  phôc  vô  www.it-

department.vnuh.edu.vn.

� DÊu th¨ng (#): chØ dÞch vô, m¸y phuc vô, ®êng dÉn vµ c¶ tªn file gi÷ 

nguyªn, chØ thay ®æi vÞ trÝ trong file.

Do ®êng dÉn ®îc xem lµ ®¬n vÞ ®éc lËp nªn cã thÓ sö dông ph¬ng 

ph¸p ®êng dÉn t¬ng ®èi nh trong UNIX hay MS-DOS (tøc lµ. chØ th môc hiÖn 

t¹i cßn.. chØ th môc cha cña th môc hiÖn t¹i).

URL c¬ së cã thÓ ®îc x¸c ®Þnh b»ng thÎ <BASE>. 



2.4.8. Kết nối mailto

NÕu ®Æt thuéc tÝnh href= cña thÎ <a> gi¸ trÞ mailto:address@domain 

th× khi kÝch ho¹t kÕt nèi sÏ kÝch ho¹t chøc n¨ng th ®iÖn tö cña tr×nh duyÖt.

<ADDRESS>
Trang WEB nµy ®îc 
<A href=”mailto:webmaster@vnuh.edu.vn” >
WEBMASTER
<\A> b¶o tr×
<\ADDRESS>



2.4.9. Vẽ một đường thẳng nằm ngang

Có ph¸p:

<HR
ALIGN = LEFT / CENTER / RIGHT
COLOR = color
NOSHADE
SIZE = n
WIDTH = width

>

ý nghÜa c¸c tham sè:

ALIGN C¨n lÒ (c¨n tr¸i, c¨n ph¶i, c¨n gi÷a)

COLOR §Æt mµu cho ®êng th¼ng

NOSHADE Kh«ng cã bang

SIZE §é dµy cña ®êng th¼ng

WIDTH ChiÒu dµi (tÝnh theo pixel hoÆc % cña bÒ réng 
cöa sæ tr×nh duyÖt).

ThÎ nµy gièng nh thÎ BR, nã còng kh«ng cã thÎ kÕt thóc t¬ng øng. 

2.5 Các thẻ chèn âm thanh, hình ảnh 

2.5.1. Giới thiệu

Liªn kÕt víi file ®a ph¬ng tiÖn còng t¬ng tù nh liªn kÕt b×nh thêng. Tuy vËy 

ph¶i ®Æt tªn ®óng cho file ®a ph¬ng tiÖn. PhÇn më réng cña file ph¶i cho biÕt 

kiÓu cña file. 

KiÓu PhÇn më 
réng

M« t¶

Image/GIF .gif ViÕt t¾t cña Graphics Interchange Format. 
Khu«n d¹ng nµy xuÊt hiÖn khi mäi ngêi cã nhu 

cÇu trao ®æi ¶nh trªn nhiÒu hÖ thèng kh¸c 
nhau. Nã ®îc sö dông trªn tÊt c¶ c¸c hÖ thèng 

hç trî giao diÖn ®å ho¹. §Þnh d¹ng GIF lµ ®Þnh 
d¹ng chuÈn cho mäi tr×nh duyÖt WEB. Nhîc 
®iÓm cña nã lµ chØ thÓ hiÖn ®îc 256 mµu.
Më réng cña chuÈn nµy lµ GIF89, ®îc thªm 

nhiÒu chøc n¨ng cho c¸c øng dông ®Æc biÖt 
nh lµm ¶nh nÒn trong suèt - tøc lµ ¶nh cã thÓ 

næi b»ng c¸ch lµm mµu nÒn gièng víi mµu nÒn 
cña tr×nh duyÖt.



Image/JPEG .jpeg ViÕt t¾t cña Joint Photographic Expert Group. 
Lµ khu«n d¹ng ¶nh kh¸c nhng cã thªm kh¶ n¨ng 
nÐn.¦u ®iÓm næi bËt cña khu«n d¹ng nµy lµ lu 

tr÷ ®îc hµng triÖu mµu vµ ®é nÐn cao nªn kÝch 
thíc file ¶nh nhá h¬n vµ thêi gian download 

nhanh h¬n. Nã lµ c¬ së cho khu«n d¹ng MPEG. 
TÊt c¶ c¸c tr×nh duyÖt ®Òu cã kh¶ n¨ng xem 

¶nh JPEG. 

Image/TIFF .tiff ViÕt t¾t cña Tagged Image File Format. §îc 
Microsoft thiÕt kÕ ®Ó quÐt ¶nh tõ m¸y quÐt 

còng nh t¹o c¸c Ên phÈm.

Text/HTML .
HTML,.htm

PostScript .eps,.ps §îc t¹o ra ®Ó hiÓn thÞ vµ in c¸c v¨n b¶n cã chÊt 
lîng cao.

Adobe 
Acrobat

.pdf ViÕt t¾t cña Portable Document Format. 
Acrobat còng sö dông c¸c siªu liªn kÕt ngay 
trong v¨n b¶n còng gièng nh HTML. Tõ phiªn 
b¶n 2.0, c¸c s¶n phÈm cña Acrobat cho phÐp 
liªn kÕt gi÷a nhiÒu v¨n b¶n. ¦u ®iÓm lín nhÊt 

cña nã lµ kh¶ n¨ng WYSISYG.

Video/MPEG .mpeg ViÕt t¾t cña Motion Picture Expert Group, lµ 
®Þnh d¹ng dµnh cho c¸c lo¹i phim (video). §©y 
lµ khu«n d¹ng th«ng dông nhÊt dµnh cho phim 

trªn WEB.

Video/AVI .avi Lµ khu«n dn¹g phim do Microsoft ®a ra.

Video/QuickT
ime

.mov Do Apple Computer ®a ra, chuÈn video nµy ®îc 
cho lµ cã nhiÒu u ®iÓm h¬n MPEG vµ AVI. 

MÆc dï ®· ®îc tÝch hîp vµo nhiÒu tr×nh duyÖt 
nhng vÉn cha phæ biÕn b»ng hai lo¹i ®Þnh 

d¹ng trªn.

Sound/AU .au

Sound/MIDI .mid Lµ khu«n d¹ng dµnh cho ©m nh¹c ®iÖn tö hÕt 
søc th«ng dông ®îc nhiÒu tr×nh duyÖt trªn c¸c 
hÖ thèng kh¸c nhau hç trî.  File Midi ®îc tæng 
hîp sè ho¸ trùc tiÕp tõ m¸y tÝnh.

Sound/Real
Audio

.ram §Þnh d¹ng audio theo dßng. Mét bÊt tiÖn khi sö 
dông c¸c ®Þnh d¹ng kh¸c lµ file ©m thanh thêng 
cã kÝch thíc lín - do vËy thêi gian t¶i xuèng l©u, 
Tr¸i l¹i audio dßng b¾t ®Çu ch¬i ngay khi t¶i ®îc 
mét  phÇn file  trong  khi  vÉn  t¶i  vÒ  c¸c  phÇn 
kh¸c.MÆc dï file theo ®Þnh d¹ng nµy kh«ng nhá 
h¬n so víi c¸c ®Þnh d¹ng kh¸c song chÝnh kh¶ 
n¨ng dßng ®· khiÕn ®Þnh d¹ng nµy phï hîp víi 
kh¶ n¨ng ch¬i ngay lËp tøc.

VRML .vrml ViÕt t¾t cña Virtual Reality Modeling Language. 



C¸c  file  theo  ®Þnh  d¹ng  nµy  còng  gièng  nh 
HTML. Tuy nhiªn do tr×nh duyÖt cã thÓ hiÓn 
thÞ ®îc cöa sæ 3 chiÒu nªn ngêi xem cã thÓ 
c¶m nhËn ®îc c¶m gi¸c ba chiÒu.

2.5.2. Đưa âm thanh vào một tài liệu HTML

Có ph¸p:

<BGSOUND
SRC = url
LOOP = n

>

ThÎ nµy kh«ng cã thÎ kÕt thóc t¬ng øng (</BGSOUND>). §Ó ch¬i lÆp l¹i 

v« h¹n cÇn chØ ®Þnh  LOOP = -1 hoÆc  LOOP =  INFINITE. ThÎ  BGSOUND 

ph¶i ®îc ®Æt trong phÇn më ®Çu (tøc lµ n»m trong cÆp thÎ HEAD).

2.5.3. Chèn một hình ảnh, một đoạn video vào tài liệu HTML

§Ó chÌn mét file ¶nh (.jpg,.gif,.bmp) hoÆc video (.mpg,.avi) vµo tµi liÖu HTML, 

b¹n cã thÓ sö dông thÎ IMG.

Có ph¸p:

<IMG
ALIGN = TOP/MIDDLE/BOTTOM
ALT = text
BORDER = n
SRC = url
WIDTH = width
HEIGHT = height
HSPACE = vspace
VSPACE = hspace
TITLE             = title
DYNSRC = url
START = 
FILEOPEN/MOUSEOVER
LOOP             = n
>



Trong ®ã:

ALIGN =  TOP/  MIDDLE/ 
BOTTOM/ LEFT/ RIGHT

C¨n hµng v¨n b¶n bao quanh ¶nh

ALT = text ChØ ®Þnh v¨n b¶n sÏ ®îc hiÓn thÞ nÕu chøc 
n¨ng show picture cña browser bÞ t¾t ®i hay 
hiÓn thÞ thay thÕ cho ¶nh trªn nh÷ng tr×nh 
duyÖt kh«ng cã kh¶ n¨ng hiÓn thÞ ®å ho¹. 
V¨n b¶n nµy cßn ®îc gäi lµ nh·n cña ¶nh. §èi 
víi  tr×nh  duyÖt  cã  kh¶  n¨ng  hç  trî  ®å ho¹, 
dßng v¨n b¶n nµy sÏ hiÖn lªn khi di chuét qua 
¶nh hay ®îc hiÓn thÞ trong vïng cña ¶nh nÕu 
¶nh cha ®îc t¶i vÒ hÕt. Chó ý ph¶i ®Æt v¨n 
b¶n trong hai dÊu nh¸y kÐp nÕu triong v¨n 
b¶n chøa dÊu c¸ch hay c¸c ký tù ®Æc biÖt - 
trong trêng hîp ngîc l¹i  cã thÓ bá dÊu nh¸y 
kÐp.

BORDER = n §Æt kÝch thíc ®êng viÒn ®îc vÏ quanh ¶nh 
(tÝnh theo pixel).

SRC = url §Þa chØ cña file ¶nh cÇn chÌn vµo tµi liÖu.

WIDTH/HEIGHT ChØ ®Þnh kÝch thíc cña ¶nh ®îc hiÓn thÞ.

HSPACE/VSPACE ChØ ®Þnh kho¶ng trèng xung quanh h×nh 
¶nh (tÝnh theo pixel) theo bèn phÝa trªn, díi, 
tr¸i, ph¶i.

TITLE = title V¨n b¶n sÏ hiÓn thÞ khi con chuét trá trªn ¶nh

DYNSRC = url §Þa chØ cña file video.

START = 
FILEOPEN/MOUSEOVER

ChØ ®Þnh file video sÏ ®îc ch¬i khi tµi liÖu 
®îc më hay khi trá con chuét vµo nã. Cã thÓ 
kÕt  hîp  c¶  hai  gi¸  trÞ  nµy nhng ph¶i  ph©n 
c¸ch chóng bëi dÊu phÈy.

LOOP = n/INFINITE ChØ  ®Þnh  sè  lÇn  ch¬i.  NÕu  LOOP  = 
INFINITE th× file video sÏ ®îc ch¬i v« h¹n lÇn.

2.6  Các thẻ định dạng bảng biểu

Sau ®©y lµ c¸c thÎ t¹o b¶ng chÝnh:

<TABLE>... </TABLE> §Þnh nghÜa mét b¶ng

<TR>... </TR> §Þnh  nghÜa  mét  hµng  trong 
b¶ng

<TD>... </TD> §Þnh nghÜa mét « trong hµng

<TH>... </TH> §Þnh  nghÜa  «  chøa  tiªu  ®Ò 
cña cét

<CAPTION>... </CAPTION> Tiªu ®Ò cña b¶ng



Có ph¸p: 

TABLE 
ALIGN = LEFT / CENTER / RIGHT
BORDER = n 
BORDERCOLOR = color
BORDERCOLORDARK = color
BORDERCOLORLIGHT = color
BACKGROUND = url
BGCOLOR = color
CELLSPACING = spacing 
CELLPADDING = pading
>
<CAPTION>Tiªu ®Ò cña b¶ng biÓu</CAPTION>
... §Þnh nghÜa c¸c dßng
<TR 
ALIGN = LEFT/CENTER/RIGHT 
VALIGN = TOP/MIDDLE/BOTTOM>

... §Þnh nghÜa c¸c « trong dßng
<TD 
ALIGN = LEFT / CENTER / RIGHT 
VALIGN = TOP / MIDDLE / BOTTOM
BORDERCOLOR = color
BORDERCOLORDARK = color
BORDERCOLORLIGHT = color
BACKBROUND = url
BGCOLOR = color
COLSPAN = n
ROWSPAN = n
>
... Néi dung cña «
</TD>
...
</TR>
...
</TABLE>



ý nghÜa c¸c tham sè:

ALIGN / VALIGN C¨n lÒ cho b¶ng vµ néi dung trong mçi «.

BORDER KÝch thíc ®êng kÎ chia « trong b¶ng, ®îc ®o theo 
pixel. Gi¸ trÞ 0 cã nghÜa lµ kh«ng x¸c ®Þnh lÒ, 
gi÷a c¸c « trong b¶ng chØ cã mét kho¶ng tr¾ng 
nhá  ®Ó  ph©n  biÖt.  NÕu  chØ  ®Ó  border  th× 
ngÇm ®Þnh border=1.  Víi  nh÷ng b¶ng cã  cÊu 
tróc phøc t¹p, nªn ®Æt lÒ ®Ó ngêi xem cã thÓ 
ph©n biÖt râ c¸c dßng vµ cét.

BORDERCOLOR Mµu ®êng kÎ

BORDERCOLORDARK

BORDERCOLORLIGHT

Mµu phÝa tèi vµ phÝa s¸ng cho ®êng kÎ næi.

BACKGROUND §Þa chØ tíi tÖp ¶nh dïng lµm nÒn cho b¶ng

BGCOLOR Mµu nÒn

CELLSPACING Kho¶ng c¸ch gi÷a c¸c « trong b¶ng

CELLPADDING Kho¶ng c¸ch gi÷a néi dung vµ ®êng kÎ trong mçi 
« cña b¶ng.

COLSPAN ChØ ®Þnh « sÏ kÐo dµi trong bao nhiªu cét

ROWSPAN ChØ ®Þnh « sÏ kÐo dµi trong bao nhiªu hµng

 2.7 FORM

2.7.1. HTML Forms

 C¸c HTML Form cã thÓ cã c¸c hép v¨n b¶n, hép danh s¸ch lùa chän, nót bÊm, 
nót chän...

2.7.2. Tạo Form

§Ó t¹o ra mét form trong tµi liÖu HTML, chóng ta sö dông thÎ FORM víi có ph¸p 
nh sau:

<FORM
ACTION = ulr
METHOD = GET | POST
NAME = name
TARGET = frame_name  |  _blank  |   _self
>
<!-- C¸c phÇn tö ®iÒu khiÓn cña form ®îc ®Æt ë 

®©y -->
<INPUT...>
<INPUT...>

</FORM>



Trong ®ã

ACTION §Þa chØ sÏ göi d÷ liÖu tíi khi form ®îc submit (cã thÓ 
lµ  ®Þa  chØ  tíi  mét  ch¬ng  tr×nh  CGI,  mét  trang 
ASP...).

METHOD Ph¬ng thøc göi d÷ liÖu.

NAME Tªn cña form.

TARGET ChØ ®Þnh cöa sæ sÏ hiÓn thÞ kÕt qu¶ sau khi göi 
d÷ liÖu tõ form ®Õn server.

§Æt c¸c ®èi tîng ®iÓu khiÓn (nh hép v¨n b¶n, « kiÓm tra, nót bÊm...) vµo trang 
Web

Có ph¸p thÎ INPUT:

<INPUT
ALIGN = LEFT | CENTER | RIGHT
TYPE = BUTTON | CHECKBOX | FILE | IMAGE | PASSWORD | 
RADIO | RESET | SUBMIT | TEXT
VALUE = value
>

2.7.3. Tạo một danh sách lựa chọn

Có ph¸p:

<SELECT NAME="tªn danh s¸ch"  SIZE="chiÒu cao">
<OPTION VALUE=value1  SELECTED>  Tªn  môc  chän  thø 
nhÊt
<OPTION VALUE=value2> Tªn môc chän thø hai
<!-- Danh s¸ch c¸c môc chän -->
</SELECT>

2.7.4. Tạo hộp soạn thảo văn bản

Có ph¸p:

<TEXTAREA
COLS=sè cét
ROWS=sè hµng
NAME=tªn

>
V¨n b¶n ban ®Çu

</TEXTAREA>



3. Th c hànhự

3.1 Tạo trang web cho nhóm.

� Khëi ®éng notepad.

� So¹n trang web c¸ nh©n cña nhãm ®Æt tªn lµ  InfoGroup<n>.htm (vÝ 

dô nhãm 1 sÏ lÊy tªn lµ InfoGroup1.htm). C¸c th«ng tin chÝnh cña c¸c 

thµnh viªn trong nhãm bao gåm: Hä vµ tªn, C«ng viÖc vµ chøc vô hiÖn 

nay,  §Þa chØ liªn l¹c,  §iÖn tho¹i, Fax, Email, Mobile Phone,... Ngoµi ra 

c¸c nhãm cã thÓ bæ sung c¸c th«ng tin kh¸c.

� Upload trang web ®· so¹n lªn website.

� Thö truy cËp trang web ®· t¶i lªn.

Tham kh¶o c¸c site th«ng tin cña ViÖt Nam

� http://vnexpress.net/    

� http://www.vnn.vn/   .

� http://www.vdc.com.vn    

Tham kh¶o c¸c site b¸n hµng næi tiÕng 

� http://shopping.yahoo.com    

� http://www.amazon.com   

Tham kh¶o c¸c site gi¶i trÝ

� http://greetings.yahoo.com   

� http://www.vnn.vn/ecards/   

� http://www.fpt.vn/Postcard/main.asp   

� http://www.geraldstevens.com/   

� http://www.1800flowers.com/   

Tham kh¶o c¸c site vÒ lao ®éng viÖc lµm t¹i VN

� http://203.162.5.43/ld2000/   

� http://www.vietname­business.com/jobnld/   

� http://www.jobsonline.saigonnet.vn/   

http://www.jobsonline.saigonnet.vn/
http://www.vietname-business.com/jobnld/
http://203.162.5.43/ld2000/
http://www.1800flowers.com/
http://www.geraldstevens.com/
http://www.fpt.vn/Postcard/main.asp
http://www.vnn.vn/ecards/
http://greetings.yahoo.com/
http://www.amazon.com/
http://shopping.yahoo.com/
http://www.vdc.com.vn/
http://www.vnn.vn/
http://vnexpress.net/


T¹o trang web chøa c¸c hyperlink dïng ®Ó truy cËp nhanh

� T¹o trang web  ®Æt tªn lµ Links.htm chøa c¸c hyperlink  ®·  ®Ò cËp  ë 

trªn. Bæ sung thªm c¸c hyperlink vµ c¸c ph©n lo¹i kh¸c mµ c¸c anh chÞ ®· 

biÕt.

� Upload lªn website vµ kiÓm tra l¹i.

T¹o trang HomePage

� T¹o trang web HomePage ®Æt tªn lµ Default.htm giíi thiÖu vÒ nhãm vµ 

c¸c c«ng viÖc mµ nhãm ®ang triÓn khai.

� KÕt nèi hai trang ®· t¹o vµo HomePage.

� Upload lªn website vµ kiÓm tra l¹i.

Chän chñ ®Ò thiÕt kÕ website.

� Website vÒ dÞch vô viÖc lµm.

� Website vÒ dÞch vô nhµ ®Êt (http://www.nhadat.com).

� Website b¸o ®iÖn tö (http://vnexpress.net )

� Website trêng häc.

� Website b¸n hµng (cöa hµng, siªu thÞ ¶o trªn Internet)

� Website dÞch vô gi¶i trÝ nh ECards, §iÖn hoa,...

� C¸c chñ ®Ò kh¸c...

http://vnexpress.net/
http://www.nhadat.com/


3.2 Đăng ký website miễn phí trên Internet.

1. Vµo ®Þa chØ http://www.freeservers.com ®Ó ®¨ng kÝ website miÔn phÝ víi 

®Þa chØ truy cËp cã d¹ng http://<yourname>.freeservers.com 

2. Gõ vào địa chỉ mà chúng ta dự định đăng kí tại ô yourname. Sau đó click Go. Màn hình tiếp 

theo sẽ hiện ra, chúng ta chọn mục cuối cùng 100% Free Hosting Option và click vào SignUp

http://www.freeservers.com/


3. Sau đó chúng ta hãy điền vào các thông tin liên quan cần thiết như Họ tên, mật khẩu, email, 

… Cuối cùng gõ vào ARTK để chắc rằng chúng ta đã đồng ý với các qui định của FreeServers 

khi cung cấp dịch vụ miễn phí này.

4. Nếu đăng kí thành công, màn hình sau sẽ hiện ra để cung cấp cho chúng ta một số lựa 

chọn khi xây dựng website của mình.



3.3 Thiết kế một số website mẫu.

1. Thiết kế website theo mẫu sau (http://greetings.yahoo.com)

2. Thiết kế website theo mẫu sau (http://www.flowers.com)

http://www.flowers.com/
http://greetings.yahoo.com/


3. Thiết kế website theo mẫu sau (http://shopping.yahoo.com)

4. Thiết kế website theo mẫu sau (http://www.is­edu.hcmuns.edu.vn)

http://www.is-edu.hcmuns.edu.vn/
http://shopping.yahoo.com/


5. Thiết kế website theo mẫu sau (http://vnexpress.net)

6. Thiết kế website theo mẫu sau (http://www.codeproject.com)

http://www.codeproject.com/
http://vnexpress.net/


7. Thiết kế website theo mẫu sau (http://www.bttvn.com )

Để 

tham khảo cách thiết kế các trang web trên, hãy:

­ Tải về máy bằng cách chọn chức năng Save của IE.

­ Dùng MS Front Page ho c notepad ặ để mở tập tin đã lưu lên

­ Chuyển qua lại giữa các màn hình Normal View và HMTL View để biết cách thiết kế

Với mỗi trang web đã xem hãy chú ý các vấn đề sau:

­ Cách bố trí các bảng (table)

­ Cách sử dụng font chữ

­ Cách chèn vào các hình ảnh để trang trí

­ Cách định nghĩa các thuộc tính như màu chữ, màu nền,...

­ Phần tĩnh (không thay đổi) mỗi khi click vào các hyperlink chuyển qua một nội dung 

mới

Từ các trang web trên, hãy tự thiết kế các trang cho website của nhóm.

 

http://www.bttvn.com/


Chương 3

 Thao tác với phần mềm tạo web

Ch¬ng nµy giíi thiÖu cho chóng ta hai phÇn kh¸ quan träng trong viÖc 

ph¸t triÓn website ®ã lµ web server vµ c¸c c«ng cô trî gióp trong c«ng viÖc thiÕt 

kÕ web.

HiÖn nay, cã rÊt nhiÒu lo¹i webserver còng nh c¸c tools phôc vô cho chóng 

ta ph¸t triÓn website. Tuy nhiªn, trong ph¹m vi gi¸o tr×nh nµy chóng ta sÏ t×m 

hiÓu vÒ IIS (Internet Infomation Services) vµ Dreamweaver MX. 

 IIS  lµ mét dÞch vô dµnh cho m¸y  chñ ch¹y  trªn  nÒn hÖ ®iÒu hµnh 

Window nh»m cung cÊp vµ ph©n t¸n c¸c th«ng tin lªn m¹ng. BÊt kú mét 

trang web ®éng nµo còng cÇn ph¶i cã mét web server xö lý th× trang 

web ®ã míi hiÓn thÞ ®îc néi dung cho ngowif dïng. Chóng ta sÏ t×m hiÓu 

s©u h¬n vÒ ®iÒu nµy trong ch¬ng 5 “Liªn kÕt trang web ®Õn hÖ CSDL 

– X©y dùng c¸c trang web ®éng c¬ b¶n” vµ ch¬ng 6 “ThiÕt kÕ web 

®éng b»ng Dreamweaver MX”.

 Dreamweaver lµ mét c«ng cô kh¸ m¹nh trong viÖc gióp ®ì chóng ta gi¶m 

thiÓu thêi gian trong qu¸ tr×nh thiÕt kÕ web. NÕu trong ch¬ng 2 chóng 

ta thiÕt kÕ mét trang web b»ng tr×nh so¹n th¶o notepad th× chóng ta sÏ 

thÊy Dreamweaver tuyÖt vêi nh thÕ nµo.

Môc tiªu

Sau khi häc xong ch¬ng nµy, chóng ta sÏ:

 Cµi ®Æt vµ cÊu h×nh ®îc IIS.

 Ph©n tÝch ®îc c¸c u, nhîc ®iÓm cña IIS víi c¸c webserver kh¸c.

 ThiÕt  kÕ  ®îc  c¸c  Forms,  Tables  ...  b»ng  c«ng  cô  trùc  quan  trong 

Dreamweaver.

 ThiÕt kÕ ®îc mét website bÊt kú b»ng Dreamweaver.





1. Giới thiệu về IIS- Internet Information Services

1.1 IIS là gì?

Microsoft  Internet  Information  Services  (dÞch  vô  cung  cÊp  th«ng  tin 

Internet) lµ dÞch vô dµnh cho m¸y chñ ch¹y trªn nÒn hÖ ®iÒu hµnh Window 

nh»m cung cÊp vµ ph©n t¸n c¸c th«ng tin lªn m¹ng, nã bao gåm nhiÒu dÞch vô 

kh¸c nhau nh Web Server, FTP Server,... Nã cã thÓ ®îc sö dông ®Ó xuÊt b¶n 

néi dung cña c¸c trang Web lªn Internet/Intranet b»ng viÖc sö dông “Ph¬ng thøc 

chuyÓn giao siªu v¨n b¶n“ - Hypertext Transport Protocol (HTTP). Nh vËy, sau 

khi b¹n thiÕt kÕ xong c¸c trang Web cña m×nh, nÕu b¹n muèn ®a chóng lªn 

m¹ng ®Ó mäi ngêi cã thÓ truy cËp vµ xem chóng th× b¹n ph¶i nhê ®Õn mét 

Web Server, ë ®©y lµ IIS. NÕu kh«ng th× trang Web cña b¹n chØ cã thÓ ®îc 

xem trªn chÝnh m¸y cña b¹n hoÆc th«ng qua viÖc chia sÎ tÖp (file sharing) nh

c¸c tÖp bÊt kú trong m¹ng néi bé mµ th«i.

1.2 IIS có thể làm được gì? 

Nhiệm vụ của IIS là tiếp nhận yªu cầu của m¸y trạm và đ¸p ứng lại yªu 

cầu  đã bằng c¸ch gửi  về m¸y trạm những th«ng tin mà m¸y trạm yªu cầu. 

Chóng ta cã thể sử dụng IIS để: 

 Xuất bản một Website của chóng ta trªn Internet.

 Tạo c¸c giao dịch thương mại  điện tử trªn Internet (hiện c¸c catalog và 

nhận được c¸c đơn đặt hàng từ nguời tiªu dïng).

 Chia sẻ file dữ liệu th«ng qua giao thức FTP.

 Cho phÐp người  ở xa cã thể truy xuất database của chóng ta (gọi là 

Database remote access). 

 Và rất nhiều khả năng kh¸c...



1.3 IIS hoạt động như thế nào?

IIS  sử dụng  c¸c  giao  thức  mạng  phổ biến  là  HTTP  (Hyper  Text  Transfer 

Protocol) và FPT (File Transfer Protocol) và một số giao thức kh¸c như SMTP, 

POP3,...  để tiếp nhận yªu cầu và truyền tải th«ng tin trªn mạng với c¸c  định 

dạng kh¸c nhau. Một trong những dịch vụ phổ biến nhất của IIS mà chóng ta 

quan t©m trong gi¸o tr×nh này là dịch vụ WWW (World Wide Web), nãi tắt là 

dịch vụ Web. Dịch vụ Web sử dụng giao thức HTTP  để tiếp nhận yªu cầu 

(Requests) của tr×nh duyệt Web (Web browser) dưới dạng một  địa chỉ URL 

(Uniform Resource Locator) của một trang Web và IIS phản hồi lại c¸c yªu cầu 

bằng c¸ch gửi về cho Web browser nội dung của trang Web tương ứng.

1.4 Cài đặt IIS

Cµi ®Æt IIS HiÖn t¹i ®· cã c¸c phiªn b¶n 5.1, 6.0, 7.0. Nãi chung c¸ch cµi 

®Æt kh«ng cã g× khã vµ kh¸c nhau l¾m gi÷a c¸c version. 

Lu ý: Tèt nhÊt lµ cã b¶n cµi ngoµi (tõ ®Üa CD hoÆc download tõ Internet)  

hoÆc tham kh¶o c¸c bíc cµi ®Æt sau:

1 §Çu tiªn chóng ta cÇn ph¶i cã m¸y tÝnh ch¹y Win 2k, XP Pro hoÆc 2k3. 

TiÕp theo, ®Ó kiÓm tra IIS ®· ®îc cµi ®Æt hay cha, chóng ta h·y truy cËp 

vµo Control Panel



Ch¬ng tr×nh sÏ hiÖn ra cöa sæ Control Panel -> Administrative Tools vµ t×m 

xem môc Internet Services Manager cã tån t¹i hay kh«ng. 



IIS cha ®îc cµi, quay l¹i cöa sæ Control Panel bÊm ®óp chuét vµo môc Add 

Remove Program 

BÊm chuét vµo Add/ remove Windows Components ch¬ng tr×nh sÏ hiÖn ra 

mét b¶ng, chóng ta ®¸nh dÊu vµo môc IIS.



Lu ý: cÇn ph¶i ph¶i ®a ®Üa cã bé cµi windows vµo v× ch¬ng tr×nh cÇn 

mét sè file trong ®Üa.

2 §îi mét chót (cã thÓ l©u h¬n nÕu RAM yÕu) ®Ó qu¸ tr×nh cµi ®Æt IIS diÔn 
ra thuËn lîi vµ kÕt thóc.



B©y giê IIS ®· cµi xong, cÇn kiÓm tra l¹i xem nã ®· cµi ®óng cha.

3 Më tr×nh duyÖt web, gâ localhost vµo thanh URL, nÕu tr×nh duyÖt cña 

chóng ta hiÓn thÞ nh h×nh sau hoÆc t¬ng tù th× qu¸ tr×nh c¸i ®Æt IIS cña 

chóng ta ®· thµnh c«ng.

MÆc ®Þnh sau khi cµi ®Æt IIS xong, ch¬ng tr×nh sÏ cung cÊp cho chóng ta 

mét th môc ®Ó lu tr÷ website lµ C:\inetpub\wwwroot. Tuy nhiªn, nÕu chóng ta 

kh«ng muèn sö dông ®êng dÉn mÆc ®Þnh nµy, chóng ta cã thÓ t¹o mét ®êng 

dÉn ¶o theo c¸ch sau:

1) Vµo  Control  Panel  ->  Administrative  Tools  ->  Internet  Information 

Services.



2) Click chuét ph¶i vµo Default Web Site -> New -> Virtual Directory…

3) Ch¬ng tr×nh sÏ hiÖn ra hép tho¹i  Virtual Directory Creation Winzard, 

chän Next



4) T¹i môc Alias, ®iÒn tªn chóng ta muèn ®Æt cho ®êng dÉn ¶o cña chóng 

ta, sau ®ã chän Next.

5) T¹i môc Directory, ®iÒn ®Þa chØ thùc cña th môc mµ chóng ta muèn 

chän lµm ®êng dÉn ¶o. chóng ta cã thÓ click vµo nót Browse thÓ thùc 

hiÖn c«ng viÖc nµy. Sau ®ã click Next.

6) Chän c¸c môc trªn h×nh tïy theo yªu cÇu chóng ta muèn c¸c website 

trong th môc ¶o cña chóng ta thùc thi nh thÕ nµo. Click Next -> Yes -> 

Finish. Qu¸ tr×nh t¹o ®êng dÉn ¶o kÕt thóc.

Chóng ta cã thÓ kiÓm tra ®êng dÉn ¶o cña chóng ta ®· ho¹t ®éng cha b»ng 

c¸ch më tr×nh duyÖt vµ ®¸nh ®Þa chØ nh sau:  http://localhost/hieulv68. NÕu 

ch¬ng tr×nh hiÓn 

http://localhost/hieulv68


thÞ gièng nh h×nh sau, coi nh qu¸ tr×nh t¹o ®êng dÉn ¶o cña chóng ta ®· thµnh 

c«ng. 

2. Xây d ng Web Site b ng ph n m m Macromedia ự ằ ầ ề
Dreamweaver MX

Macromedia Dreamweaver  lµ tr×nh biªn so¹n HTML chuyªn nghiÖp dïng 

®Ó thiÕt kÕ, viÕt m· vµ ph¸t triÓn website cïng c¸c trang web vµ c¸c øng dông 

web. Cho dï chóng ta cã thÝch thó víi c«ng viÖc viÕt m· HTML thñ c«ng hoÆc 

chóng ta thÝch lµm viÖc trong m«i trêng biªn so¹n trùc quan, Dreamweaver 

cung cÊp cho chóng ta nh÷ng c«ng cô h÷u Ých ®Ó n©ng cao kinh nghiÖm 

thiÕt kÕ web cña chóng ta.

Híng  dÉn  nµy  giíi  thiÖu  cho  chóng  ta  c¸ch  sö dông  Macromedia 

Dreamweaver MX nÕu chóng ta cha quen víi  c¸c khÝa c¹nh chÝnh cña nã. 

Nh÷ng bµi híng dÉn trong môc híng dÉn nµy dÉn chóng ta qua c¸c qu¸ tr×nh t¹o 

mét website ®¬n gi¶n nhng ®Çy ®ñ chøc n¨ng.

C¸c tÝnh n¨ng biªn so¹n trùc quan trong Dreamweaver cho phÐp chóng 

ta t¹o nhanh c¸c trang web mµ kh«ng cÇn c¸c dßng m·. Chóng ta cã thÓ xem 

tÊt cacr c¸c thµnh phÇn trong website cña chóng ta vµ kÐo chóng trùc tiÕp tõ 

mét panel dÔ sö 



dông vµo 1 v¨n b¶n. Chóng ta cã thÓ n©ng cao s¶n phÈm cña chóng ta b»ng 

c¸ch t¹o vµ söa c¸c ¶nh trong Macromedia Fireworks hoÆc trong øng dông ¶nh 

kh¸c, råi sau ®ã chÌn trùc tiÕp vµo Dreamweaver. Dreamweaver còng cung cÊp 

nh÷ng c«ng cô gióp ®¬n gi¶n hãa viÖc chÌn Flash vµo trang web.

Bªn c¹nh nh÷ng tÝnh n¨ng kÐo vµ th¶ gióp x©y dùng trang web cña 

chóng ta, Dreamweaver cßn cung cÊp mét m«i trêng viÕt m· ®Çy ®ñ chøc 

n¨ng bao gåm c¸c c«ng cô viÕt m· (nh t« mµu m·, bæ sung thÎ (tag), thanh c«ng 

cô m· vµ thu bít m·) vµ nguyªn liÖu tham chiÕu ng«n ng÷ trong Cascading Style 

Sheets (CSS), JavaScript, ColdFusion Markup Language (CFML) vµ c¸c ng«n 

ng÷ kh¸c. C«ng nghÖ Macromedia Roundtrip HTML nhËp c¸c v¨n b¶n HTML 

viÕt m· thñ c«ng mµ kh«ng ®Þnh d¹ng l¹i m·, khi ®ã chóng ta cã thÓ ®Þnh d¹ng 

l¹i m· víi phong c¸ch ®Þnh d¹ng cña riªng chóng ta.

Dreamweaver  còng cho phÐp chóng ta  x©y dùng c¸c  øng dông web 

®éng dùa theo d÷ liÖu sö dông c«ng nghÖ m¸y chñ nh CFML, ASP.NET, ASP, 

JSP,  vµ  PHP.  NÕu  së thÝch  cña  chóng  ta  lµ  lµm  viÖc  víi  d÷ liÖu  XML, 

Dreamweaver cung cÊp nh÷ng c«ng cô cho phÐp chóng ta dÔ dµng t¹o c¸c 

trang XSLT, chÌn file XML vµ hiÓn thÞ d÷ liÖu XML trªn trang web cña chóng 

ta.

Dreamweaver cã thÓ tïy biÕn hoµn toµn. Chóng ta cã thÓ t¹o cho riªng 

m×nh nh÷ng ®èi tîng vµ yªu cÇu, chØnh söa shortcut bµn phÝm vµ thËm chÝ 

viÕt m· JavaScript ®Ó më réng nh÷ng kh¶ n¨ng cña Dreamweaver víi nh÷ng 

hµnh vi míi, nh÷ng chuyªn gia gi¸m ®Þnh Property míi vµ nh÷ng b¸o c¸o site míi.

2.1 Chuẩn bị và cài đặt

2.1.1 Chuẩn bị

Mua ®Üa Macromedia Dreamweaver MX t¹i c¸c cöa hµng vi tÝnh (Chóng 

ta cã thÓ sö dông phiªn b¶n Dreamweaver cao h¬n, trong lóc t¸c gi¶ viÕt cuèn 

s¸ch nµy ®· cã phiªn b¶n Dreamweaver CS3) Tuy nhiªn, trong cuèn s¸ch nµy sÏ 

híng  dÉn  c¸c  chóng  ta  cµi  ®Æt  vµ  øng  dông  trªn  phiªn  b¶n  8.0  cña 

Dreamweaver.

2.1.2 Cài đặt

1. Më ®Üa chøa ch¬ng tr×nh Dreamweaver 8, nhÊp File Setup.exe. ( H×nh 
1 ).



1. Next > I Accept-- > Next > NhÊp chän Create Shortcut On Desktop > 

Next > NhÊp chän Select All > Next > Install > Ch¹y cµi ®Æt > Finish. 

2.2 Bắt đầu trang

2.2.1 Mô tả giao diện.

Open a Recent Item

Chøa danh s¸ch 10 Môc ®îc më gÇn ®©y. NÕu më Ýt h¬n 10 Môc, nã 

chØ hiÓn thÞ sè. NÕu cha sö dông Dreaweaver ( D ), ná chØ xuÊt hiÖn 

Folder Open.



Create New.

� Chän 1 trong nh÷ng tïy chän sÏ  t¹o 1 File HTML, Cold Fusion, 

PHP,  ASP  VB  Script,  ASP  NET  C#,  JavaScript,  XML,  XSLT 

( Entire Page ), CSS, T¹o 1 Site Dreamweaver.

� Chän More  ®Ó hiÓn thÞ Hép Tho¹i  New Document  cung cÊp 

nhiÒu lùa chän. 

Create From Samples.

� PhÇn gióp chóng ta chØ häc vÒ x©y dùng c¸c Website.

� Chøa c¸c Folder, tõng Folder chøa nhiÒu Trang mÉu tr×nh bµy 

®Ñp

� NhÊp bÊt cø Folder nµo sÏ më Hép tho¹i New Document. NhÊp 

Folder Css Style Sheets  > Trong HT nÇy chóng ta cã thÓ chän 

néi dung cña c¸c Folder kh¸c. 



2.3 Làm việc với cửa sổ tài liệu

2.3.1 Cửa sổ tài liệu: Thí dụ chọn HTML

§©y lµ 1 Cöa sæ tµi  liÖu Dreamweaver  ®¬n gi¶n.  Chóng ta  cã thÓ 

chØnh söa nã ®Ó thÝch hîp víi nh÷ng thãi quen cña chóng ta.

NÕu më nhiÒu Files cïng lóc, chóng ta sÏ thÊy c¸c Tables n»m däc ë 

phÇn trªn cïng cöa sæ. Chóng ta nhÊp vµo 1 Table ®Ó chØnh söa. 

1. NhÊp Nót Restore Down ( Gãc Ph¶i trªn ) ®Ó phãng to mµn h×nh 

--> Trë l¹i nhÊp Nót Maximize.

2. Thanh Menu: Nãi vÒ nh÷ng g× mµ chóng ta mong ®îi thÊy trªn nÒn.

3. Thanh INSERT: Díi thanh Menu.

� COMMON  : TËp hîp nÇy chøa c¸c §èi Tîng  thêng ®îc sö dông 

nhiÒu nhÊt nh c¸c liªn kÕt víi ¶nh.

� LAYOUT  : nhÊp nót xæ xuèng chän Layout. HiÖn ra gåm c¸c 

Tables – Div – Layer – Khung ( Frame ). C¸c §èi tîng nÇy gióp chóng ta 

m« t¶ c¸ch chóng ta muèn tr×nh bµy Trang. (H4).



� FORM   : G m các thành ph n Form nh  Tr ng Text, Nút và H pồ ầ ư ườ ộ  
ki m (H5).ể

� TEXT:    Giúp t o Style  cho Text đã n m trên Trang t t h n là dùngạ ằ ố ơ  

Property  Inspector ( N m   đáy ). (H6).ằ ở

� HTML   : Ít h u d ng, cho phép chúng ta chèn các đ i t ng nhữ ụ ố ượ ư 

Table – Khung – Script v n đ c th c hi n t t h n   n i khác.(H7).ố ượ ự ệ ố ơ ở ơ

� APPLICATION   : Giúp cho chúng ta làm vi c v i các c  s  d  li uệ ớ ơ ở ữ ệ  

bên ngoài (H8).

� FLASH   ELEMENTS   :   Ch   ch a   1   Đ i   t ng   b   xem   nhỉ ứ ố ượ ộ ả  

Flash.N u mu n thêm các thành ph n Flash nh  Nút Flash – Text – Video hãyế ố ầ ư  

quay v  Common > Nút Media. ( H9+10).ề



� FAVORITES  : ChØ lµ ræng kh«ng. Dïng ®Ó chØnh söa, dïng 

®Ó chøa nh÷ng g× chóng ta muèn nã cã. §Ó lµm ®iÒu này: Chän TËp 

hîp Favorites -> NhÊp Ph¶i -> Cho phÐp chóng ta chän lùa ®Ó thªm 

nh÷ng ®èi tîng thêng ®îc sö dông nhiÒu nhÊt. 

� Chøc n¨ng cña tõng Nót vµ nót xæ xuèng kÕ bªn: §Ó con 

trá lªn Nót sÏ thÊy Text m« t¶ chøc n¨ng cña Nót ®ã. NhÊp Nót xæ xuèng 

kÕ bªn ra chøc n¨ng phô. 

Trong phÇn gi¸m s¸t Property cña « layout, ®¸nh mét sè cho chiÒu réng 
hoÆc chiÒu cao cña «. VÝ dô, ®¸nh 200 trong « texbox Height ®Ó thiÕt 
lËp chiÒu cao cña « lµ 200 pixels, sau ®ã click trong tµi liÖu ®Ó thÊy sù 
thay ®æi cña chiÒu réng «.

2.5.8 Thêm màu cho bảng layout

Chóng ta cã thÓ thªm mµu tíi bÊt kú thµnh phÇn nµo cña b¶ng. Chóng ta sÏ 

b¾t ®Çu b»ng viÖc thªm mµu nÒn (background) vµo b¶ng, sau ®ã ¸p dông mét 



mµu nÒn kh¸c vµo c¸c « trong b¶ng. Chóng ta sÏ kÕt thóc b»ng viÖc thay ®æi  

®êng viÒn cña b¶ng.

1) Trong tµi liÖu, click vµo bÊt kú « nµo trong b¶ng, sau ®ã trong phÇn lùa 

chän thÎ ë díi cïng bªn tr¸i cña cöa sæ Document, click vµo thÎ <table> 

®Ó lùa chän toµn bé b¶ng.

2) Më phÇn gi¸m s¸t Property (Window > Properties), nÕu nã cha ®îc më.

Properties  cho  phÇn  lùa  chän  b¶ng  xuÊt  hiÖn  trong  phÇn  gi¸m  s¸t 

Property.

1. Trong « texbox Bg Color cña phÇn gi¸m s¸t Property, lùa chän mµu b»ng 

mét trong c¸c c¸ch sau:

 Click chän mµu vµo « pop-up, sau ®ã lùa chän mét mµu tõ « chän 

mµu.

 Lùa  chän  mµu  b»ng  c¸ch  sö  dông  m·  Hecxadecimal,  vÝ  dô 

#CC9933

 NhËp tªn mµu, vÝ dô goldenrod.

Mµu nÒn ®· ®îc ¸p dông cho b¶ng.

2.5.9 Thiết lập một bảng với chiều rộng tương đối trong bảng 
Layout.

Theo mÆc ®Þnh, khi chóng ta vÏ mét b¶ng hay « trong Layout view, 

Dreamweaver t¹o ra b¶ng víi nh÷ng cét cã chiÒu réng cè ®Þnh. Chóng ta cã 



thÓ thay ®æi chiÒu réng- cè ®Þnh cña mét b¶ng hay « thµnh chiÒu réng t¬ng 

®èi b»ng c¸ch sö dông thuéc tÝnh Autostretch.

Autostretch cho phÐp chóng ta t¹o ra mét b¶ng víi chiÒu réng t¬ng ®èi, 

vµ ¸p dông c¸ch tr×nh bµy linh ho¹t cho cét chóng ta thiÕt lËp nh cét më réng, 

do ®ã b¶ng tù ®éng më réng ®Ó phñ ®Çy mét cöa sæ tr×nh duyÖt.

Chóng ta sÏ thiÕt lËp mét trong sè nh÷ng cét cña b¶ng ®Ó tù ®éng tr¶i ra 

®Ó phñ ®Çy mét cöa sæ tr×nh duyÖt khi hiÓn thÞ.

1) Trong tµi liÖu, trong phÇn ®Çu cét click cét b¶ng mµ chóng ta muèn tù 

®éng tr¶i ra.

2) Khi tr×nh ®¬n pop – up xuÊt hiÖn, chän Make Column Autostretch.

Hép tho¹i Choose Spacer Image xuÊt hiÖn

3) Trong hép tho¹i th«ng b¸o, lùa chän Create a Spacer Image File.

4) B¶ng hép tho¹i Save Spacer Image File As xuÊt hiÖn, nhËp mét gi¸ trÞ 

®Ó lu ¶nh vÝ dô spacer.gif trong vÞ trÝ t¬ng ®èi cña Site Root.

Cét ®Çu tiªn thay ®æi tõ gi¸ trÞ sè thµnh dßng lîn sãng. PhÇn gi¸m s¸t 

Property còng  cËp nhËt ®Ó ph¶n ¸nh r»ng Autostretch sÏ ®îc ¸p dông 

cho c¸c b¶ng. 

5) Lu file l¹i.



2.5.10 Tổng kết

Trong phÇn nµy, chóng ta ®· ®îc häc c¸ch ®Ó t¹o ra c¸c b¶ng trong 

Dreamweaver. Cïng víi ®ã, chóng ta thay ®æi c¸c hµng vµ c¸c cét trong b¶ng,  

thiÕt lËp mµu nÒn tíi c¸c phÇn tö b¶ng, vµ ®· häc c¸ch ®Ó t¹o ra mét b¶ng linh 

®éng thiÕt kÕ c¶ Standard vµ Layout view. 

§Ó biÕt thªm th«ng tin chi tiÕt, chóng ta cã thÓ t×m hiÓu trong tµi liÖu 

Using  Dreamweaver  MX  hoÆc  Dreamweaver  Help  (Help  >  Using 

Dreamweaver)

2.4 Làm việc với Document

2.4.1 Thanh công cụ. 

1. Nút Code:  G m di n m o Markup và Tag ( Th  ). Có nhi u ng i t o raồ ệ ạ ẻ ề ườ ạ  

Trang Web đ p mà ch a s  d ng Khung xem Code.( H1 ).ẹ ư ử ụ

2. Nút   Split:  Có   c   ph n   Code   và   Design.Mã   n m   phía   trên.   Khung   xemả ầ ằ  

WYSIWG 

( What You See Is You Get ) phía d i.Dùng tìm hi u v  Markup, tinh ch nhướ ể ề ỉ  

các Tag  xem di n m o c a ki u thi t k . Rê thanh gi a đ  n i r ng và thuệ ạ ủ ể ế ế ữ ể ớ ộ  

h p 2 ph n này.(H2)ẹ ầ



3. NÚT   DESIGN   :   N i   chúng   ta   nh p   d   li u.Khi   xem   trong   Trình   Duy tơ ậ ữ ệ ệ  

(Browser ) cũng gi ng nh  th . G i là: What You See Is You Get.Là n i chúngố ư ế ọ ơ  

ta thao tác th c hi n thi t k  Trang Web. Chúng ta có th  xem trên các chự ệ ế ế ể ế 

đ : Design – Code – Split.(H3).ộ

4. CÁC LO I NÚT PHẠ Ụ   : Ch a m i th , chúng ta nh p lên đ  tìm hi u thêm.ứ ọ ứ ấ ể ể  

Đáng chú ý Nút Preview In Browser đang liên k t đ n các trình duy t c aế ế ệ ủ  

chúng ta đang s  d ng. ( H4 )ử ụ

5. TITTLE   : Nh p Tiêu đ  Trang.ậ ề

2.4.2 Các thanh công cụ khác.

Khi nh p Ph i trong Thanh Document hay Thanh Insert, chúng ta s  th y có 2ấ ả ẽ ấ  

Thanh trong b ng này:ả

2. THANH STYLE RENDERING   : Chúng ta s  s  d ng đ  chuy n đ i gi a 2ẽ ử ụ ể ể ổ ữ  

Style Rendering. Ph n l n chúng ta ch  mu n xem Khung màn Hình m c đ nhầ ớ ỉ ố ặ ị  

(H5). 



3. THANH STANDARD   : Khi nh p Ph i đ  ch n  Style Rendering  có các ch cấ ả ể ọ ứ  

năng New – Open – Save – Print – Cut – Copy – Paste. chúng ta có th  t tể ắ  

thanh Insert và Thanh Document. Đ  m  l i:  View > Toolbars > Ch n cácể ở ạ ọ  

thanh.

2.5 Sử dụng bảng (table) để thiết kế bố cục trang (Page Layout)

NÕu chóng ta ®ang quen thuéc víi viÖc viÕt m·  HTML, chóng ta ®· biÕt 

r»ng bÊt kú v¨n b¶n hoÆc c¸c néi dung kh¸c nµo mµ chóng ta thªm vµo trong 

mét trang web tõ mét lÒ trang tíi bÊt kú chç kh¸c trõ khi nã ®îc chÌn vµo trong 

mét "container", ch¼ng h¹n nh mét layer hoÆc mét b¶ng. C¸c b¶ng trong HTML 

lµ mét gi¶i ph¸p tuyÖt vêi cho viÖc thiÕt kÕ layout cña mét trang web, bëi v× 

chóng ®îc dÔ dµng söa ®æi vµ t¬ng thÝch víi hÇu hÕt c¸c tr×nh duyÖt. Chóng 

ta cã thÓ sö dông c¸c b¶ng bè trÝ d÷ liÖu hoÆc ®Ó ®Æt mµn h×nh hiÓn thÞ 

trùc quan c¸c phÇn tö (vÝ dô nh c¸c nót Flash, h×nh ¶nh, hoÆc ®o¹n v¨n b¶n).

Dreamweaver  cã  hai  khung  nh×n  ®Ó chóng  ta  cã  thÓ thiÕt  kÕ b¶ng- 

Standard view vµ Layout view. Trong phÇn nµy híng dÉn chóng ta t×m hiÓu 

®Ó thiÕt kÕ tr×nh bµy rang trong c¶ hai khung nh×n ®ã. Trong phÇn ®Çu tiªn 

cña phÇn nµy, chóng ta lµm viÖc trong Standard view vµ chÌn mét b¶ng trong 

mét trang. Trong phÇn sau, chóng ta lµm viÖc trong Layout view, n¬i mµ chóng 

ta sö dông c¸c tïy chän ®Ó vÏ mét b¶ng vµ c¸c « cña b¶ng trong viÖc thiÕt kÕ 

layout.

§Ó hoµn thµnh tèt phÇn híng dÉn nµy, chóng ta sÏ t×m hiÓu xem lµm thÕ 

nµo ®Ó hoµn thµnh c¸c nhiÖm vô sau:

 "T¹o vµ söa ®æi mét b¶ng trong Standard view " trªn trang 8

 "Thªm mµu cho b¶ng" trªn trang 12

 "ThiÕt lËp b¶ng víi chiÒu réng t¬ng ®èi trong Standard view " trªn trang 14

  "ThiÕt kÕ mét trang trong Layout view " trªn trang 15

  "VÏ mét « layout" trªn trang 16

  "Thªm nhiÒu « layout" trªn trang 17

  "Di chuyÓn hoÆc thay ®æi kÝch cì cña « layout" trªn trang 18

  "ThiÕt lËp mét b¶ng víi chiÒu réng t¬ng ®èi trong Layout view " trªn trang 
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 "ThiÕt kÕ mét trang trong Layout view " trªn trang 15

2.5.1 Tạo và chỉnh sửa bảng trong Standard view.

Standard  view  lµ  mét  khung  nh×n  thiÕt  kÕ  ®iÓn  h×nh  cña 

Dreamweaver. §Ó t¹o mét b¶ng trong  Standard view, chóng ta sö dông c©u 

lÖnh Insert Table. Dreamweaver t¹o ra mét b¶ng dùa trªn c¸c tïy chän mµ chóng 

ta chän trong b¶ng hép tho¹i Insert  Table. Chóng ta cã thÓ dÔ dµng thay ®æi 

cÊu tróc ban ®Çu cña b¶ng ®Ó t¹o ra nhiÒu thiÕt kÕ phøc t¹p b»ng c¸ch kÕt 

hîp vµ t¸ch c¸c «, vµ b»ng c¸ch chÌn c¸c hµng vµ cét.

Chóng ta sö dông c¸c « cña b¶ng (c¸c hép ®îc  t¹o ra t¹i giao cña tõng cét 

hoÆc hµng trong mét b¶ng) ®Ó kiÓm so¸t c¸c vÞ trÝ cña v¨n b¶n vµ h×nh ¶nh 

trong mét trang web. Bëi v× chóng ta cã thÓ thùc hiÖn viÖc Èn c¸c ®êng viÒn 

cña b¶ng, ngêi xem sÏ kh«ng nh×n thÊy c¸c cÊu tróc thiÕt kÕ cña chóng ta  khi 

hä nh×n trang trong mét cöa sæ tr×nh duyÖt.

Tríc khi chÌn b¶ng vµo trang web, chóng ta cÇn t¹o ra mét trang web míi.  

C¸c bíc ®Ó t¹o ra mét trang web míi b»ng HTML nh sau:

- Chän File -> New… 

- Trong danh sach Category -> Chän Basic Page. 

- Trong Basic Page -> Chän HTML. 

- NhÊn nót Create 

2.5.1.1 Chèn một bảng vào trang web.

B©y giê chóng ta ®· s½n sµng ®Ó chÌn mét b¶ng vµo trong tµi liÖu.

1) Trong cöa sæ Document, chän vÞ trÝ chóng ta cÇn chÌn trong trang web 

vµ thùc hiÖn mét trong sè c¸c bíc sau:

 Chän Insert > Table.

 Chóng ta còng cã thÓ thùc hiÖn b»ng c¸ch chän tab Common 

trong thanh Insert, sau ®ã chän Insert table.

2) Trong b¶ng hép tho¹i, thiÕt lËp c¸c tïy chän sau:



 Trong « Rows: chän 2

 Trong « Columns: chän 2

 Trong « Width: chän 600, sau ®ã chän Pixels trong thùc ®¬n pop-

up phÝa bªn ph¶i môc Width.

ThiÕt lËp width lµ 600 pixels chÝnh lµ t¹o ra chiÒu réng cña b¶ng. 

Chóng ta  ®·  ®îc  th¶o  luËn vÒ chiÒu réng cña b¶ng  trong  phÇn 

HTML.

• Trong « Border:  Chän 1 ®Ó thiÕt lËp ®êng viÒn cña b¶ng lµ 1 

pixel.

3) Click OK.

Chóng ta thÊy Dreamweaver ®· chÌn mét b¶ng vµo trang web.

4) Lu trang web ta võa t¹o b»ng mét trong c¸c c¸ch sau.

 Chän File -> Save.

 Ấn Ctrl + S.

2.5.1.2  Chỉnh sửa bảng.

TiÕp theo, chóng ta sÏ chØnh söa bè côc cña b¶ng. Chóng ta sÏ thªm c¸c « 

(Cells) vµ c¸c cét (Columns) vµo b¶ng, vµ häc c¸ch gép vµ t¸ch chóng nh

thÕ nµo.

1) Click « trªn cïng bªn tr¸i sau ®ã kÐo – th¶ xuèng « díi ®Ó lùa chän cét 

tr¸i.





2) Chän Modify > Table > Insert Column.

B¶ng b©y giê gåm cã 3 cét.

3) Click « díi cïng bªn tr¸i vµ sau ®ã lùa chän Modify > Table > Insert Rows 

or Columns.

Hép tho¹i Insert Rows hoÆc Columns xuÊt hiÖn.

4) Trong hép tho¹i, thiÕt lËp c¸c tïy chän sau:

 Trong Insert, chän Rows.

 Trong Number of Rows, chän 2.

 Trong  Where, chän Above the Selection.

5) Click OK.

B¶ng ®· ®îc cËp nhËt, B©y giê, b¶ng cña chóng ta cã 4 hµng vµ 3 cét.

6) Lu l¹i sù thay ®æi (File > Save).

2.5.1.3 Gộp và tách ô.

B»ng c¸ch gép vµ t¸ch «, chóng ta cã thÓ tïy chØnh mét b¶ng ®îc thiÕt 

kÕ phï hîp víi nhu cÇu cña chóng ta. TiÕp theo, Chóng ta sÏ thÊy lµm thÕ nµo 

®Ó tïy chän tr×nh ®¬n hoÆc kiÓm tra Property ®Ó gép hoÆc t¸ch c¸c « trong 

b¶ng.



1) Trong trang web, chän 2 « ®Çu tiªn trong cét bªn tr¸i cña b¶ng b»ng 

c¸ch kÐo – th¶ xuèng « phÝa díi. 

2) Chän Modify > Table > Merge Cells. 

Hai « ®· ®îc gép l¹i thµnh mét.

3) Click vµo hµng thø 3 cña cét thø 2. Sau ®ã kÐo vÒ phÝa ph¶i vµ 
xuèng « díi cïng cña cét 3. 

4) Trong  phÇn gi¸m s¸t Property, click nót Merge ®Ó gép c¸c « ®· lùa 
chän.

C¸c « ®îc lùa chän ®· ®îc gép thµnh 1 «.

Chóng ta cã thÓ t¸ch mét « hoÆc cét 

5) Click vµo « trªn cïng phÝa tr¸i

6) Trong phÇn gi¸m s¸t Property, click vµo nót Split Cell

B¶ng hép tho¹i Split Cell xuÊt hiÖn

7) Trong b¶ng hép tho¹i, thiÕt lËp c¸c tïy chän sau

 PhÇn Split Cell Into, chän Columns

 Trong Munber of Rows, chän 2

8) Click OK

B¶ng ®· ®îc thay ®æi



2.5.1.4 Thay đổi chiều cao hàng và độ rộng cột

Chóng ta sÏ lµm t¨ng sè lîng cña kh«ng gian gi÷a b¶ng vµ hµng vµ ®iÒu chØnh 
chóng

1) Di chuyÓn trá däc theo biªn giíi phÝa díi b¶ng cho ®Õn khi nã ®æi 

thay, biÕn thµnh mét ®êng viÒn chän, sau ®ã kÐo nã xuèng ®Ó thay 

®æi kÝch cì cña b¶ng.

Chóng ta cã thÓ sö dông c¸ch nµy ®Ó thay ®æi chiÒu cao cña 

c¸c hµng kh¸c trong b¶ng nÕu b¹n muèn.

2) Di chuyÓn trá mét cét däc theo ®êng biªn giíi cho ®Õn khi nã thay 

®æi ®Õn mét biªn giíi chän, sau ®ã kÐo nã vµo ë phÝa bªn tr¸i 

hoÆc ph¶i ®Ó thay ®æi chiÒu réng cña mét cét.

3) Khi chóng ta ®· lµm xong b¶ng ®iÒu chØnh cña chóng ta, lu tµi 

liÖu cña chóng ta.

2.5.2 Thêm màu cho bảng

Chóng ta cã thÓ thªm mµu cho bÊt kú thµnh phÇn nµo cña b¶ng. Chóng ta 

sÏ b¾t ®Çu b»ng viÖc thªm mét mµu nÒn (background) vµo b¶ng. Sau khi ¸p 

dông  mét mµu nÒn kh¸c vµo c¸c « trong b¶ng. Chóng ta sÏ kÕt thóc b»ng viÖc 

thay ®æi mµu ®êng viÒn (border).

1) Trong tµi liÖu, click vµo bÊt kú « nµo trong b¶ng, sau ®ã trong phÇn lùa 

chän thÎ ë díi cïng bªn tr¸i cña cöa sæ Document, click vµo thÎ <table> 

®Ó lùa chän toµn bé b¶ng.

2) Më b¶ng gi¸m s¸t Property (Window > Properties), nÕu nã cha ®îc më ra. 

3) Trong b¶ng gi¸m s¸t Property, trong « texbox Bg Color lùa chän mét mµu 

chóng ta muèn b»ng mét trong c¸c c¸ch sau:



 Click chän mµu vµo « pop-up, sau ®ã lùa chän mét mµu tõ « chän 

mµu.

 Lùa  chän  mµu  b»ng  c¸ch  sö  dông  m·  Hecxadecimal,  vÝ  dô 

#CC9933

 NhËp tªn mµu, vÝ dô goldenrod.

Mµu nÒn ®· ®îc ¸p dông cho b¶ng.

4) Chóng ta còng cã thÕ ¸p dông c¸c bíc trªn ®Ó thay ®æi mµu t¹i c¸c « bÊt 

k×.

2.5.2.1 Thêm màu đường viền

B©y giê, chóng ta sÏ thiÕt lËp mµu ®êng viÒn cña b¶ng. Mµu ®êng viÒn ¸p 

dông cho c¶ ®êng viÒn phÝa ngoµi vµ phÝa trong cña b¶ng Brdr Color

1) Trong cöa sæ Document, lùa chän b¶ng.

2) Trong b¶ng gi¸m s¸t Property, Trong « texbox Brdr Color, chän mét mµu 

®êng viÒn cho b¶ng.

3) Khi chóng ta ®· thùc hiÖn xong, lu tµi liÖu cña chóng ta l¹i.

2.5.3 Thiết lập bảng có độ rộng tương đối trong Standard view

Mét b¶ng dùa trªn tû lÖ phÇn tr¨m sÏ gi·n ra vµ co l¹i dùa trªn chiÒu réng 

cña mét cöa sæ tr×nh duyÖt. (VÝ dô, nÕu chóng ta chØ ®Þnh r»ng mét b¶ng 

sö dông mét 

chiÒu réng 75%, b¶ng sÏ gi·n ra ®Ó lÊp ®Çy 75% chiÒu  ngang cña 

kh«ng  gian mµ kh«ng phô thuéc vµo kÝch thíc cöa sæ tr×nh duyÖt. §iÒu nµy 

cã thÓ h÷u Ých trong mét vµi trêng hîp, ch¼ng h¹n nh b¶o ®¶m lµ mét tr×nh 

®¬n chuyÓn híng lu«n lu«n ®îc hiÓn thÞ khi mét cöa sæ ®îc thay ®æi kÝch cì.



Khi chóng ta muèn thiÕt lËp kÝch thíc cña mét b¶ng bÊt kÓ mét ngêi sö 

dông thay ®æi kÝch thíc cña cöa sæ tr×nh duyÖt nh thÕ nµo, h·y sö dông c¸c 

b¶ng dùa trªn pixel. Khi chóng ta muèn b¶ng c¨ng ra ®Õn kÝch cì cña cöa sæ 

tr×nh duyÖt, sö dông b¶ng dùa trªn tû lÖ phÇn tr¨m lµ tèt nhÊt.

§Ó thÊy sù kh¸c nhau gi÷a c¸c b¶ng dùa trªn tû lÖ phÇn tr¨m vµ dùa trªn 

pixel, chóng ta sÏ thªm mét trong sè chóng, sau ®ã hiÓn thÞ chóng trªn tr×nh 

duyÖt.

1. Trong Dreamweaver, chän File -> New.

2. Trong b¶ng hép tho¹i New Document, môc Basic Page ®· s½n sµng ®Ó 

lùa chän trong danh s¸ch Basic Pages, click ®óp vµo HTML ®Ó lùa chän 

mét tµi liÖu HTML míi.

Tµi liÖu ®îc më trong cöa sæ Document.

3. Lu tµi liÖu nµy l¹i. Tªn cña nã lµ table Width.

4. Chän vÞ trÝ ®Ó chÌn trong tµi liÖu.

5. Trong tab Common cña thanh Insert, click vµo nót Table.

6. Trong b¶ng hép tho¹i xuÊt hiÖn, thiÕt lËp c¸c tïy chän sau:

 Trong « textbox Rows, chän 2.

 Trong « textbox Columns, chän 3.

 Trong « textbox Width, chän 90, vµ chän Percentage trong tr×nh 

®¬n pop-up ë phÝa ph¶i cña « textbox Width. 

 Trong « textbox Border, ®iÒn1 ®Ó thiÕt lËp 1 pixel ®êng viÒn 

quanh b¶ng vµ c¸c « cña b¶ng.

7. Click OK.

B¶ng xuÊt hiÖn trong tµi liÖu

8. Click vµo trong « trªn ë gi÷a vµ kÐo tíi « díi ®Ó lùa chän cét gi÷a.

9. Trong phÇn gi¸m s¸t Property, chän mµu ®Ó thiÕt lËp mµu nÒn cho cét



2.5.4 Thiết kế trang trong Layout view.

Chóng ta ®· biÕt lµm thÕ nµo ®Ó lµm viÖc víi c©u lÖnh Insert Table, 

h·y xem xÐt mét c¸ch kh¸c ®Ó lµm viÖc víi b¶ng b»ng viÖc vÏ b¶ng layout.

TiÕp theo, chóng ta sÏ lµm viÖc víi khung nh×n Layout,  Nã cho phÐp 

chóng ta vÏ c¸c layout  « hoÆc b¶ng mµ ta cã thÓ thªm c¸c néi dung nh: h×nh 

¶nh, v¨n b¶n, hoÆc c¸c ph¬ng tiÖn truyÒn th«ng kh¸c.



Trong Layout view chóng ta cã thÓ vÏ c¸c « layout hoÆc b¶ng ®Ó ®Þnh 

nghÜa khu vùc thiÕt kÕ cña trang web.Chóng ta cã thÓ b¾t ®Çu b»ng viÖc 

chÌn mét « b¶ng hoÆc mét « layout. Khi chóng ta chÌn mét « layout ®Çu tiªn  

Dreamweaver sÏ tù ®éng t¹o mét b¶ng ®Ó bao quanh nã.

2.5.4.1  Khởi tạo và lưu một tài liệu

1) Trong Dreamweaver, chän File -> New.

2) Trong b¶ng hép tho¹i New Document, Môc Basic Page ®· s½n sµng ®Ó 

lùa  chän,  trong  danh  s¸ch  Basic  Page  lùa  chän  HTML sau  ®ã click 

Create ®Ó t¹o mét tµi liÖu HTML míi.

Tµi liÖu ®îc më trong cöa sæ Document.

3) Lu  tµi  liÖu  trong  th môc  côc  bé  trªn  m¸y  tÝnh,  vµ  cã  tªn  lµ 

tableLayout.htm

2.5.5  Vẽ một ô layout

1) Trong thanh Insert, click tab Layout, sau ®ã click nót Layout view ®Ó 

thay ®æi tõ Standard view.

2.5.6 Thêm nhiều ô layout.

TiÕp theo chóng ta sÏ häc xem lµm thÕ nµo ®Ó thªm mét lo¹t c¸c « layout. 

Chóng ta sÏ thªm c¸c « layout tiÕp theo c¸c « layout mµ chóng ta ®· t¹o ®Ó t¹o 

ra layout cho c¸c nót ®Þnh híng (navigation) cña trang.

1) Trong thanh Insert,  click vµo nót Draw Layout Cell, gi÷ phÝm Ctrl ®Ó 

chóng ta cã thÓ vÏ ®îc nhiÒu « trong b¶ng.



2) Trong cöa sæ Document, ®Þnh vÞ con trá ë díi « cuèi cïng chóng ta ®· 

vÏ, sau ®ã vÏ mét « layout. TiÕp tôc gi÷ phim Ctrl vµ vÏ thªm hai « layout 

n÷a.

Sau khi thùc hiÖn xong, mµn h×nh cña chóng ta nh×n gièng nh thÕ nµy:

3) Click vµo mét vïng trèng cña thanh Insert ®Ó hñy c«ng cô Draw Layout 

Cell.

2.5.7 Di chuyển hoặc thay đổi kích cỡ của một ô layout.

NÕu chóng ta cÇn ®iÒu chØnh c¸c «, chóng ta cã thÓ thay ®æi kÝch thíc 

vµ di chuyÓn nh÷ng « layout. Chóng ta cã thÓ di chuyÓn « layout tíi mét vÞ trÝ  

míi cña tµi liÖu miÔn lµ nã ë trong ph¹m vi cña b¶ng layout. §«i khi chóng ta sÏ  

ph¶i thay ®æi kÝch thíc cña c¸c « xung quanh ®Ó thùc hiÖn mong muèn thay 

®æi. NÕu chóng ta muèn di chuyÓn mét « layout ®Ó ®Þnh vÞ l¹i nã trong tµi  

liÖu, h·y thùc hiÖn theo c¸c bíc sau:

1) Click vµo ®êng viÒn cña « layout ®Ó lùa chän nã.



2) Thùc hiÖn mét trong c¸c bíc sau:

 Dïng chuét kÐo « layout ®Ó di chuyÓn nã tíi mét vÞ trÝ kh¸c.

 NÕu xung quanh « layout lµ kho¶ng trèng (ko liÒn kÒ c¸c « layout 

kh¸c) sö dông c¸c nót lªn (#), xuèng (#), tr¸i  (#), ph¶i (#) ®Ó di 

chuyÓn «.

2.5.7.1 Thay đổi kích thước ô layout.

§Ó thiÕt kÕ mét trang web chÝnh x¸c, chóng ta cã thÓ thiÕt lËp kÝch thíc 
cña nh÷ng « mµ chóng ta ®· thªm vµo trong tµi liÖu. Chóng ta còng cã thÓ 
®Þnh vÞ l¹i nh÷ng « trong trang web.

1) Click vµo ®êng viÒn cña « layout ®Ó lùa chän nã.

2) §Ó thay ®æi kÝch thíc cña «:

3) Lùa chän mét « b»ng c¸ch click vµo ®êng viÒn cña «, sau ®ã lùa chän 

mét mµu trong phÇn gi¸m s¸t Property ®Ó ¸p dông nã.

4) Thªm mét mµu nÒn cho c¸c « kh¸c trong b¶ng cña chóng ta, nÕu chóng 

ta muèn.



5) Lu l¹i tµi liÖu cña chóng ta.

2.6 Căn chỉnh ảnh và các bản đồ hình ảnh.

ViÖc lµm viÖc víi nh÷ng ¶nh trong Macromedia Dreamweaver MX hoµn 

toµn  dÔ dµng.  Chóng  ta  cã  thÓ sö dông  nh÷ng  c«ng  cô trùc  quan 

Dreamweaver kh¸c nhau ®Ó chÌn mét h×nh ¶nh. PhÇn nµy giíi thiÖu cho chóng 

ta nh÷ng tïy chän h×nh ¶nh, chóng ta cã thÓ ¸p dông mét lÇn mét h×nh ¶nh ®îc 

chÌn vµo trong mét trang. Chóng ta sÏ häc vÒ c¨n chØnh h×nh ¶nh vµ v¨n b¶n, 

vµ thiÕt lËp kho¶ng trèng xung quanh ¶nh. Chóng ta còng sÏ häc c¸ch sö dông 

mét ¶nh ®¬n ®Ó liªn kÕt tíi nhiÒu trang Web nh thÕ nµo.

PhÇn híng  dÉn nµy  ®îc  thiÕt  kÕ dµnh  cho  ngêi  b¾t  ®Çu sö dông 

Dreamweaver. Nã bao gåm mét sè c¸c tÝnh n¨ng c¬ b¶n trong Dreamweaver 

vµ sÏ gióp chóng ta hiÓu lµm thÕ nµo ®Ó c¨n chØnh h×nh ¶nh, còng nh lµm 

thÕ nµo ®Ó t¹o mét b¶n ®å h×nh ¶nh.

Trong phÇn nµy, chóng ta sÏ hoµn thµnh nh÷ng nhiÖm vô sau:

 ThiÕt lËp viÖc c¨n chØnh h×nh ¶nh.

 ThiÕt lËp viÖc ®Æt kho¶ng trèng h×nh ¶nh.

 ThiÕt lËp c¸c tïy chän vÒ kho¶ng trèng vµ c¨n chØnh.

 Khëi t¹o mét b¶n ®å ¶nh.

 ThiÕt lËp c¸c vïng b¶n ®å ¶nh.



 Më mét file ®· ®îc liªn kÕt trong cöa sæ míi.

2.6.1 Thiết lập căn chỉnh hình ảnh.

Mét h×nh ¶nh, gièng nh v¨n b¶n, th«ng thêng xuÊt hiÖn trong m· HTML 

trong mét trang web vµ cã thÓ xuÊt hiÖn nh mét ®o¹n cña chÝnh nã, hoÆc nh 

lµ mét phÇn cña mét ®o¹n v¨n b¶n. Chóng ta cã thÓ c¨n chØnh mét h×nh ¶nh 

b»ng hai c¸ch trong phÇn gi¸m s¸t Property b»ng c¸ch sö dông c¸c ®iÒu khiÓn 

text alignment hoÆc image alignment.

VÞ trÝ c¸c ®o¹n trong Text alignment trong ®ã cã h×nh ¶nh ®îc chÌn  vµ 

cã thÓ ®îc sö dông ®Ó c¨n chØnh  mét h×nh  ¶nh  ë bªn tr¸i hay bªn ph¶i lÒ, 

hoÆc trung t©m. Image  Alignment  cho phÐp chóng ta thiÕt lËp c¸c mèi quan 

hÖ cña mét h×nh ¶nh cho c¸c néi dung kh¸c trong cïng mét ®o¹n v¨n (bao gåm 

c¶ h×nh ¶nh kh¸c). Trong Dreamweaver, c¸c tr×nh ®¬n Align pop-up cho phÐp 

chóng ta chän c¸ch thøc c¨n chØnh h×nh ¶nh víi v¨n b¶n.

Chó ý: Kh«ng ph¶i tÊt c¶ c¸c tïy chän image alignment ®Òu ho¹t ®éng ®îc 

trong tÊt c¶ c¸c tr×nh duyÖt. Trong phÇn nµy, chóng ta sÏ sö dông c¸c tïy chän  

c¨n chØnh mµ ho¹t ®éng ®îc trong Microsoft Internet Explorer and in Netscape  

Navigator.



2.6.1.1 Hiển thị tài liệu đã hoàn thành

Tríc khi b¾t ®Çu, h·y nh×n file ®· ®îc hoµn thµnh ®Ó thÊy chóng ta sÏ ph¶i lµm 

g× trong phÇn híng ®Én nµy.

1) Chän File -> Open, mét hép tho¹i xuÊt hiÖn, chän ®êng dÉn vµ chän file 

imageAlign_comp.htm (File nµy n»m trong sè c¸c file gi¸o viªn cung cÊp 

trong m«n häc)

File ®îc më trong cöa sæ Document.

2) Ên F12 hoÆc chän File > Preview in Browser and vµ lùa chän tr×nh 

duyÖt hiÓn thÞ tµi liÖu.

File hiÓn thÞ ba vÝ dô cã sö dông images alignment vµ spacing ®Ó kÕt hîp 

¶nh vµ v¨n b¶n.

3) Khi chóng ta xem xong file ®ã, ®ãng cöa sæ tr×nh duyÖt cña chóng ta 

l¹i.

2.6.1.2 Mở một file để làm việc

Chóng ta sÏ lµm viÖc trong mét tµi liÖu cha ®îc ®îc  hoµn thµnh mµ tõng 

phÇn cã chøa h×nh ¶nh vµ v¨n b¶n trong mét b¶ng. B¶ng ranh giíi layout, cho 

phÐp chóng ta dÔ dµng nh×n thÊy c¸ch thøc kh¸c nhau c¶u thiÕt lËp ¶nh hëng 

®Õn sù c¨n chØnh lÒ (alignment).

1) Chän File > Open vµ chän ®êng dÉn tíi file imageAlign.htm. 

Tµi liÖu nµy bao gåm c¸c ¶nh vµ v¨n b¶n gièng víi file ®· hoµn thµnh 

trong môc tríc.

Trong cöa sæ Document, click vµo ¶nh ®Çu tiªn. 

¶nh trong cïng mét ®o¹n gièng nh v¨n b¶n.



2) Më phÇn gi¸m s¸t Property (Window > Properties), nÕu nã cha ®îc më.

Trong «  Align, chó ý ë ®©y ¶nh ®îc c¨n chØnh default. Nã ®Æt ¶nh trªn 

®êng gèc cña dßng v¨n b¶n

3) Víi ¶nh ®· lùa chän, trong tr×nh ®¬n pop-up Align chän Middle ®Ó thÊy 

chóng ta võa thiÕt lËp c¸i g×.

Dßng ®Çu tiªn cña v¨n b¶n c¨n chØnh tíi gi÷a ¶nh.

4) Víi ¶nh ®· lùa chän, trong tr×nh ®¬n pop-up Align chän Left.

¶nh b©y giê xuÊt hiÖn ë phÝa tr¸i  vµ v¨n b¶n tù ®éng xuèng dßng ë 

phÝa ph¶i. 

5) Chän File > Save ®Ó lu l¹i sù thay ®æi cña chóng ta.

6) Chän File > Preview in Browser, sau ®ã lùa chän mét tr×nh duyÖt ®Ó 

hiÓn thÞ tµi liÖu chóng ta võa lµm hoÆc Ên F12 ®Ó xem nã trªn cöa sæ 

tr×nh duyÖt.

Chóng ta thÊy ¶nh vµ v¨n b¶n ®· ®îc c¨n chØnh.

7) Khi chóng ta xem xong file nµy, ®ãng cöa sæ tr×nh duyÖt l¹i.

2.6.2 Thiết lập khoảng trống cho ảnh.

Nh chóng ta thÊy, khi chóng ta ®Æt mét ¶nh trong mét ®o¹n v¨n, v¨n b¶n 

xuÊt hiÖn ngay bªn c¹nh mÐp cña ¶nh. Trong bíc tiÕp theo chóng ta sÏ thªm 

mét lÒ  kh«ng gian gi÷a ¶nh vµ v¨n b¶n

Chóng ta cã thÓ sö dông c¸c thuéc tÝnh kh«ng gian  ngang (H Space) vµ 

däc (V Space) trong phÇn gi¸m s¸t Property ®Ó t¹o ra kh«ng gian xung quanh 

mét h×nh ¶nh. Thuéc tÝnh kh«ng gian ngang (horizontal space) cho biÕt thªm 

kh«ng gian cho bªn tr¸i vµ bªn ph¶i cña h×nh ¶nh, trong khi thuéc tÝnh kh«ng 

gian däc (vertical space) thªm kh«ng gian ë trªn vµ díi mét h×nh ¶nh.

1) Trong tµi liÖu image_align.htm, click ¶nh thø hai trong trang.



2) Trong phÇn gi¸m s¸t Property, nhËp 10 « textbox V Space ®Ó thiÕt lËp 

kho¶ng trèng däc.

3) Di chuyÓn con trá tíi « textbox H Space, nhËp 30, sau ®ã Ên Enter.

Kho¶ng trèng lÒ ®· ®îc t¹o gi÷a v¨n b¶n vµ ¶nh. Kho¶ng trèng nµy còng ¶nh h-

ëng tíi kho¶ng c¸ch gi÷a ¶nh vµ ®êng viÒn cña b¶ng.

2.6.2.1 Thiết lập các tùy chọn về khoảng trống (Space) và căn chỉnh 
lề (Alignment).

Nh lµ bíc cuèi cïng trong phÇn híng dÉn nµy, chóng ta sÏ thiÕt lËp c¶ thuéc 

tÝnh Alignment vµ Space cho ¶nh.

1) Trong tµi liÖu imageAlign.htm, click vµo ¶nh thø 3 cña trang.

2) Trong phÇn gi¸m s¸t Property, trong tr×nh ®¬n pop-up Align chän Right.

¶nh di chuyÓn sang bªn ph¶i

3) Trong « textbox HSpace, chän 30, sau ®ã click vµo mét vÞ trÝ bÊt kú 

trong phÇn gi¸m s¸t Property. 

Kho¶ng trèng – lÒ ®· ®îc thªm gi÷a ¶nh vµ v¨n b¶n.

2.6.3 Tạo một bản đồ ảnh

Mét b¶n ®å ¶nh lµ Mét ¶nh mµ ®îc dïng lµm mét thiÕt bÞ dÉn ®êng. Víi 

mét b¶n ®å ¶nh, chóng ta cã thÓ t¹o ra nhiÒu hotspot (nh÷ng vïng clickable) 

trong mét ¶nh ®¬n vµ cã mçi mèi liªn kÕt hotspot tíi mét URL kh¸c hay file ®Ó 

më. CHóng ta còng cã thÓ thiÕt lËp n¬i sÏ më ra mét tµi liÖu ®· ®îc liªn kÕt 

ch¼ng h¹n chóng ta cã thÓ më tµi liÖu trong mét khung ®Æc biÖt cña mét tµi 

liÖu frameset, hoÆc më nã trong mét cöa sæ tr×nh duyÖt míi

2.6.3.1 Xem file đã hoàn thành

H·y xem qua c¸c file ®· hoµn thµnh ®Ó xem nh÷ng g× chóng ta sÏ t¹o ra. 

B¶n ®å ¶nh ®· hoµn thµnh bao gåm c¸c ®êng liªn kÕt tíi  c¸c tµi  liÖu kh¸c. 

Chóng ta sÏ më tµi liÖu trong mét cöa sæ tr×nh duyÖt ®Ó xem lµm thÕ nµo c¸c 

liªn kÕt ho¹t ®éng.



1) Chän File -> Open, mét hép tho¹i xuÊt hiÖn, chän ®êng dÉn vµ chän file 

imagemap_comp.htm (File nµy n»m trong sè c¸c file gi¸o viªn cung cÊp 

trong m«n häc)

Tµi liÖu ®îc më trong cöa sæ Document.

2) Ên F12 (Windows only) hoÆc chän File > Preview in Browser sau ®ã lùa 

chän tr×nh duyÖt ®Ó hiÓn thÞ tµi liÖu.

3) Cuén cho con trá qua c¸c vïng ¸nh s¸ng tÝm. Con trá thay ®æi thµnh mét 

bµn tay, ®Ó cho chóng ta  biÕt  nh÷ng vïng liªn kÕt tíi tµi liÖu kh¸c

4)  Click North America. 

Mét trang míi ®îc më ra.

5) Click vµo nót Back cña tr×nh duyÖt ®Ó quay l¹i trang b¶n ®å thÕ giíi.

6) Click vµo hotspot kh¸c. 

Tµi liÖu ®· ®îc liªn kÕt më mét cöa sæ tr×nh duyÖt míi.

7) Sau khi chóng ta ®· xem xong c¸c trang ®ã, ®ãng cöa sæ tr×nh duyÖt 

l¹i.

2.6.3.2 Thiết lập phạm vi cho bản đồ ảnh.

Chóng ta sÏ t¹o ra mét b¶n ®å ¶nh ®Ó cho mét ¶nh liªn kÕt ®Õn nhiÒu trang.

1) Chän File -> Open, mét hép tho¹i xuÊt hiÖn, chän ®êng dÉn vµ chän file 

imagemap_start.htm (File nµy n»m trong sè c¸c file gi¸o viªn cung cÊp 

trong m«n häc)

2) Trong tµi liÖu, click vµo ¶nh b¶n ®å thÕ giíi ®Ó lùa chän nã.



3) Më phÇn gi¸m s¸t Property nÕu nã cha ®îc më, vµ nhÊn vµo mòi tªn díi 

cïng bªn ph¶i cña phÇn gi¸m s¸t Property ®Ó xem tÊt c¶ c¸c thuéc tÝnh 

¶nh, nÕu cÇn thiÕt.

C¸c tïy chän b¶n ®å ¶nh xuÊt hiÖn trong phÇn gi¸m s¸t Property.

4) Trong « textbox Map Name, chän  Locations. 

MÑo: NÕu chóng ta t¹o nhiÒu h¬n mét b¶n ®å h×nh ¶nh trong mét tµi 

liÖu, mçi b¶n ®å ph¶i cã mét tªn duy nhÊt. Mçi b¶n ®å h×nh ¶nh cã thÓ 

cã nhiÒu hotspots .

5)  Click  Rectangular Hotspot Tool ®Ó lùa chän nã.

6) Trong cöa sæ Document, bÊm vµo trong khu vùc ë phÝa trªn vµ bªn tr¸i 

cña B¾c Mü (North America), sau ®ã kÐo xuèng vµ trá ë bªn ph¶i trªn 

h×nh ¶nh ®Ó t¹o ra mét khu vùc hotspot.

Mét Layer mµu xanh xuÊt hiÖn phÝa trªn ¶nh, vµ b¶ng gi¸m s¸t Property cña 

hostpot xuÊt hiện.

7) Trong « textbox Link, click vµo biÓu tîng folder. Mét hép tho¹i xuÊt hiÖn, 

chóng ta chän file cã tªn lµ location1.htm theo ®óng ®êng dÉn ®Ó thiÕt 

lËp liªn kÕt cho nã.

8) Trong « textbox Alt, gâ North America.



Chóng ta ®· thiÕt lËp hotspot ®Çu tiªn. Chóng ta h·y thiÕt lËp thªm mét 

vµi c¸i n÷a.

2.6.3.3 Mở một file lên kết trong cửa sổ mới.

Chóng ta cã thÓ thÊy c¸c c«ng cô hotspot kh¸c nhau nh thÕ nµo, lÇn nµy 

chóng ta sÏ sö dông c«ng cô Polygon Hotspot ®Ó x¸c ®Þnh vïng hotspot. C«ng 

cô ®a gi¸c cho phÐp chóng ta thiÕt lËp c¸c ®iÓm kÕt nèi ®Ó x¸c ®Þnh khu vùc 

hotspot. Chóng ta còng sÏ t×m hiÓu lµm thÕ nµo ®Ó më c¸c tµi liÖu liªn kÕt 

trong mét cöa sæ míi.

1) Trong b¶ng gi¸m s¸t Property, click vµo ¶nh n¬i mµ chóng ta muèn b¾t 

®Çu hotspot, vµ di chuyÓn con trá tíi vÞ trÝ ta muèn.

2) TiÕp tôc click vßng quanh thµnh 1 h×nh khÐp kÝn ®Ó ®Þnh nghÜa 

Europe lµ vïng hotspot. 

Chó ý: Khi chóng ta click, vïng b¶n ®å ¶nh ®iÒu chØnh vµ phñ ®Çy 

trong ph¹m vi ®ã, tiÕp tôc click quanh h×nh ®Ó  phñ ®Çy vïng chóng ta 

muèn ®a vµo.

3) Khi chóng ta ®· kÕt thóc t¹o b¶n ®å ¶nh, click nót mòi tªn trong phÇn 

gi¸m s¸t Property ®Ó thay ®æi con trá tõ c«ng cô vÏ.

4) Trong « textbox Link, click vµo biÓu tîng folder, sau ®ã chän ®êng dÉn tíi file 

location3.htm ®Ó më file nµy khi hotspot ®îc click.

5) Trong tr×nh ®¬n pop-up Target, chän _blank. 

Khi ngêi dïng click vµo  hotspot, trang Locations3 sÏ ®îc më trong cöa sæ míi.

6) Trong « textbox Alt text, nhËp Europe. 



7) Ên F12 (Windows only) hoÆc chän File > Preview in Browser sau ®ã lùa chän 

tr×nh duyÖt ®Ó hiÓn thÞ tµi liÖu vµ kiÓm tra c¸c liªn kÕt chóng ta võa thiÕt 

lËp. 

8) Lu vµ ®ãng file l¹i.

2.6.4 Tổng kết

Trong phÇn híng dÉn nµy, chóng ta ®· lµm viÖc víi mét sè khÝa c¹nh 

cña h×nh ¶nh. Chóng ta ®· häc ®îc c¸ch sö dông phÇn gi¸m s¸t Property ®Ó 

c¨n chØnh h×nh ¶nh, ®Þnh nghÜa kh«ng gian xung quanh mét h×nh ¶nh, vµ 

®Ó t¹o ra mét b¶n ®å h×nh ¶nh.

2.7 Làm việc với các file thiết kế trong Dreamweaver

Trong phÇn nµy, chóng ta sÏ t¹o mét tµi liÖu míi, sau ®ã chÌn vµ chØnh söa c¸c 

®o¹n m· thiÕt kÕ c¸c phÇn tö cña ®o¹n m·. Chóng ta còng t×m hiÓu lµm thÕ 

nµo ®Ó t¹o ra ®o¹n m· cña riªng m×nh.

Trong phÇn nµy chóng ta sÏ tËp chung vµo c¸c nhiÖm vô sau:

 Lµm viÖc víi c¸c ®o¹n m·.

 ChÌn mét ®o¹n m·.

 ChØnh söa néi dung ®o¹n m·.

 Lu m· nh mét mÈu tin.

2.7.1 Làm việc với các đoạn mã

Sö dông c¸c ®o¹n m· cã thÓ lµ mét thùc tÕ tiÕt kiÖm thêi gian trong viÖc 

t¹o ra lµ mét trang web chuyªn nghiÖp. Chóng ta cã thÓ chÌn thªm c¸c ®o¹n m· 

s½n cã trong Dreamweaver hoÆc chóng ta cã thÓ dÔ dµng t¹o c¸c ®o¹n m· 

riªng cña chóng ta ®Ó t¸i sö dông trong c¸c trang web cña chóng ta. Chóng ta 

cã thÓ t¹o c¸c ®o¹n m· HTML, Javascript, CFML, ASP, JSP, vµ nhiÒu h¬n n÷a.

Chóng ta sÏ b¾t ®Çu b»ng c¸ch lµm viÖc víi mét sè ®o¹n m· cã s½n 

trong Dreamweaver.

Chóng ta cã thÓ t¹o ra mét tµi liÖu míi dùa trªn tµi liÖu Page Design 

trong hép tho¹i New Document.

1) Chän File > New. 

Hép tho¹i New Document xuÊt hiÖn.



2) Trong tab General, môc Basic Page s½n sµng ®Ó lùa chän.

3) Trong  danh  s¸ch  tµi  liÖu  Basic  Page,  lùa  chän  HTML,  sau  ®ã  click 

Create.

Tµi liÖu ®îc më trong Document.

4) Lu tµi liÖu lµ  myCodeSnippets trong site cña chóng ta (File > Save).

2.7.3 Chèn một bảng điều hướng (navigation)

Dreamweaver ®i kÌm víi kh¸ nhiÒu ®o¹n m· ®Ó lùa chän. C¸c ®o¹n m· ®îc ®Æt 

trong panel Code. Khi chóng ta hoµn thµnh phÇn  híng dÉn nµy, chóng ta sÏ 

chÌn mét m· chuyÓn híng (navigation), mét ®o¹n néi dung (content), vµ mét 

®o¹n footer.

1) §Æt ®iÓm chÌn trong v¨n b¶n mµ chóng ta muèn chÌn c¸c ®o¹n m·.

2) Më panel Snippets b»ng mét trong c¸c c¸ch sau:

 Chän Window > Snippets.

 Trong panel Code, nhÊp vµo mòi tªn më réng nÕu nã cha hiÓn 

thÞ, sau ®ã chän Snippet.

Panel Snippets xuÊt hiÖn.

3) Click ®óp vµo th môc Accessible ®Ó xem néi dung cña nã, sau ®ã click 

®óp tiÕp vµo th môc Navigation.

4) Click ®óp vµo th môc Tab ®Ó xem néi dung cña nã, sau ®ã click Basic 

Tabs ®Ó lùa chän nã.

Snippet xuÊt hiÖn trong panel xem tríc.



5) Trong panel Snippets, click nót Insert ë díi cïng bªn tr¸i cña b¶ng ®iÒu 

Snippets ®Ó chÌn nã vµo tµi liÖu cña chóng ta.

Mét ®o¹n m· nhá xuÊt hiÖn trong tµi liÖu cña chóng ta.

6) Lu tµi liÖu l¹i (File > Save).

2.7.4 Thêm một nội dung (content)

TiÕp theo chóng ta sÏ thªm mét b¶ng ®Ó t¹o néi dung. Chóng ta sÏ chÌn ®o¹n m· 

trùc tiÕp bªn díc c¸c ®o¹n m· cña b¶ng chuyÓn híng (navigation) mµ chóng ta 

võa chÌn.

1) Ên Enter hoÆc Return ®Ó di chuyÓn ®iÓm chÌn tíi dßng tiÕp theo.

2) Trong panel Snippets, click ®óp vµo th môc Content Tables, sau ®ã click 

®óp vµo th môc One-pixel-border ®Ó thÊy c¸c snippets trong th môc ®ã.

3) Click vµo Text B ®Ó lùa chän nã, vµ sau ®ã click Insert ®Ó chÌn snippet 

vµo trong tµi liÖu.

Mét ®o¹n m· nhá xuÊt hiÖn trong tµi liÖu



4) Lu tµi liÖu l¹i (File > Save).

2.7.5 Thêm đoạn mã cho phần footer

B©y giê chóng ta sÏ häc c¸ch thªm mét snippet cuèi cïng, mét snippet cho néi  

dung phÇn cuèi (footer).

1) Ên Enter hoÆc Return ®Ó di chuyÓn ®iÓm chÌn ®Õn dßng tiÕp theo.

2) Trong panel Snippets, click ®óp vµo th môc Footers ®Ó thÊy néi dung 

trong th môc ®ã.

3) Click vµo Basic: Brief Text ®Ó lùa chän nã, sau ®ã click Insert ®Ó chÌn 

snippet vµo tµi liÖu.

Mét ®o¹n m· nhá xuÊn hiÖn trong tµi liÖu. 

B¶ng hép tho¹i Getting Started trong Layout View xuÊt hiÖn vµ m« t¶ c¸c tïy 

chän Layout view.

1) Xem l¹i c¸c tïy chän, sau ®ã click OK ®Ó ®ãng hép tho¹i.

2) Trong thanh Insert cã 2 tïy chän Layout s½n dïng - Draw Layout Cell and 

Draw  Layout  Table,  nh÷ng  tïy  chän  nµy  kh«ng  cã  hiÖu  lùc  trong 

Standard view.

3) NÕu phÇn gi¸m s¸t Property cha ®îc më, chän Window > Properties ®Ó 

më nã.

4) Trong thanh Insert, click nót Draw Layout Cell



5) Di chuyÓn con trá tíi cöa sæ Document, Con trá chuét thay ®æi tíi mét 

c«ng cô b¶n vÏ. (tr«ng nh dÊu + ). KÝch vµo gãc tr¸i trªn cña tµi liÖu, råi 

kÐo lª ®Ó vÏ « layout. 

Khi chóng ta gi¶i phãng con chuét, mét « layout b¶ng xuÊt hiÖn trong 

mét b¶ng layout.

B¶ng layout më réng ®Ó ®iÒn vµo cöa sæ Document, vµ thiÕt lËp ph¹m vi  

Layout cña trang web. H×nh ch÷ nhËt mµu tr¾ng lµ « layout chóng ta vÏ. Chóng 

ta cã thÓ ®Æt thªm c¸c « layout trong khu vùc trèng cña b¶ng layout.

6) VÏ 1 « kh¸c ®Ó t¹o ra mét vïng v¨n b¶n phÝa trªn nót ®Þnh híng. 

4) Lu tµi liÖu l¹i (File > Save).



2.7.6 Chỉnh sửa nội dung mẩu tin

TiÕp theo, chóng ta sÏ chØnh söa v¨n b¶n gi÷ chç vµ ¸p dông c¸c thay ®æi mµu 

s¾c. chóng ta sÏ ¸p dông mµu nÒn cho c¸c « ®Ó thiÕt lËp biÓu ®å mµu cña 

riªng chóng ta.

1) Më b¶ng gi¸m s¸t Property (Window -> Property), nÕu nã cha ®îc më.

2) §Æt con trá vµo « ®Çu tiªn cña b¶ng Navigation mµ chóng ta ®· chÌn. 

ChÝnh lµ « cã ch÷ “Lorem”.

3) Trong « textbox Bg cña b¶ng gi¸m s¸t Property, click vµo « cã mòi tªn ®Ó 

chän mµu cho «, hoÆc chóng ta tù ®iÒn m· mµu vµo « textbox bªn c¹nh 

phÝa ph¶i. Chóng ta sÏ sö dông mµu #9966FF.

4) §Æt con trá tíi « tiÕp theo, chÝnh lµ « cã ch÷  “Ipsum.” 

5) Trong « textbox Bg cña b¶ng gi¸m s¸t Property, click vµo « cã mòi tªn ®Ó 

chän mµu cho «, hoÆc chóng ta tù ®iÒn m· mµu vµo « textbox bªn c¹nh 

phÝa ph¶i. Chóng ta sÏ sö dông mµu #9999FF.

6) LÆp l¹i bíc 5, ¸p dông mµu #9999FF cho c¸c « “Dolor” vµ “Amit.”

7) Click vµo « cña b¶ng content, sau ®ã lùa chän mµu ¸p dông cho « cña b¶ng.

8) T¹o thªm sù thay ®æi nÕu chóng ta muèn.

9) Khi chóng ta lµm xong, lu tµi liÖu l¹i.

10)Ên F12 (Windows only) hoÆc chän File > Preview in Browser vµ lùa 

chän tr×nh duyÖt hiÓn thÞ tµi liÖu ta võa thùc hiÖn.



2.7.7 Lưu mã như một snippet

Lµm viÖc víi ®o¹n m· cã s½n lµ rÊt dÔ dµng. Chóng ta cã thÓ dÔ dµng 

t¹o ®o¹n m· cña riªng chóng ta. VÝ dô, gi¶ sö chóng ta muèn t¸i sö dông ®o¹n 

m· mµ chóng ta ®· cËp nhËt trong tµi liÖu mµ chóng ta võa t¹o ra.

H·y lu c¸c snippet ®Þnh híng nh lµ mét snippet míi.

1) Trong panel Snippets chän th môc Navigation, sau ®ã chän th môc Tab.

2) Trong cöa sæ Document, click vµo « ®iÒu híng cã néi dung “Lorem”.

3) Trong phÇn lùa chän thÎ, ë vÞ trÝ phÝa díi bªn tr¸i cña cöa sæ tµi liÖu, 

click vµo thÎ <table>.

Trong cöa sæ Document, b¶ng ®· ®îc lùa chän.

4) Thùc hiÖn mét trong c¸c c¸ch sau ®Ó lu phÇn lùa chän nh lµ mét m· 

snippet:

 Click ph¶i chuét ®Ó chän b¶ng, sau ®ã chän Create New Snippet.

 Trong panel Snippets, click vµo nót céng (+) nót cã vÞ trÝ phÝa díi cña 

panel.

Mét hép tho¹i Snippet xuÊt hiÖn.

5) Trong « textbox Name, nhËp mét tªn ®Ó m« t¶ snippet cña chóng ta.

6) Trong Description, NhËp mét m« t¶ cho snippet. 

7) Chóng ta cã thÓ xem c¸c m« t¶ cña snippet trong panel Snippets ®Ó lùa 

chän tªn snippet mét c¸ch chÝnh x¸c. 



8) Trong Snippet Type, chän Insert Block. §iÒu nµy cã nghÜa lµ sÏ chÌn mét 

snippet lµ mét khèi m· h¬n lµ mét snippet mµ v¨n b¶n ®îc ¸p dông vµo.

9)  Click OK.

10)Trong panel Snippets, m· snippet míi ®· ®îc thªm vµo th môc Tab.

2.7.8 Tổng kết

Trong phÇn híng dÉn nµy, chóng ta ®· biÕt lµm thÕ nµo ®Ó x¸c ®Þnh 

vÞ trÝ, xem, vµ chÌn thªm c¸c ®o¹n m· cã s½n trong Dreamweaver. Chóng ta 

còng biÕt c¸ch t¹o m· snippets riªng cña chóng ta lµ mét c«ng viÖc dÔ dµng ®Ó 

thùc hiÖn.

2.8 Thực hành

Sö dông c¸c Dreamweaver ®Ó thiÕt kÕ c¸c website trong phÇn thùc hµnh ch-

¬ng 2.



Chương 4

 Những kiến thức cơ bản về VBSCRIPT

VBScript  lµ  mét  c«ng nghÖ cña Microsoft  yªu  cÇu ph¶i  cã  Microsoft 

Internet Explorer. Tr−íc khi b¾t ®Çu häc viÕt VBScript, chóng ta cÇn ph¶i biÕt 

c¸c kh¸i niÖm c¬ b¶n vÒ: WWW, HTML vµ c¸c kiÕn thøc c¨n b¶n ®Ó x©y dùng 

mét trang web.

Trong phÇn nµy sÏ cung cÊp cho chóng ta nh÷ng g× c¬ b¶n nhÊt vÒ 

VBScript, vµ t¹i sao chóng ta l¹i sö dông nã.

Môc tiªu

Sau khi häc xong ch¬ng nµy, chóng ta sÏ:

      1. Ph©n tÝch ®îc b¶n chÊt cña VBScript. 

2. Khai b¸o vµ chÌn ®îc c¸c ®o¹n m· VBScript vµo trang HTML.

3. VËn dông ®îc c¸c lÖnh ®iÒu khiÓn, vßng lÆp c¬ b¶n trong lËp tr×nh.

      4. X©y dùng ®îc c¸c hµm, thñ tôc ®Ó øng dông vµo trang web.

5. HiÓu vµ vËn dông ®îc c¸c hµm cã s½n trong VBScript.



1. Khái niệm về ngôn ngữ VB Script

VBScript lµ mét ng«n ng÷ lËp tr×nh th«ng dÞch (ngay ng«n ng÷ kÞch 

b¶n). Nã cã thÓ ®îc nhóng vµo mét trang web HTML hoÆc ®îc dïng trong c¸c 

kÞch b¶n phÝa server.

Client Side Scripting

M· VBScript ®îc thùc thi/th«ng dÞch khi mét sù kiÖn (biÕn cè) ®îc tÝch 

(bÊm). Khi m· ®îc thùc thi nã sÏ th«ng dÞch mét dßng mét lÇn. Cã mét sè c¸c 

sù kiÖn sÏ ®îc tÝch ®Ó thùc thi mét VBScript gièng nh click vµo mét nót cña 

Form hoÆc hoµn thµnh qu¸ tr×nh n¹p mét trang web.

Chó ý: Internet Explorer lµ tr×nh duyÖt duy nhÊt hç trî VBScript (Cho ®Õn thêi  

®iÓm t¸c gi¶ viÕt gi¸o tr×nh nµy).

Server Side Scripting

Khi web server n¹p mét trang .asp tõ æ cøng vµo bé nhí, nã tù ®éng biÕt 

th«ng dÞch m· trong tµi  liÖu nµy. Khi m· ®îc th«ng dÞch, kÕt qu¶ lµ trang 

HTML ®îc göi tíi tr×nh duyÖt (client) ®Ó t¹o ra yªu cÇu.

1.1 Tại sao học VBScript.

VBScript ®îc dïng ®Ó t¹o ra c¸c trang ho¹t ®éng phÝa server (Active 

Server  Pages  -  ASPs),  ®Ó  t¹o  ra  c¸c  kÞch  b¶n  qu¶n  trÞ  cho  Windows 

95/98/NT,  ®Ó sö  dông  hoÆc t¨ng  cêng  c¸c  chøc  n¨ng  cña  c¸c  s¶n  phÈm 

Microsoft Office (Gièng nh Word vµ Excel (macros)). Nã còng cã thÓ ®îc dïng 

nh mét  ng«n ng kÞch b¶n phÝa client  cho Internet  Explorer.  Netscape th× 

kh«ng hç trî VBScript nh lµ mét ng«n ng÷ kÞch b¶n phÝa client.

1.2 Câu hỏi trắc nghiệm

1. (§óng hay sai) VBScript lµ mét ng«n ng÷ th«ng dÞch.

2. Visual Basic lµ mét ng«n ng÷ lËp tr×nh ______________.

3. (§óng hay sai) Visual Basic vµ VBScript ®îc t¹o bëi mét c«ng ty.



4. Microsoft Internet Explorer hç trî c¸c ng«n ng÷ kÞch b¶n sau.

   a. VBScript

   b. Visual Basic

   c. BASIC

   d. JavaScript

   e. C++

   f. Perl

5. (§óng hay sai) VBScript ®îc hç trî bëi phÇn lín c¸c tr×nh duyÖt.

2. Đưa các đoạn Script vào trong trang Web

2.1 Cú pháp VBScript.

C¸ch tèt nhÊt ®Ó chóng ta t×m hiÓu vÒ có ph¸p cña VBScript lµ chóng ta cïng 

t×m hiÓu ®o¹n m· sau:

<html>
   <head>
   </head>
   <body>
        <script type="text/vbscript">
             document.write("Xin chµo từ VBScript!")
        </script>
    </body>
</html>

Và ®o¹n m· trªn sÏ hiÓn thÞ ra tr×nh duyÖt cña chóng ta lµ:

Xin chào từ VBScript! 

Chóng ta cã tù ®Æt ra c©u hái lµ t¹i sao chóng l¹i hiÓn thÞ ra nh vËy? vµ ®Ó 

hiÓn thÞ ra nh vËy th× chóng ta sÏ ph¶i viÕt code nh thÕ nµo? C©u tr¶ lêi sÏ cã 

ngay sau ®©y.

§Ó chÌn mét kÞch b¶n vµo mét tµi liÖu HTML, chóng ta sö dông thÎ <script>. 

Chóng ta sö dông thÎ nµy ®Ó ®Þnh nghÜa mét ng«n ng÷ kÞch b¶n.

<script type="text/vbscript">

Sau  ®ã ®Õn VBScript:  C©u lÖnh ®Ó hiÓn thÞ v¨n b¶n lªn tr×nh duyÖt lµ 

document.write: 



document.write("Hello from VBScript!")

KÕt  thóc mét kÞch b¶n, chóng ta dïng thÎ </script>

</script>

2.2 Các vị trí đặt mã VBScript.

C¸c kÞch b¶n trong trang web sÏ ®îc thùc thi ngay lËp tøc khi trang web 

®îc n¹p vµo trong tr×nh duyÖt. §iÒu nµy kh«ng ph¶i lu«n lµ ®iÒu chóng ta 

mong muèn. §«i khi chóng ta muèn thùc thi mét kÞch b¶n khi trang web ®îc 

n¹p, nh÷ng lÇn kh¸c chóng ta l¹i muèn c¸c kÞch b¶n chØ ®îc thùc thi khi ngêi 

dïng click vµo mét sù kiÖn.

2.2.1 Các kịch bản trong phần head.

C¸c kÞch b¶n ®îc thùc thi khi chóng ®îc gäi hoÆc khi mét sù kiÖn ®îc 

chän trong phÇn head. Khi chóng ta ®Æt mét ®o¹n m· trong phÇn head chóng 

ta sÏ ch¾c ch¾n r»ng kÞch b¶n ®îc n¹p tríc khi ai ®ã sö dông chóng.

<html>
     <head>
          <script type="text/vbscript">
                 Mét vµi c©u lÖnh.
          </script>
     </head>

1.2.2 Các kịch bản trong phần body.

C¸c kÞch b¶n ®îc thùc thi khi trang web ®îc n¹p vµo phÇn body. Khi chóng 

ta ®Æt mét kÞch b¶n vµo phÇn body nã sÏ t¹o ra néi dung cña trang web.

<html>
    <head>
    </head>
    <body>
         <script type="text/vbscript">
                Mét vµi c©u lÖnh.
        </script>
</body>

2.2.3 Các kịch bản trong cả phần head và body.

Chóng ta cã thÓ ®Æt mét sè c¸c kÞch b¶n (kh«ng giíi h¹n) trong tµi liÖu 

cña chóng ta. Do ®ã, chóng ta cã c¸c kÞch b¶n trong c¶ phÇn head vµ body.

<html>



    <head>
        <script type="text/vbscript">
               C¸c c©u lÖnh
        </script>
    </head>
    <body>
        <script type="text/vbscript">
              C¸c c©u lÖnh
        </script>
    </body>

2.3 Xây dựng lập trình cơ bản.

Trong phÇn nµy chóng ta sÏ t×m hiÓu vÒ cÊu tróc c¬ b¶n cña lËp tr×nh. 

Nh÷ng cÊu tróc nµy gièng víi mét sè ng«n ng÷ lËp tr×nh, vµ sÏ sö dông trong 

mét sè kÞch b¶n trong c¸c phÇn sau.

M  ôc tiªu  

1. Khai b¸o biÕn

2. Sö dông c¸c to¸n tö.

3. T¹o c¸c cÊu tróc ®iÒu khiÓn.

4. Vßng lÆp

5. Mét sè hµm c¬ b¶n.

2.3.1 Khai báo biến.

BiÕn lµ mét vïng chøa th«ng tin cÇn l−u tr÷. Gi¸ trÞ cña biÕn cã thÓ 

®−îc thay ®æi trong qu¸ tr×nh lËp tr×nh. Ta cã thÓ lµm viÖc víi mét biÕn th«ng 

qua tªn cña nã, còng nh− cã thÓ thay ®æi gi¸ trÞ  cña biÕn ®ã. Trong VBScript, 

tÊt c¶ c¸c biÕn ®Òu cã kiÓu lµ variant, vµ nã cã thÓ  l−u tr÷  bÊt kú d¹ng d÷ 

liÖu nµo.

Quy t¾c ®Æt tªn biÕn: 

 B¾t ®Çu b»ng mét ch÷ c¸i. 

 kh«ng chøa dÊu (.).

 §é dµi kh«ng qu¸ 255 ký tù. 

Khai b¸o biÕn

Chóng ta cã thÓ khai b¸o biÕn víi c¸c tõ kho¸ Dim, Public hoÆc Private.   



famname(2)="Hege"
famname(3)="Stale"
famname(4)="Kai Jim"
famname(5)="Borge"

for i=0 to 5
  document.write(famname(i) & "<br />")

next
</script>

   </body>
</html>

VÝ dô d−íi ®©y khai b¸o mét biÕn tªn name vµ g¸n cho nã mét gi¸ trÞ: 

dim name 

name = gi¸ trÞ 

Chóng ta còng cã thÓ khai b¸o biÕn b»ng c¸ch sö  dông nã trong script cña 

m×nh. 

VÝ dô 1

name = gi¸ trÞ 

Tuy vËy, c¸ch khai b¸o nµy kh«ng ®−îc t−êng minh vµ kh«ng tèt cho øng 

dông cña chóng chóng ta, v× sau ®ã trong øng dông cña m×nh, chóng ta cã  

thÓ v« t×nh viÕt sai tªn biÕn vµ cã thÓ nhËn ®−îc kÕt qu¶ kh«ng chÝnh x¸c khi 

ch¹y ch−¬ng tr×nh. 

§iÒu ®ã x¶y ra lµ v× gi¶ sö chóng ta cã mét tªn biÕn tªn “name”, sau ®ã 

chóng ta gäi tíi  biÕn ®ã b»ng mét tªn “nime” ch¼ng h¹n, ch−¬ng tr×nh sÏ tù 

®éng sinh ra thªm 1 biÕn tªn “nime”.  §Ó tr¸nh x¶y ra ®iÒu nhÇm lÉn nµy, 

chóng ta nªn sö dông c©u lÖnh Option Explicit. Khi sö dông c©u lªnh nµy, tÊt 

c¶ c¸c biÕn ®Òu ph¶i khai b¸o tr−íc khi sö  dông bëi c¸c c©u lÖnh víi tõ kho¸ 

Dim, Public hoÆc Private. §Æt c©u lÖnh Option Explicit trªn ®Çu cña ch−¬ng 

tr×nh, nh− vÝ dô sau: 

Option Explicit 

dim name 

name = gi¸ trÞ 

C¸ch g¸n gi¸ trÞ cho biÕn: 

Chóng ta cã thÓ g¸n gi¸ trÞ cho cho mét biÕn nh− sau:  



name = “NguyÔn Minh Ph−îng” 

i = 200 

Tªn biÕn lµ ë phÝa bªn tr¸i cña biÓu thøc vµ gi¸ trÞ chóng ta muèn g¸n 

cho biÕn lµ ë bªn ph¶i. B©y giê biÕn "name" cã gi¸ trÞ " NguyÔn Minh Ph¬ng ".

Thêi gian sèng cña biÕn

Kho¶ng thêi gian biÕn ®ã tån t¹i ®−îc gäi lµ thêi gian sèng cña nã. 

Khi khai b¸o mét biÕn trong mét thñ tôc, biÕn ®ã chØ ®−îc truy xuÊt tíi trong 

ph¹m vi thñ tôc ®ã. Khi thñ tôc ®ã kÕt thóc, c¸c biÕn ®ã còng bÞ huû. Nh÷ng 

biÕn nµy ®−îc gäi lµ biÕn côc bé. Chóng ta cã thÓ ®Æt c¸c biÕn côc bé trïng 

tªn nhau trong c¸c thñ tôc kh¸c nhau, bëi v× mçi biÕn chØ ®−îc nhËn biÕt bëi 

chÝnh thñ tôc trong ®ã chóng ®−îc khai b¸o.  

NÕu chóng ta khai b¸o mét biÕn bªn ngoµi mét thñ tôc, tÊt c¶ c¸c thñ tôc 

n»m trong cïng trang ®ã ®Òu cã thÓ truy nhËp tíi biÕn ®ã. Thêi gian sèng cña 

biÕn nµy b¾t ®Çu tõ lóc nã ®−îc khai b¸o vµ kÕt thóc khi trang web ®−îc ®ãng 

l¹i. 

BiÕn m¶ng (Array) 

Cã nh÷ng khi chóng ta muèn g¸n nhiÒu h¬n 1 gi¸ trÞ cho mét biÕn, khi  

®ã chóng ta khai b¸o mét biÕn cã thÓ chøa mét d·y d÷ liÖu. BiÕn nµy ®−îc gäi 

lµ biÕn m¶ng (array). §Ó khai b¸o mét  biÕn lµ biÕn m¶ng, chóng ta ®Æt dÊu 

ngoÆc ®¬n ngay sau tªn biÕn.

VÝ dô sau chóng ta khai b¸o mét biÕn m¶ng gåm cã 3 gi¸ trÞ: 

dim names(2) 

Gi¸ trÞ sè trong dÊu ngoÆc lµ 2. ChØ sè cña biÕn array b¾t ®Çu bëi 0 

cho nªn biÕn nµy sÏ bao gåm 3 gi¸ trÞ. §©y lµ mét m¶ng cã ®é dµi cè ®Þnh. Ta 

g¸n gi¸ trÞ cho tõng phÇn tö cña m¶ng b»ng c¸ch sau: 

names(0) = “NguyÔn Thu H¬ng”  

names(1)=”NguyÔn V¨n B×nh” 

names(2)=”Hoµng Kh¸nh H−ng”  

T−¬ng tù nh− vËy chóng ta cã thÓ lÊy gi¸ trÞ cña bÊt kú phÇn tö nµo 

trong m¶ng mµ chóng ta cÇn b»ng c¸ch sö dông chØ sè t−¬ng øng cña phÇn 

tö: 



eng = names(0) 

Chóng ta chØ cã thÓ khai b¸o nhiÒu nhÊt tíi 60 chiÒu cho mét m¶ng. 

C¸c chiÒu ®−îc khai b¸o c¸ch nhau bëi dÊu phÈy. VÝ dô sau khai b¸o mét m¶ng 

bao gåm 5 dßng vµ 7 cét: 

dim table(4,6) 

VÝ dô 3: T¹o mét biÕn m¶ng

<html>

     <body>

<script type="text/vbscript">

dim famname(5)

famname(0)="Jan Egil"

famname(1)="Tove"

famname(2)="Hege"

famname(3)="Stale"

famname(4)="Kai Jim"

famname(5)="Borge"

for i=0 to 5

  document.write(famname(i) & "<br />")

next

</script>

     </body>

</html>

2.3.2  Các kiểu dữ liệu  

2.3.2.1 Kiểu dữ liệu trong VBScript là gì? 

VBScript chØ cã mét kiÓu d÷ liÖu tªn lµ variant. KiÓu variant lµ mét kiÓu 

d÷ liÖu ®Æc biÖt cã thÓ chøa c¸c lo¹i th«ng tin kh¸c nhau phô thuéc vµo c¸ch 

sö dông chóng. Còng v× nã lµ kiÓu d÷ liÖu duy nhÊt trong VBScript cho nªn tÊt 

c¶ c¸c hµm cña VBScript ®Òu tr¶ vÒ kiÓu d÷ liÖu nµy. 

Nãi mét c¸ch ®¬n gi¶n nhÊt, mét biÕn variant cã thÓ chøa th«ng tin lµ 

mét sè hoÆc mét x©u. BiÕn variant nµy xö sù nh− mét sè khi nã ®−îc sö dông 

trong ng÷  c¶nh sè vµ nh−  mét x©u khi sö  dông nã trong ng÷  c¶nh x©u. §iÒu 

®ã cã nghÜa lµ nÕu ta lµm viÖc víi mét d÷ liÖu tr«ng gièng kiÓu sè, VBScript  

sÏ cho r»ng ®ã lµ mét sè vµ thùc hiÖn tÊt c¶ c¸c c«ng viÖc phï hîp nhÊt víi mét  



sè. T−¬ng tù nh− vËy, nÕu ta lµm viÖc víi d÷ liÖu lµ mét x©u, VBScript coi ®ã 

lµ mét x©u. TÊt nhiªn chóng ta hoµn toµn cã thÓ coi d÷ liÖu sè lµ mét x©u 

b»ng c¸ch ®Æt sè ®ã trong cÆp ngoÆc kÐp (“”).  

2.3.2.2 Kiểu dữ liệu con của Variant

Ngoµi viÖc ®¬n gi¶n lµ ph©n biÖt sè vµ x©u, mét variant cã thÓ ph©n 

biÖt ®−îc th«ng tin sè theo c¸ch kh¸c. Ch¶ng h¹n chóng ta cã thÓ cã mét d÷ 

liÖu sè ®¹i  diÖn cho Date/Time. Khi  sö dông nã cïng víi  mét  d÷ liÖu kiÓu 

Date/Time kh¸c th× kÕt qu¶ tr¶ vÒ lu«n ®−îc biÓu diÔn d−íi d¹ng Date/Time. 

TÊt nhiªn ta cã thÓ cßn cã mét lo¹t c¸c d÷ liÖu d¹ng sè víi kÝch th−íc kh¸c nhau 

tõ kiÓu Boolean cho tíi kiÓu floating – point. C¸c d¹ng th«ng tin kh¸c nhau ®ã cã 

thÓ ®−îc l−u trong biÕn variant gäi lµ c¸c kiÓu con (subtype). PhÇn lín thêi  

gian, chóng ta chØ cÇn g¸n d÷ liÖu cña m×nh vµo biÕn variant vµ biÕn nµy sÏ 

ho¹t ®éng theo c¸ch xö lý d÷ liÖu gièng nh− chÝnh d÷ liÖu mµ nã chøa.

Díi ®©y lµ danh s¸ch c¸c lo¹i d÷ liÖu ®îc hç trî trong VBScript

KiÓu d÷ liÖu M« t¶
Empty BiÕn ch−a ®−îc g¸n gi¸ trÞ ban ®Çu. Cã gi¸ trÞ 0 ®èi víi c¸c 

biÕn kiÓu sè vµ x©u rçng (“”) ®èi víi biÕn x©u.
Null BiÕn kh«ng chøa d÷ liÖu.

Boolean Bao gåm hai gi¸ trÞ lµ True hoÆc False.
Byte Chøa sè nguyªn tõ 0 tíi 255.

Integer Chøa sè nguyªn tõ -32,768 tíi 32,767.  
Currency 922,337,203,685,477.5808 ®Õn 922,337,203,685,477.5807.

Long Chøa sè nguyªn tõ -2,147,483,648 tíi  2,147,483,647.
Single Chøa sè single-precision, floating-point tõ  -1.402823E38 tíi  

-1.401298E-45 ®èi víi gi¸ trÞ ©m, tõ 1.401298E-45 tíi 

3.402823E38 ®èi víi gi¸ trÞ d−¬ng.  
Double Chøa sè double-precision, floating-point -

1.79769313486232E308  to  -4.94065645841247E-324  ®èi 

víi 

gi¸ trÞ ©m, tõ 4.94065645841247E-324 tíi 

1.79769313486232E308 ®èi víi gi¸ trÞ d−¬ng.
Date (Time) Chøa mét gi¸ trÞ sè ®¹i diÖn cho ngµy tÝnh tõ January 1, 

100 tíi 

December 31, 9999.  
String Chøa mét x©u cã ®é dµi bÊt kú dµi nhÊt kho¶ng 2 tû ký tù
Object Chøa mét Object
Error Chøa m· sè lçi



2.3.3 Các toán tử

To¸n tö ®Ó thùc hiÖn c¸c hµnh ®éng trong biÕn. Chóng ta ch¾c ch¾n 

®· thÊy mét to¸n tö ®îc sö dông trong vÝ dô tríc, n¬i mµ chóng ta g¸n c¸c gi¸ trÞ 

tíi c¸c biÕn cña chóng ta. VÝ dô nh sö dông mét trong c¸c to¸n tö c¬ b¶n nhÊt, 

“=” hay to¸n tö g¸n. 

dim x, y, sum

x = 1: y = 3: sum = 0

sum = x + y

VBScript cã mét tËp hîp lín c¸c lo¹i to¸n tö, chia ra thµnh ba lo¹i lµ c¸c to¸n 

tö sè häc, c¸c to¸n tö so s¸nh vµ ghÐp nèi (concatenation), vµ c¸c to¸n tö logic. 

Thø tù −u tiªn cña c¸c to¸n tö 

Khi cã nhiÒu to¸n tö cïng xuÊt hiÖn trong mét biÓu thøc, tõng phÇn cña 

biÓu thøc ®−îc ®¸nh gi¸ vµ xö lý theo mét tr×nh tù gäi lµ thø tù −u tiªn. Ta cã 

thÓ dïng dÊu ngoÆc ®¬n ®Ó thay ®æi thø tù −u tiªn vµ b¾t mét phÇn nµo ®ã 

cña biÓu thøc ph¶i ®−îc thùc hiÖn tr−íc c¸c phÇn kh¸c. C¸c biÓu  thøc bªn trong 

dÊu ngoÆc ®¬n lu«n ®−îc xö 



lý  tr−íc  nh÷ng  biÓu  thøc  bªn  ngoµi.  TÊt  nhiªn,  nÕu biÓu  thøc  trong 

ngoÆc chøa nhiÒu to¸n tö th× chóng còng ph¶i tu©n theo thø tù −u tiªn chuÈn. 

Khi c¸c biÓu thøc chøa nhiÒu lo¹i to¸n tö kh¸c nhau, c¸c to¸n tö sè häc 

®−îc xö lý tr−íc, sau ®ã ®Õn c¸c to¸n tö so s¸nh råi cuèi cïng lµ c¸c to¸n tö logic.  

C¸c to¸n tö so s¸nh tÊt c¶ cã cïng thø tù −u tiªn, tøc lµ chóng sÏ ®−îc xña lý tõ tr¸i 

qua ph¶i theo thø tù xuÊt hiÖn. C¸c to¸n tö sè häc vµ logic ®−îc xö lý theo thø 

tù sau:

Khi phÐp nh©n vµ chia cïng xuÊt hiÖn trong mét biÓu thøc, chóng ®−îc 

xö lý tõ ph¶i qua tr¸i theo thø tù xuÊt hiÖn. T−¬ng tù nh− vËy ®èi víi phÐp céng 

vµ trõ.  

PhÐp ghÐp x©u kh«ng thuéc nhãm to¸n tö sè häc nh−ng vÒ thø tù −u 

tiªn nã ®øng sau c¸c to¸n tö sè häc vµ tr−íc c¸c to¸n tö so s¸nh. To¸n tö Is lµ mét 

to¸n tö so s¸nh viÖc tham chiÕu Object. Nã kh«ng dïng ®Ó so s¸nh object hay 

gi¸  trÞ  cña  chóng,  nã  chØ  cho  biÕt  xem  hai  tham  chiÕu  object  (object 

references) cã lo¹i hay kh«ng.     

2.4 Các câu lệnh điều kiện trong VBScript.

2.4.1 Các câu lệnh điều kiện.

Khi viÕt ch−¬ng tr×nh, nhiÒu khi chóng ta mèn thùc hiÖn c¸c hµnh ®éng 

kh¸c nhau cho c¸c quyÕt ®Þnh kh¸c nhau. Chóng ta cã thÓ dïng c¸c c©u lÖnh 

®iÒu kiÖn ®Ó thùc hiÖn ®iÒu nµy. 

Trong VBScript cã 4 d¹ng c©u lÖnh ®iÒu kiÖn:  

 C©u lÖnh if – sö dông c©u lÖnh nµy nÕu chóng ta muèn thùc thi mét sè 

®o¹n m· khi ®iÒu kiÖn ®óng.



 C©u lÖnh if...then...else - sö dông c©u lÖnh nµy nÕu chóng ta muèn 

lùa chän mét trong hai tËp lÖnh ®Ó thùc thi.

 C©u lÖnh if...then...elseif - sö dông c©u lÖnh nµy nÕu chóng ta muèn 

lùa chän mét trong nhiÒu tËp lÖnh ®Ó thùc thi.

 C©u lÖnh select case - sö dông c©u lÖnh nµy nÕu chóng ta muèn lùa 

chän mét trong nhiÒu tËp lÖnh ®Ó thùc thi.

2.4.1.1 Câu lệnh If....Then.....Else

Chóng ta nªn sö dông c©u lÖnh If...Then...Else nÕu chóng ta muèn

 Thùc thi mét sè ®o¹n m· nÕu ®iÒu kiÖn ®óng.

 Lùa chän mét trong hai khèi lÖnh ®Ó thùc thi.

NÕu muèn thùc thi mét c©u lÖnh duy nhÊt khi mét ®iÒu kiÖn ®óng, 

chóng ta sÏ viÕt code trªn mét dßng:

   if i=10 Then msgbox "Hello"

Có ph¸p nµy kh«ng cã Else. Chóng ta chØ yªu cÇu thùc thi mét hµnh 

®éng nÕu ®iÒu kiÖn lµ ®óng (trong trêng hîp nµy if i=10).

NÕu muèn thùc hiÖn nhiÒu h¬n mét c©u lÖnh khi ®iÒu kiÖn ®−îc tho¶ 

m·n, chóng ta cÇn viÕt tõng c©u lÖnh trªn mét dßng lÖnh kh¸c nhau vµ kÕt 

thóc bëi tõ kho¸ “End If”.   

  if i=10 Then

      msgbox "Hello"

      i = i+1

  end If

Có ph¸p nµy còng kh«ng cã Else. Chóng ta yªu cÇu thùc thi nhiÒu hµnh 

®éng nÕu ®iÒu kiÖn ®óng.

NÕu chóng ta muèn thùc thi mét c©u lÖnh nÕu ®iÒu kiÖn ®óng vµ thùc 

thi mét c©u lÖnh kh¸c nÕu ®iÒu kiÖn sai, chóng ta ph¶i thªm tõ khãa “Else”:

if i=10 then



   msgbox "Hello"

else

   msgbox "Goodbye"

end If

Khèi m· ®Çu tiªn sÏ ®îc thùc thi nÕu ®iÒu kiÖn ®óng, vµ khèi thø hai dÏ 

®îc thùc thi nÕu ®iÒu kiÖn sai ( nÕu i kh«ng b»ng 10).

2.4.1.2  Câu lệnh If....Then.....Elseif

Chóng ta sö dông c©u lÖnh if...then...elseif nÕu chóng ta muèn lùa chän 

mét trong nhiÒu khèi lÖnh ®Ó thùc thi.

if payment="Cash" then

   msgbox "You are going to pay cash!"

 elseif payment="Visa" then

   msgbox "You are going to pay with visa."

 elseif payment="AmEx" then

   msgbox "You are going to pay with American Express."

 else

   msgbox "Unknown method of payment."

end If

2.4.1.3 Câu lệnh Select Case

Chóng ta còng cã thÓ sö dông c©u lÖnh SELECT nÕu chóng ta muèn 

lùa chän mét trong nhiÒu khèi lÖnh ®Ó thùc thi.

Có ph¸p:

Select Case biểu_thức_kiểm_tra

[Case danh_s¸ch_biểu_thức-n

[nhãm_lệnh-n]]...
[Case Else danh_s¸ch_biểu_thức-n

 [else nhãm_lệnh-n]]
End Select



Thµnh phÇn M« t¶

biÓu_thøc_kiÓm_tra BÊt kú biÓu thøc sè hoÆc chuçi

danh_s¸ch_biÓu_th
øc-n

Ph¶i  cã nÕu cã  Case.  Danh s¸ch cã giíi  h¹n 
cña mét hoÆc nhiÒu biÓu thøc.

nhãm_lÖnh-n Nhãm lÖnh sÏ  ch¹y nÕu  biÓu_thøc_kiÓm_tra 
trïng  víi  bÊt  kú  biÓu  thøc  nµo  trong 
danh_s¸ch_biÓu_thøc-n.

elsenhãm_lÖnh-n Nhãm lÖnh sÏ  ch¹y nÕu  biÓu_thøc_kiÓm_tra 
kh«ng trïng víi bÊt kú biÓu thøc nµo trong c¸c 
mÖnh Case.

Ví dụ

select case payment

 case "Cash"

   msgbox "You are going to pay cash"

 case "Visa"

   msgbox "You are going to pay with visa"

 case "AmEx"

   msgbox "You are going to pay with American Express"

 case Else

   msgbox "Unknown method of payment"

end select

C©u lÖnh nµy lµm viÖc nh− sau: §Çu tiªn chóng ta cã mét biÓu thøc 

(th−êng lµ mét biÕn), ®îc ®¸nh gi¸ mét lÇn. Gi¸ trÞ cña biÓu thøc nµy ®−îc so 

s¸nh víi tõng gi¸ trÞ trong cÊu tróc Case. NÕu chóng b»ng nhau, tËp hîp c¸c 

lÖnh t−¬ng øng víi gi¸ trÞ Case ®ã ®−îc thùc thi.

2.4 Vòng lặp trong VBScript.

Khi chóng ta viÕt code, chóng ta muèn cho phÐp cïng mét khèi lÖnh 

ch¹y mét sè lÇn. Chóng ta cã thÓ sö dông cÊu tróc lÆp trong code cña chóng  

ta ®Ó lµm ®iÒu nµy.

Trong VBScript chóng ta cã bèn vßng lÆp:

 Vßng lÆp  For...Next - LÆp 1 khèi lÖnh trong khi ®iÒu kiÖn ®óng(True) 

hoÆc cho ®Õn khi ®iÒu kiÖn cßn ®óng. 



 Vßng lÆp For Each...Next - Lặp 1 nhóm lệnh cho từng thành phần của 

1 mảng hay tập hợp. 

 Vßng lÆp Do...Loop - LÆp 1 khèi lÖnh trong khi ®iÒu kiÖn ®óng(True) 

hoÆc cho ®Õn khi ®iÒu kiÖn cßn ®óng. 

 Vßng lÆp While...Wend -  Thùc hiÖn mét d·y lÖnh  trong khi ®iÒu kiÖn lµ 

True. 

2.4.1 Vòng lặp For...Next 

Chóng ta sö dông c©u lÖnh For...Next ®Ó ch¹y mét khèi lÖnh, khi chóng 

ta biÕt cã bao nhiªu lÇn thùc hiÖn l¹i khèi lÖnh ®ã.

Có ph¸p tæng qu¸t:

For biến_đếm = bắt_đầu To kết_thóc [Step bước_nh¶y]

[nhãm_lệnh]

[Exit For]

[nhãm_lệnh]

Next

Thµnh 
phÇn

M« t¶

biÕn_®Õm BiÕn kiÓu sè  dïng nh bé ®Õm lÆp.  Kh«ng ®îc  dïng 
biÕn kiÓu m¶ng.

b¾t_®Çu Gi¸ ban ®Çu cña biÕn ®Õm.

kÕt_thóc Gi¸ trÞ cuèi cïng cña biÕn ®Õm.

bíc_nh¶y Sè lîng t¨ng thªm cña biÕn ®Õm sau mçi lÇn lÆp.NÕu 
kh«ng chØ ®Þnh th× bíc nh¶y lµ 1.

nhãm_lÖn
h

1 hoÆc nhiÒu c©u lÖnh mµ For vµ  Next sÏ thùc hiÖn 
theo sè lÇn lÆp ®· chØ ®Þnh.

Chóng ta sö dông mét biÕn ®Õm ®Ó t¨ng hoÆc gi¶m sau mçi lÇn thùc 

hiÖn vßng lÆp, gièng nh thÕ nµy:

For i=1 to 10

   some code

 Next

2.4.1.1 Từ khóa Step



Sö dông tõ khãa  Step khi chóng ta muèn t¨ng hoÆc gi¶m biÕn ®Õm 

b»ng gi¸ trÞ mµ chóng ta ®· x¸c ®Þnh.

Trong vÝ dô sau, biÕn ®Õm (i) ®îc t¨ng 2 sau mçi lÇn lÆp.

 For i=2 To 10 Step 2

   some code

 Next

§Ó gi¶m biÕn ®Õm, chóng ta ph¶i sö dông mét gi¸ trÞ cña Step lµ ©m. 

Chóng ta sÏ chØ ra mét gi¸ trÞ kÕt thóc nghÜa lµ gi¸ trÞ thÊp ¬n gi¸ trÞ ban 

®Çu.

Trong vÝ dô sau, biÕn ®Õm (i) ®îc gi¶m 2 sau mçi lÇn lÆp.

 For i=10 To 2 Step -2

   some code

 Next

2.4.1.2 Exit a For...Next

Chóng ta cã thÓ tho¸t khái c©u lÖnh For...Next víi tõ khãa Exit For.

2.4.1.3  Vòng lặp For Each...Next 

 M« t¶: LÆp 1 nhãm lÖnh cho tõng thµnh phÇn cña 1 m¶ng hay tËp hîp. 

 Có ph¸p

For Each thµnh_phÇn In nhãm

           [nhãm_lÖnh]
    [Exit For]

           [nhãm_lÖnh]
Next [thµnh_phÇn]

Thµnh phÇn M« t¶

thµnh_phÇn BiÕn  dïng  ®Ó  lÆp  víi  tÊt  c¶  c¸c  thµnh  phÇn  cña  tËp 

hîn(collection)  hoÆc  array.  ®èi  víi  collections,  thµnh_phÇn 

chØ cã thÓ lµ biÕn Variant, 1 lo¹i biÕn Object, or bÊt kú biÕn 

Automation object. ®èi víi arrays, thµnh_phÇn chØ cã thÓ lµ 

biÕn Variant.

nhãm Tªn cña tËp hîp object hoÆc array.



nhãm_lÖnh 1 hoÆc nhiÒu lÖnh ®îc thùc hiÖn lÆp theo tõng môc (item) 

trong nhãm.

 Ví d : ụ

dim cars(2)

cars(0)="Volvo"

cars(1)="Saab"

cars(2)="BMW"

For Each x in cars

     document.write(x & "<br />")

   Next

2.4.2 Vòng lặp Do...Loop

Chóng ta cã thÓ sö c©u lÖnh  Do...Loop ®Ó ch¹y mét khèi lÖnh khi chóng 

ta kh«ng biÕt bao nhiªu lÇn lÆp. C¸c khèi m· ®îc lÆp ®i lÆp l¹i khi mét ®iÒu 

kiÖn lµ ®óng hay cho ®Õn khi trë thµnh mét ®iÒu kiÖn ®óng sù thËt.

 Cú pháp:

Do [{While | Until} điều_kiện]

    [khối_lệnh]

    [Exit Do]

    [khối_lệnh]

Loop 

 Ho c, chúng ta có th  dùng cú pháp: ặ ể

Do
    [khối_lệnh]

 [Exit Do]

    [khối_lệnh]

Loop [{While | Until} điều_kiện]

Thành phần Mô tả

điều_kiện Biểu  thức  số(numeric)  hoặc  chuỗi(string)  đúng(True) 

hoặc sai(False). Nếu  điều kiện là  Null(không có giá trị 



hợp lệ), điều kiện được xem như False.

khối_lệnh 1  hoặc nhiều lệnh  được  lặp trong  khi  điều kiện  đứng 

hoặc đến khi điều kiện đúng.

 L  u ý  

 LÖnh  Exit  Do chØ  cã  thÓ  dïng  trong  cÊu  tróc  ®iÒu  khiÓn 

Do...Loop ®Ó chuyÓn híng tho¸t khái  Do...Loop. LÖnh  Exit Do 

®Æt mäi n¬i trong Do...Loop vµ sè lîng lÖnh bÊt kú. Thêng dïng 

®Ó  ®Þnh  lîng  mét  vµi  ®iÒu  kiÖn  (vÝ  dô,  If...Then),  Exit  Do 

chuyÓn ®iÒu khiÓn tøc th× cho c¸c lÖnh ®i ngay sau Loop. 

 Khi dïng trong nhiÒu Do...Loop lång nhau, Exit Do chuyÓn ®iÒu 

khiÓn ®Ó lÆp Do..Loop lång trªn nã 1 cÊp. 

 VÝ dô:

Do Until DefResp = vbNo

   MyNum = Int (6 * Rnd + 1) ' K t sinh ng u nhiên 1 s  nguyên   gi aế ẫ ố ở ữ  
1   và   6.
   DefResp = MsgBox (MyNum & " Do you want  another  number?", 
vbYesNo)
Loop 
Dim Check, Counter

Check = True: Counter = 0 ' Kh i t o bi n.ở ạ ế

Do ' loop ngoài.

  Do While Counter < 20 ' loop trong.

     Counter = Counter + 1 ' tăng bi n đ m.ế ế

     If Counter = 10 Then ' If đi u ki n=True...ề ệ

     Check = False ' set giá tr  flag=False.ị



  Exit Do ' Thoát loop trong.

     End If

 Loo

Loop Until Check = False

2.4.3 Vòng lặp While...Wend 

Thùc hiÖn mét d·y lÖnh  trong khi ®iÒu kiÖn lµ True. 

 Có ph¸p:

While điều_kiện

[nhãm_lệnh]

Wend

Thành 
ph nầ

Mô tả

đi u_ki nề ệ 1 bi u th c s  ho c chu i đ nh giá  ể ứ ố ặ ỗ ị True  ho c  ặ False. N uế  
đi u_ki nề ệ  là Null, đi u_ki nề ệ   xem nh  ư False.

nhóm_l nhệ Nhóm l nh đ c th c hi n khi đi u ki n là ệ ượ ự ệ ề ệ True.

 Ví dụ
Dim Counter

Counter = 0                ' Khởi tạo biến.

While Counter < 20         ' Test giá trị Counter.

Counter = Counter + 1   ' Tăng Counter.

Alert Counter

Wend      'Kết thóc lặp While khi  Counter > 19.

2.4.4 Một số hàm thông dụng trong VBScript.

2.4.4.1 Hàm Abs(number).

 M« t¶:  tr¶ vÒ trÞ tuyÖt ®èi cña number

 Có ph¸p:

Abs(number)

 VÝ dô:

Dim MyNumber

MyNumber = Abs(50.3)  ' Tr¶ vÒ 50.3.



MyNumber = Abs(-50.3) ' Tr¶ vÒ 50.3.

2.4.4.2 Hàm CreateObject.

 M« t¶: Khëi t¹o mét ®èi tîng.

 Có ph¸p: 

CreateObject (servername.typename [, location])

 
 

 

 VÝ dô:

'T¹o 1 connection:

Set Conn = Server.CreateObject("ADODB.Connection")     

‘Më Excel trong ®èi tîng Application.

ExcelSheet.Application.Visible = True          

' §a text vµo « ®Çu tiªn cña sheet.

ExcelSheet.ActiveSheet.Cells(1,1).Value = "This is column A, row 1" 

ExcelSheet.SaveAs "C:\DOCS\TEST.XLS"         ' Lu sheet.

'§ãng Excel b»ng ph¬ng thøc Quittrªn Application object.

ExcelSheet.Application.Quit       

Set ExcelSheet = Nothing        ' Gi¶i phãng biÕn ®èi tîng.

2.4.4.3 Hàm CStr 

 Mô t :ả  chuy n bi u th c (ể ể ứ expression) số sang chu i.ỗ
 Cú pháp:

CStr(expression):

Thµnh 

phÇn

M« t¶

servername Ph¶i cã. Tªn cña øng dông.

typename Ph¶i cã. KiÓu cña líp hay ®èi tîng ®îc t¹o.

location Tïy chän. Tªn cña network server n¬i ®èi tîng ®ùoc t¹o.



 Ví d :ụ
Dim MyDouble, MyString

MyDouble = 437.324         ' MyDouble là s  th c.ố ự

MyString  =  CStr(MyDouble)    '  MyString  ch a  "437.324"  là  m tứ ộ  
chu i.ỗ

2.4.4.4 hàm Date. 

 Mô t :ả  tr  v  ngày hi n t i.ả ề ệ ạ  
 Ví dụ

Dim MyDate

MyDate = Date    ' MyDate ch a ngày hi n t iứ ệ ạ

2.4.4.5 Hàm DateValue. 

 Mô t : ả tr  v  ngày t  chu i d ng ngàyả ề ừ ỗ ạ
 Cú pháp:

DateValue(strdate):
 Ví d :ụ

Dim MyDate

MyDate = DateValue("September 11, 1963")    ' Tr  v  1 date.ả ề

2.4.4.6 Hàm LBound

 Mô tả: Trả về cỡ chiều nhỏ nhất của mảng. 

 Cú pháp

LBound(arrayname[, dimension]) 

Thành phần Mô tả

arrayname Tên biến mảng

dimension Số thứ tự của chiều được mô tả trong mảng. Dùng 1 
cho chiều thứ nhất, 2 cho chiều thứ hai,... Nếu 
dimension  bỏ qua, mặc nhiên là 1.



2.4.4.7 Hàm UBound

 Mô tả: Trả về cỡ chiều lớn nhất của mảng. 

 Cú pháp 

UBound(arrayname[, dimension])

 Ví dụ

Dim A(100,3,4)

 

 

 

 

2.4.4.8 Hàm LCase. 

 Mô tả: Chuyển chuỗi (string) sang chữ thường.

 Cú pháp:

LCase(string)

 Ví dụ:

     Dim MyString 

     Dim LCaseString 

Thành 
ph nầ

Mô tả

arrayname Tên bi n m ngế ả

dimension S  th  t  c a chi u đ c mô t  trong m ng. Dùng 1 cho chi u ố ứ ự ủ ề ượ ả ả ề
th  nh t, 2 cho chi u th  hai,... N u ứ ấ ề ứ ế dimension  b  qua, m c nhiênỏ ặ  
là 1.

L nhệ Giá tr  tr  vị ả ề

UBound(A, 1) 100

UBound(A, 2) 3

UBound(A, 3) 4



     MyString = "VBSCript" 

     LCaseString = LCase(MyString) ' LCaseString ch a "vbscript"ứ

2.4.4.9 Hàm UCase.

 Mô tả: Chuy n chu i (string) sang ch  hoaể ỗ ữ .

 Cú pháp:

UCase(string)

 Ví d :ụ

     Dim MyString 

     Dim UCaseString 

     MyString = "VBSCript" 

      UCaseString   =  UCase(MyString)                '   UCaseString   ch aứ  
"VBSCRIPT"

2.4.4.10 Hàm Len

 Mô tả: Tr  v  đ  s  l ng ký t  ch a trong chu i ho c bi nả ề ộ ố ượ ự ứ ỗ ặ ế .
 Cú pháp:

Len(String|Varname)
 Ví d :ụ

Dim MyString
MyString = Len("VBSCRIPT")             ' MyString ch a 8.ứ

2.4.4.11 Hàm LTrim, RTrim, Trim

LTrim(String): tr  v  chu i String nh ng đã c t b  các kho ng tr ng tr c(bên trái)ả ề ỗ ư ắ ỏ ả ắ ướ  
chu iỗ
RTrim(String): tr  v  chu i String nh ng đã c t b  các kho ng tr ng sau(bên ph i)ả ề ỗ ư ắ ỏ ả ắ ả  
chu iỗ
Trim(String): tr  v  chu i String nh ng đã c t b  các kho ng tr ng tr c và sau(tráiả ề ỗ ư ắ ỏ ả ắ ướ  
& ph i) chu iả ỗ
 Ví d :ụ

Dim MyVar
MyVar = LTrim("  vbscript ")   ' MyVar ch a "vbscript ".ứ
MyVar = RTrim("  vbscript ")   ' MyVar ch a "  vbscript".ứ
MyVar = Trim("  vbscript ")    ' MyVar ch a "vbscript".ứ

2.4.4.12 Hàm Mid, Left, Right

 Mid(string, start[, length]): 
­ Tr  v  chu i c t ra length ký t   t  chu i string b t đ u t  v  trí start. ả ề ỗ ắ ự ừ ỗ ắ ầ ừ ị
­ N u length không ch  ra thì l y đ n cu i chu i.ế ỉ ấ ế ố ỗ



 Left(String, Length): 

­ Trả về Length ký tự bên trái của String

 Right(String, Length): 
­ Tr  v  Length ký t  bên ph ii c a Stringả ề ự ả ủ

 Ví d :ụ
Dim MyVar
MyVar = Mid("VB Script is fun!", 4, 6) 'MyVar ch a "Script".ứ
Dim MyString, LeftString
MyString = "VBSCript"
LeftString = Left(MyString, 3)  ' LeftString ch a "VBS".ứ
Dim MyString, RightString
MyString = "VBSCript"
RightString = Right(MyString, 6)  ' LeftString ch a "SCript".ứ

2.4.4.13 Hàm Now

 Mô tả: Tr  v  ngày và gi  hi n t iả ề ờ ệ ạ
 Ví dụ:

Dim MyVar

MyVar = Now  ' MyVar ch a ngày và gi  hi n t i. ứ ờ ệ ạ

2.4.4.14 Hàm Space

 Mô tả: Tr  v  1 chu i có Number ký t  tr ngả ề ỗ ự ắ
 Cú pháp:

Space(Number)

 Ví dụ:

Dim MyString

MyString = Space(10)                     ' Trả về 1 chuỗi có 10 khoảng trắng.

MyString = "Hello" & Space(10) & "World" ' Chèn 10 khoảng trắng giữa 1 chuỗi.

2.4.4.15 Hàm Time: 

 Môt t : ả Tr  v  gi  hi n t i.ả ề ờ ệ ạ
 Ví d :ụ

Dim MyTime
MyTime   =  Time        '   Tr   v   gi   hi n   t i.  ả ề ờ ệ ạ

2.4.4.16 Hàm TimeValue(Time): 

 Mô t : ả Tr  v  gi  t  chu i gi  Timeả ề ờ ừ ỗ ờ
 Cú pháp: 

TimeValue(Time):



 Ví d :ụ
Dim MyTime
MyTime = TimeValue("4:35:17 PM") ' MyTime ch a 4:35:17 PM.ứ

2.4.4.17 Hàm MsgBox

 Mô tả: Hi n th  h p tho i thông báo, ch  ng i s  d ng click 1 nút và tr  v  ể ị ộ ạ ờ ườ ử ụ ả ề
1 giá tr . ị

 Cú pháp

MsgBox(prompt[, ][, title][, helpfile, context]) 

 

 

 

 

  

 Thiết lập

Các đ i số ố   thi t l p: ế ậ

Thành phần Mô tả

prompt Biểu thức chuỗi dài tối đa 1024 ký tự

 1 số chỉ định kiểu nút.

title Chuỗi tiêu đề

helpfile Chỉ định file help

context Biểu thức số chỉ định ngữ cảnh help.



H ngằ Giá trị Mô tả

vbOKOnly    0 Ch  hi n nút ỉ ệ OK.

vbOKCancel    1 Hi n ệ OK và  Cancel.

vbAbortRetryIgnore    2 Hi n ệ Abort, Retry, và  Ignore.

vbYesNoCancel    3 Hi n ệ Yes, No, và  Cancel.

vbYesNo    4 Hi n ệ Yes và  No.

vbRetryCancel    5 Hi n ệ Retry và  Cancel.

vbCritical   16 Hi n ệ Critical Message icon.

vbQuestion   32 Hi n ệ Warning Query icon.

vbExclamation   48 Hi n ệ Warning Message icon.

vbInformation   64 Hi n ệ Information Message icon.

vbDefaultButton1    0 Giá tr  th  1 m c nhiên.ị ứ ặ

vbDefaultButton2  256 Giá tr  th  2 m c nhiên.ị ứ ặ

vbDefaultButton3  512 Giá tr  th  3 m c nhiên.ị ứ ặ

vbDefaultButton4  768 Giá tr  th  4 m c nhiên.ị ứ ặ

vbApplicationModal    0 Các th c Applicationứ

vbSystemModal 4096 Cách th c System.ứ

 Giá trị trả về

Hàm MsgBox tr  v  các giá tr  sau: ả ề ị

H ngằ Giá 
trị

Nút

vbOK 1 OK

vbCancel 2 Cancel

vbAbort 3 Abort

vbRetry 4 Retry

vbIgnore 5 Ignore



vbYes 6 Yes

vbNo 7 No

 Ví d :ụ
Dim MyVar

MyVar = MsgBox ("Hello World!", 65, "MsgBox Example") 

' MyVar ch a 1 ho c 2,  ' tùy thu c nút nào đ c click ứ ặ ộ ượ



2. Thiết lập các thư viện procedure, function 
cho 1 ứng dụng WEB

Cã hai lo¹i ch¬ng tr×nh con trong VBScript: Thñ tôc vµ Hµm

3.1 Thủ tục trong VBScript

­ Lµ mét d·y c¸c c©u lÖnh, ®îc b¾t ®Çu bëi tõ khãa Sub vµ kÕt thóc bëi tõ 

khãa End Sub.

­ Cã thÓ thùc thi c¸c hµnh ®éng, nhng kh«ng tr¶ vÒ mét gi¸ trÞ.

­ Cã thÓ cã tham sè hoÆc kh«ng cã tham sè.

 Có ph¸p:

  [Public [Default] | Private] Sub tªn_sub [(danh_s¸ch_đối_số)]

[nhãm_lệnh]

  [Exit Sub]

[nhãm_lệnh]

  End Sub 

VÝ dô:

<html>
     <head>

<script type="text/vbscript">
sub mySub()

  msgbox("§©y lµ mét thñ tôc")
end sub

</script>
     </head>
     <body>

<script type="text/vbscript">
call mySub()

</script>
<p>Thñ tôc kh«ng tr¶ vÒ mét kÕt qu¶.</p>
</body>

</html>

3.2 Hàm trong VBScript.

­ Lµ mét d·y c¸c c©u lÖnh, b¾t ®Çu bëi  Function vµ kÕt thóc lµ End 

Function.



­ Cã thÓ thùc hiÖn c¸c hµnh ®éng vµ cã thÓ tr¶ vÒ mét gi¸ trÞ.

­ Cã thÓ cã tham sè hoÆc kh«ng cã tham sè.

­ Cã thÓ tr¶ vÒ mét gi¸ trÞ b»ng c¸ch g¸n mét gi¸ trÞ cho tªn hµm.

 Cú pháp
[Public [Default]|Private] Function tªn_hµm[(danh_s¸ch_đối_số)]

[nhãm_lệnh]
     [tªn_hµm = biểu_thức]

[Exit Function]

[nhãm_lệnh]
     [tªn_hµm = biểu_thức]

End Function 

Thµnh phÇn M« t¶

Public X¸c  ®Þnh  Function cã  thÓ  dïng  trong  c¸c 

procedures scripts kh¸c.

Default ChØ dïng víi tõ kho¸  Public trßn 1 khèi líp(Class) 

®Ó chØ ®Þnh Function procedure lµ ph¬ng thøc 

mÆc  nhiªn cho líp. Lçi xÉy ra khi cã h¬n 1 thñ tôc 

Default chØ ®Þnh trßn 1 líp.

Private ChØ  ®Þnh  r»ng  Function chØ  ®îc  dïng  trong 

nh÷ng thñ tôc trong script  n¬i  nã khai  b¸o hoÆc 

nÕu function lµ 1 thµnh viªn cña class.

tªn_hµm Tªn cña Function

danh_s¸ch_®èi_

sè

Danh  s¸ch  biÕn  g¸n  vµo  gi¸  trÞ  t¬ng  øng  khi 

Function  ®îc  gäi.  C¸c  biÕn  c¸ch  nhau b»ng c¸c 

dÊu phÈy(,).

nhãm_lÖnh Nhãm  lÖnh  bÊt  kú  ®îc  thùc  hiÖn  trong  th©n 

function. 

biÓu_thøc Tr¶ vÒ gi¸ trÞ cña hµm Function.

 Danh_s¸ch_đối_số cã có ph¸p và c¸c thành phần sau đ©y: 

 [ByVal | ByRef] tªn_biến[( )]  

Thµnh phÇn M« t¶

ByVal ChØ ®Þnh ®èi sè ®îc truyÒn b»ng gi¸ trÞ(value). #èi sè 



kh«ng thay ®æi gi¸ trÞ sau khi kÕt thóc hµm.

ByRef ChØ  ®Þnh  ®èi  sè  ®îc  truyÒn  b»ng  tham 

kh¶o(reference).#èi sè bÞ thay ®æi gi¸ trÞ sau khi kÕt thóc 

hµm nÕu trong hµm cã lÖnh thay ®æi gi¸ trÞ ®èi sè.

tªn_biÕn Tªn biÕn nhËn gi¸ trÞ truyÒn vµo khi gäi hµm. BiÕn nhËn 

vµ gi¸ trÞ truyÒn ph¶i t¬ng øng tõ biÕn ®Çu tiªn ®Õn biÕn 

cuèi cïng.

 Ví dụ

Function BinarySearch(...)

      ... 

' Value not found. Return a value of False.

      If lower > upper Then

           BinarySearch = False  

Exit Function

      End If

      ... 

End Function

3.2.1 Gọi hàm hoặc thủ tục.

Khi b¹n gäi mét hµm trong m· lÖnh cña b¹n, b¹n cã thÓ viÕt code gièng nh thÕ 
nµy:

 name = findname()

ý nghÜa cña c©u lÖnh trªn lµ chóng ta gäi mét hµm cã tªn lµ “findname”, 

hµm tr¶ vÒ mét gi¸ trÞ nªn sÏ ®îc lu tr÷ trong biÕn “name”.

HoÆc, chóng cã thÓ viÕt code gièng nh thÕ nµy:

msgbox "Tªn cña b¹n lµ:  " & findname()

§o¹n m· trªn còng gäi mét hµm cã tªn lµ “findname”, hµm tr¶ vÒ mét gi¸ 

trÞ vµ nã sÏ ®îc hiÓn thÞ trong hép th«ng b¸o (message box).

Khi chóng ta gäi mét thñ tôc, b¹n cã thÓ sö dông tõ khãa Call, gièng nh
thÕ nµy:



Call MyProc(tham sè)

HoÆc b¹n cã thÓ bá qua c©u lÖnh Call, gièng nh thÕ nµy:

MyProc argument

3. M t s  bài t p  ng d ng m uộ ố ậ ứ ụ ẫ

3.1 T¹o mét biÕn cã gi¸ trÞ lµ “Jan Egil” sau ®ã hiÓn thÞ gi¸ trÞ ®ã lªn mµn  

h×nh.

<html>

  <body>

    <script type="text/vbscript">

      dim name

      name="Jan Egil"

      document.write(name)

    </script>

  </body>

</html>

3.2 T¹o mét biÕn cã gi¸ trÞ lµ “Jan Egil” sau ®ã chÌn gi¸ trÞ cña biÕn ®ã  

vµo v¨n b¶n ®Ó hiÓn thÞ  lªn mµn h×nh dßng ch÷ “My name is: Jan Egil”.

<html>

  <body>

    <script type="text/vbscript">

      dim name

      name="Jan Egil"

      document.write("My name is: " & name)   
</script>

  </body>

</html>

3.3 T¹o mét biÕn m¶ng gåm 6 gi¸ trÞ sau ®ã hiÓn thÞ c¸c gi¸ trÞ ®ã lªn 
mµn h×nh.

<html>

   <body>

<script type="text/vbscript">

dim famname(5)

famname(0)="Jan Egil"

famname(1)="Tove"



famname(2)="Hege"

famname(3)="Stale"

famname(4)="Kai Jim"

famname(5)="Borge"

for i=0 to 5

  document.write(famname(i) & "<br />")

next

</script>

   </body>

</html>

3.4 T¹o mét thñ tôc t¹i phÇn head ®Ó hiÓn thÞ ra dßng th«ng b¸o “§©y lµ 
mét thñ tôc” sau ®ã gäi thñ tôc trong phÇn body ®Ó hiÓn thÞ ra mµn 
h×nh.

<html>
   <head>

<script type="text/vbscript">
  sub mySub()

  msgbox("§©y lµ mét thñ tôc")
  end sub
</script>

   </head>
   <body>

<script type="text/vbscript">
   call mySub()
</script>
<p>Thñ tôc kh«ng tr¶ vÒ kÕt qu¶.</p>

  </body>
</html>

3.5 T¹o mét hµm t¹i phÇn head sau ®ã g¸n gi¸ trÞ cho hµm ®ã lµ “BLUE” 
sau ®ã chÌn hµm ®ã vµo v¨n b¶n t¹i phÇn body ®Ó hiÓn thÞ ra dßng ch÷ 
“Mµu yªu thÝch cña t«i lµ: BLUE”

<html>

  <head>

     <script type="text/vbscript">

        function myFunction()

 myFunction = "BLUE"

        end function

     </script>

  </head>

  <body>



     <script type="text/vbscript">

        document.write("Mµu yªu thÝch cña t«i lµ: " & 

                       myFunction())

     </script>

<p>Hµm cã thÓ tr¶ vÒ mét kÕt qu¶.</p>

  </body>

</html>

3.6 ViÕt mét hµm lÊy giê hiÖn t¹i. NÕu giê < 10 th× hiÖn ra dßng ch÷ 
“Chµo buæi s¸ng” nÕu giê kh«ng < 10 th× hiÖn ra dßng ch÷ “Chóc mét 
ngµy tèt lµnh”.

<html>

   <head>

<script type="text/vbscript">

   function greeting()

    i=hour(time)

    if i < 10 then

  document.write("Good morning!")

    else

 document.write("Have a nice day!")

    end if

            end function

</script>

  </head>

  <body onload="greeting()">

  </body>

3.7 ViÕt mét hµm lÊy giê hiÖn t¹i vµ thùc hiÖn c¸c yªu cÇu: NÕu giê = 8 
th× hiÖn ra dßng th«ng b¸o “B¾t ®Çu lµm viÖc!”, NÕu giê = 11 th× hiÖn 
ra dßng th«ng b¸o “§ãi!”, nÕu giê = 12 th× hiÖn ra dßng th«ng b¸o “A, ¨n 
tra!”, nÕu giê = 17 th× hiÖn ra dßng th«ng b¸o “VÒ nhµ th«i!”, nÕu ngoµi 
c¸c giê trªn th× hiÖn ra th«ng b¸o “Ch¼ng biÕt lµm g×!”.

<html>

  <head>

<script type="text/vbscript">

  function greeting()



    i=hour(time)

      If i = 8 then

   document.write("b¾t ®Çu lµm viÖc!")

 elseif i = 11 then

   document.write("§ãi!")

      elseif i = 12 then

   document.write("A, ¨n tra!")

      elseif i = 15 then

   document.write("VÒ nhµ th«i!")

 else

   document.write("Ch¼ng biÕt lµm g×")

 end if

end function

 </script>

</head>

    <body onload="greeting()">

    </body>

    </html>
3.8 Dïng vßng lÆp For hiÓn thÞ mét d·y sè tõ 0 -> 10 lªn mµn h×nh.

<html>
   <body>

<script type="text/vbscript">
               for i = 0 to 10

 document.write("The number is " & i & "<br />")
   next
</script>

     </body>
       </html>

3.9 Dïng vßng lÆp For hiÓn thi ra 6 dßng ch÷ “§©y lµ mét tiªu ®Ò” theo 
thø tù gi¶m dÇn vÒ kÝch thíc.

<html>

  <body>

    <script type="text/vbscript">

for i=1 to 6

   document.write("<h" & i & ">This is header "

                    & i & "</h" & i & ">")

next

    </script>



 </body>

    </html>
3.10 Dïng vßng lÆp Do...While ®Ó hiÓn thÞ ra mµn h×nh c¸c gi¸ trÞ khi 
®iÒu kiÖn cßn ®óng.

<html>

   <body>

<script type="text/vbscript">

   i=0

   do while i < 10

   document.write(i & "<br />")

 i=i+1

   loop

</script>

   </body>

</html>

4. Bài t p cu i ch ngậ ố ươ
1) Sö dông ng«n ng÷ VBSCRIPT ®Ó viÕt ch¬ng tr×nh theo yªu cÇu sau: 

X©y dùng mét hµm tÝnh An Víi (A , N lµ 2 sè tù nhiªn ) A,N lµ 2 tham sè ®îc 

truyÒn cho hµm

2) Sö dông ng«n ng÷ VBSCRIPT ®Ó viÕt ch¬ng tr×nh theo yªu cÇu sau: 

X©y dùng mét hµm kiÓm tra mét x©u S truyÒn vµo, nÕu x©u S kh«ng cã ký 

tù @ hoÆc nhiÒu h¬n 1 ký tù @ th× th«ng b¸o ra mµn h×nh b»ng lÖnh msg 

“§©y kh«ng ph¶i lµ Email hîp lÖ”

3) Sö dông ng«n ng÷ VBSCRIPT ®Ó viÕt ch¬ng tr×nh theo yªu cÇu sau: 

X©y dùng hµm cã tªn ISMAIL cã 1 tham sè ®Çu vµo d÷ liÖu d¹ng TEXT.  

Hµm nµy kiÓm tra xem tham sè truyÒn vµo cã ph¶i lµ 1 Email hay kh«ng , 

nÕu ®óng lµ Email th× tr¶ vÒ true vµ ngîc l¹i

 Email b¾t buéc chØ cã 1 ký tù @ duy nhÊt.

 B¾t ®Çu vµ kÕt thóc cña Email  kh«ng cã c¸c ký tù (  @ hoÆc dÊu 

chÊm .) VD: .admin@vn.vn hoÆc @admin.vn hoÆc admin@.vn.  HoÆc 

admin@

mailto:admin@.vn
mailto:.admin@vn.vn


4) Sö dông ng«n ng÷ VBSCRIPT ®Ó viÕt ch¬ng tr×nh theo yªu cÇu sau: 

X©y dùng hµm cã tªn EqualMail cã 2 tham sè ®Çu vµo lµ 2 Email. Hµm nµy 

tr¶ vÒ gi¸ trÞ ®óng nÕu 2 tham sè gièng nhau (kh«ng ph©n biÖt ch÷ hoa, 

ch÷ thêng) vµ ngîc l¹i.

5) Sö dông ng«n ng÷ VBSCRIPT ®Ó viÕt ch¬ng tr×nh theo yªu cÇu sau: 

X©y dùng hµm cã tªn CheckNum() cã 1 tham sè ®Çu vµo.Hµm nµy kiÓm 

tra xem tham sè truyÒn vµo cã ph¶i lµ mét sè ®iÖn tho¹i kh«ng ?

 Sè ®iÖn tho¹i kh«ng ®îc cã x©u ký tù,nÕu cã x©u ký tù th× xãa ký tù ®ã 

®i.

 Sè ®iÖn tho¹i kh«ng dµi qu¸ 12 sè

6) Sö dông ng«n ng÷ VBSCRIPT ®Ó viÕt ch¬ng tr×nh theo yªu cÇu sau: 

X©y dùng hµm cã tªn Viewdate().  Hµm nµy cã gi¸ trÞ tr¶ vÒ lµ ngµy th¸ng 

theo có ph¸p (Ngµy … Th¸ng … N¨m …) VÝ dô : Ngµy 20 th¸ng 4 n¨m 2009



Chương 5 

Liên kết trang Web đến hệ CSDL – xây dựng 
các trang Web động cơ bản

Ch¬ng nµy nh¾c l¹i mét sè kh¸i niÖn c¬ b¶n vÒ c¬ së d÷ liÖu, c¸c c©u 

lÖnh truy vÊn c¬ b¶n SQL. C¸c trang web chóng ta t¹o ra trong ch¬ng 2 vµ ch-

¬ng 3 lµ nh÷ng trang web tÜnh (Nh÷ng trang web mµ ngêi dïng kh«ng thÓ thay 

®æi ®îc néi dung cña nã). Trong ch¬ng 4 chóng ta ®· ®· t¹o ra ®îc mét trang 

web ®éng nhng ®ã lµ mét trang web ®éng phÝa client. Chóng ta cã thÓ thay 

®æi néi dung cña chóng nhng chØ trong mét ph¹m vi rÊt hÑp nh gi¶i ph¬ng 

tr×nh bËc 2, kiÓm tra tÝnh hîp lÖ cña email, th«ng tin ngêi dïng... Tuy nhiªn nã 

còng kh«ng h¬n g× nhiÒu so víi mét trang web tÜnh. Ch¬ng nµy sÏ giíi thiÖu 

cho chóng ta vÒ c¸ch thøc ®Ó t¹o ra mét trang web ®éng phÝa server. Chóng 

ta sÏ t×m hiÓu vÒ ng«n ng÷ ASP (Chi tiÕt vÒ ng«n ng÷ ASP chóng ta sÏ ®îc 

t×m hiÓu kü h¬n trong m«n “LËp tr×nh web 1”), mét trong sè c¸c ng«n ng÷ ®îc 

sö dông ®Ó t¹o ra c¸c trang web ®éng phÝa server. Chóng ta sÏ t¹o ra mét trang 

web ®éng c¬ b¶n cã kÕt nèi c¬ së d÷ liÖu.

Môc tiªu

Sau khi häc xong ch¬ng nµy, chóng ta sÏ:

1. VËn dông ®îc c¸c c©u lÖnh truy vÊn SQL.

2. Ph©n tÝch ®îc có ph¸p c¬ b¶n cña c©u lÖnh ASP.

3. BiÕt c¸ch lu l¹i vµ hiÓn thÞ mét trang ASP.

4. Tr×nh bµy ®îc c¸c bíc ®Ó t¹o mét kÕt nèi CSDL trong ASP.

5. T¹o ra ®îc mét trang web ®éng b»n ASP cã kÕt nèi CSDL.



1. Nh c l i m t s  khái ni m v  CSDLắ ạ ộ ố ệ ề

1.1 Các khái niệm cơ bản

1.1.1 Cơ sở dữ liệu

C¬ së d÷ liÖu lµ mét tËp hîp c¸c d÷ liÖu cã liªn quan víi nhau chøa th«ng 

tin vÒ mét tæ chøc nµo ®ã (Nh mét trêng ®¹i häc, mét ng©n hµng, mét c«ng ty, 

mét nhµ m¸y,...), ®îc lu tr÷ trªn c¸c thiÕt bÞ nhí thø cÊp (Nh b¨ng tõ, ®Üa tõ,...) 

®Ó ®¸p øng nhu cÇu khai th¸c th«ng tin cña nhiÒu ngêi sö dông víi nhiÒu môc 

®Ých kh¸c nhau

1.1.2 Siêu khóa.

Siªu khãa cña lîc ®å quan hÖ R lµ mét tËp hîp gåm mét hay nhiÒu thuéc 

tÝnh cña lîc ®å R cã tÝnh chÊt x¸c ®Þnh duy nhÊt mét bé trong mçi thÓ hiÖn 

cña R.

1.1.3 Khóa chính.

Khãa cña mét lîc ®å quan hÖ lµ mét siªu khãa cña lîc ®å nµy sao cho 

mäi tËp con thùc sù cña nã kh«ng lµ siªu khãa.

1.1.4 Khóa ngoài.

Khãa ngoµi cña mét lîc ®å quan hÖ lµ mét tËp hîp gåm mét hay nhiÒu 

thuéc tÝnh lµ khãa cña lîc ®å quan hÖ kh¸c.

1.1.5 Miền (Domain)

Mét miÒn D lµ mét tËp hîp c¸c gi¸ trÞ nguyªn tè, hiÓu theo nghÜa mçi gi¸  

trÞ trong miÒn kh«ng thÓ ph©n chia trong ph¹m vi m« h×nh quan hÖ.

1.1.6 Quan hệ (Relation)

Mét quan hÖ trªn mét tËp c¸c thuéc tÝnh lµ mét tËp con cña tÝch 
Descartes cña mét hay nhiÒu miÒn.

Cho mét quan hÖ r x¸c ®Þnh trªn tËp thuéc tÝnh  Ω = {A1, A2, ..., A1}

Khi ®ã r Є Dom(A1) x  Dom(A2) x Dom(A3) x Dom(A4) x … x Dom(An), trong ®ã 

Dom(Ai) lµ miÒn cña thuéc tÝnh Ai, lµ tËp c¸c gi¸ trÞ cã thÓ cña thuéc tÝnh ®ã. 

Nh vËy quan hÖ r lµ mét tËp hîp c¸c n bé cã d¹ng:

r = {(a1, a2, …, an) | ai Є Dom(ai), i = 1, 2, 3, …, n}.



1.1.6 Lược đồ quan hệ (Relation schema)

Mét lîc ®å quan hÖ R lµ mét cÆp cã thø tù R = <Ω, F>, trong ®ã Ω lµ 

tËp h÷u h¹n c¸c thuéc tÝnh cña quan hÖ, F lµ tËp c¸c ®iÒu kiÖn gi÷a c¸c thuéc 

tÝnh (F cßn gäi lµ tËp c¸c rµng buéc toµn vÑn).

1.2 SQL - Structure Query Language 

Mçi hÖ qu¶n trÞ CSDL  ®Òu ph¶i cã ng«n ng÷ giao tiÕp gi÷a ngêi sö 

dông víi c¬ së d÷ liÖu. Ng«n ng÷ giao tiÕp CSDL gåm c¸c lo¹i sau: 

 Ng«n ng÷ m« t¶ d÷ liÖu  (Data Definition Language –DDL): Cho phÐp 

khai b¸o cÊu tróc c¸c b¶ng cña CSDL, khai b¸o c¸c mèi liªn hÖ cña d÷ 

liÖu (relatÝonship) vµ c¸c quy t¾c ¸p ®Æt lªn c¸c d÷ liÖu ®ã. 

 Ng«n ng÷ thao t¸c  d÷ liÖu  (Data Manipullation Language- DML) cho 

phÐp ngêi sö dông cã thÓ thªm (insert), xo¸ (delete), söa (update) d÷ 

liÖu trong CSDL. 

 Ng«n ng÷ truy vÊn d÷ liÖu (hay ng«n ng÷ hái ®¸p cã cÊu tróc(Structured 

Query Language-SQL)): Cho phÐp ngêi sö dông khai th¸c CSDL ®Ó truy 

vÊn c¸c th«ng tin cÇn thiÕt trong CSDL. 

 Ng«n ng÷ qu¶n lý d÷ liÖu  (Data Control Language- DCL): Cho phÐp 

nh÷ng ngêi qu¶n trÞ hÖ thèng thay ®æi cÊu tróc cña c¸c b¶ng d÷ liÖu, 

khai b¸o b¶o mËt th«ng tin vµ cÊp quyÒn khai th¸c CSDL cho ngêi sö 

dông.

Nh÷ng n¨m 1975-1976, IBM lÇn ®Çu tiªn ®a ra hÖ qu¶n trÞ CSDL kiÓu 

quan  hÖ  mang  tªn  SYSTEM–R víi  ng«n  ng÷  giao  tiÕp  CSDL  lµ  SEQUEL 

(Structured English Query Language). N¨m 1976 ng«n ng÷ SEQUEL ®îc c¶i 

tiÕn thµnh SEQUEL-2, kho¶ng n¨m 1978-1979 SEQUEL-2 ®îc c¶i tiÕn vµ ®æi 

tªn thµnh ng«n ng÷ truy vÊn cã cÊu tróc (Structured Query Language). Cuèi 

n¨m 1979 hÖ qu¶n trÞ CSDL ®îc c¶i tiÕn thµnh SYSTEM-R*. N¨m 1986 viÖn 

tiªu chuÈn quèc gia Mü (American National Standards Institute –ANSI) ®· c«ng 

nhËn vµ chuÈn ho¸ ng«n ng÷ SQL vµ sau  ®ã tæ chøc tiªu chuÈn thÕ giíi 

(International  Standards Organization -ISO) còng ®· c«ng nh©n ng«n ng÷ nµy. 

§ã lµ chuÈn SQL-86. tíi nµy SQL ®· qua 3 lÇn chuÈn ho¸ (1989,1992,1996) ®Ó 



më réng c¸c phÐp to¸n vµ t¨ng cêng kh¶ n¨ng b¶o mËt vµ tÝnh toµn vÑn d÷ 

liÖu. 



Trong phÇn nµy chóng ta chØ nghiªn cøu vÒ ng«n ng÷ SQL. Ng«n ng÷ 

truy vÊn SQL cã tËp lÖnh kh¸ phong phó ®Ó thao t¸c trªn c¬ së d÷ liÖu. Ch¼ng 

h¹n lÖnh create ®Ó t¹o c¸c b¶ng quan hÖ, lÖnh update ®Ó cËp nhËt d÷ liÖu,  

lÖnh delete  ®Ó xo¸ d÷ liÖu, lÖnh insert  ®Ó thªm d÷ liÖu,… 

1.2.1 Định nghĩa dữ liệu

 C¸c kiÓu miÒn trong SQL

 CHAR(n): X©u kÝ tù cã ®é dµi cè ®Þnh n.

 VARCHAR(n): X©u kÝ tù cã ®é dµi tèi ®a n.

 INT, SMALLINT: KiÓu sè nguyªn.

 NUMBER(p,d): Sè thËp ph©n gåm p ch÷ sè vµ mét dÊu chÊm vµ 

d ch÷ sè bªn ph¶i dÊu chÊm.

 REAL, DOUBLE, PRECISION: Sè dÊu phÈy ®éng.

 FLOAT(n): Sè dÊu phÈy ®éng víi ®é chÝnh x¸c Ýt nhÊt n ch÷ sè.

 DATE: KiÓu ngµy, th¸ng, n¨m.

 TIME: KiÓu giê trong ngµy.

 §Þnh nghÜa lîc ®å trong SQL

D¹ng ®¬n gi¶n nhÊt cña c©u lÖnh t¹o mét b¶ng cã có ph¸p nh sau:

CREATE TABLE <Tªn b¶ng>(

<Tªn cét 1><KiÓu d÷ liÖu 1>(<KÝch thíc 1>),

<Tªn cét 2><KiÓu d÷ liÖu 2>(<KÝch thíc 2>),

..................

<Tªn cét n><KiÓu d÷ liÖu n>(<KÝch thíc n>)

);

VÝ dô: §Ó t¹o b¶ng nhan_vien cã thÓ dïng c©u lÖnh sau:

CREATE TABLE nhan_vien (

Manv NUMBER(2),

Ho_ten VARCHAR(25),



Ng_sinh DATE,

Gioi_tinh VARCHAR(3),

Ma_dv CHAR(2),

Luong NUMBER(9)

);

1.2.2 Thao tác dữ liệu

C¸c c©u lÖnh c¬ b¶n ®îc tËp chung nãi ®Õn trong phÇn thao t¸c d÷ liÖu nµy lµ:

 CÊu tróc      SELECT dïng ®Ó truy vÊn d÷ liÖu trong CSDL

FROM 

WHERE

 INSERT: Thªm c¸c bé míi vµo mét b¶ng.

 UPDATE: Söa ®æi th«ng tin ®· cã trong mét b¶ng.

 DELETE: Xo¸ bá mét sè bé trong mét b¶ng.

 CÊu tróc c¬ së ®Ó truy vÊn

Có ph¸p ®iÓn h×nh cña mét biÓu thøc truy vÊn trong SQL lµ:

SELECT [ DISTINCT | ALL] { * | [<biÓu thøc cét> AS [<Tªn míi>]] [,...]}

FROM <tªn b¶ng>[<bÝ danh>] [,...]

[WHERE <®iÒu kiÖn>]

[GROUP BY <danh s¸ch tªn cét>] [HAVING<®iÒu kiÖn>]

[ORDER BY <Danh s¸ch tªn cét>]

Trong d¹ng trªn <biÓu thøc cét> lµ tªn cña mét cét hoÆc mét biÓu thøc, <tªn 

b¶ng> lµ tªn cña mét b¶ng trong CSDL hay mét khung nh×n (View) mµ ta cã 

thÓ truy cËp vµo, <bÝ danh> lµ mét tªn viÕt t¾t cña tªn b¶ng. Ngoµi ra:

 GROUP BY dïng ®Ó gép nhãm c¸c bé cïng gi¸ trÞ t¬ng øng ë c¸c cét 

xuÊt hiÖn trong <danh s¸ch tªn cét>.

 HAVING dïng ®Ó läc c¸c nhãm tháa ®iÒu kiÖn.



 ORDER BY quy ®Þnh thø tù c¸c cét trong kÕt qu¶ tr¶ ra.

Thø tù c¸c c©u trong d¹ng biÓu thøc truy vÊn trªn kh«ng thÓ thay ®æi. KÕt 

qu¶ cña biÓu thøc truy vÊn ®ã lµ mét b¶ng. Díi ®©y lµ mét sè vÝ dô minh häa.

VÝ dô 4.1  

§Ó t×m tªn c¸c dù ¸n vµ m· c¸c ®¬n vÞ (C¸c phßng) QL dù ¸n t¬ng øng cã thÓ 

dïng truy vÊn sau:

SELECT ten_da, ma_dv 

FROM du_an 

B¶ng kÕt qu¶ cña truy vÊn trªn (®èi víi b¶ng DU_AN) sÏ lµ:

ten_da ma_dv
PhÇn mÒm A

M¹ng B

Agent C

PhÇn mÒm B

P4

P3

P2

P1

Muèn b¶ng kÕt qu¶ kh«ng chØ cã 2 cét ten_da vµ ma_da mµ lµ tÊt c¶ c¸c cét  

trong b¶ng du_an, cã 2 c¸ch.

SELECT ma_da, ten_da, dia_diem_da, ma_dv 

FROM du_an 

hoÆc 

SELECT *

FROM du_an 

VÝ dô 4.2

C©u truy vÊn sau cho danh s¸ch nh©n viªn cã l¬ng trªn 2 300 000, víi mçi nh©n 

viªn nh vËy c¸c th«ng tin ®a ra gåm: m· nh©n viªn, hä tªn, m· ®¬n vÞ vµ l¬ng.

SELECT ma_nv, ho_ten, ma_dv, luong 

FROM nhan_vien 

WHERE luong > 2 300 000



VÝ dô 4.3

LiÖt kª l¬ng cña c¸c nh©n viªn theo thø tù t¨ng dÇn.

SELECT ma_nv, ho_ten, ma_dv, luong 

FROM nhan_vien 

ORDER BY luong;

B¶ng kÕt qu¶ sÏ lµ:

VÝ dô 4.4

§Ó t×m m· sè vµ hä tªn nh÷ng häc sinh khoa ‘C«ng nghÖ th«ng tin’ cã thÓ dïng 

c©u lÖnh truy vÊn sau:

SELECT malop, hoten 

FROM lop

WHERE makhoa = 

         (SELECT makhoa 

             FROM khoa 

               WHERE tenkhoa = 'C«ng nghÖ th«ng tin');

B¶ng kÕt qu¶ sÏ lµ:

 CËp nhËt c¬ së d÷ liÖu.



Trong SQL cã 3 c©u lÖnh cã thÓ biÕn ®æi c¬ së d÷ liÖu (Thªm, bít, thay 

®æi th«ng tin).

o INSERT: Thªm c¸c bé míi vµo mét b¶ng.

o UPDATE: Söa ®æi th«ng tin ®· cã trong mét b¶ng.

o DELETE: Xo¸ bá mét sè bé trong mét b¶ng.

 D¹ng INSERT.

C©u lÖnh Insert cho phÐp mét bé ®îc thªm vµo mét b¶ng, có ph¸p nh

sau:

INSERT INTO <Tªn b¶ng>[(Danh s¸ch cét)]

VALUES (Danh s¸ch c¸c gi¸ trÞ)

VÝ dô 4.5

C©u lÖnh sau thªm vµo mét bé vµo b¶ng nhan_vien.

INSERT INTO nhan_vien 

     VALUES (‘11’,’TrÇn H÷u ViÖt’, ‘Nam’, ‘Hµ Néi’);

 D¹ng UPDATE.

Trong mét sè trêng hîp chóng ta cÇn thay ®æi mét sè gi¸ trÞ trong mét bé chø 

kh«ng ph¶i lµ thay ®æi tÊt c¶ c¸c gi¸ trÞ cña bé. LÖnh UPDATE cho phÐp lµm 

®iÒu ®ã vµ có ph¸p nh sau:

UPDATE <Tªn b¶ng>

SET <Tªn cét i>=<Gi¸ trÞ i>[,<Tªn cét j>=<Gi¸ trÞ j>,...]

[WHERE <®iÒu kiÖn>]

Khi c©u  WHERE kh«ng xuÊt hiÖn trong c©u lÖnh cËp nhËt nµy th× mäi bé 

trong b¶ng sÏ ®îc cËp nhËt trªn nh÷ng cét x¸c ®Þnh bëi SET, ngîc l¹i th× chØ 

nh÷ng bé tho¶ ®iÒu kiÖn ®Æt sau WHERE míi bÞ söa ®æi.

VÝ dô 4.6

T¨ng l¬ng 5% cho mäi nh©n viªn, c©u lÖnh ®îc viÕt nh sau:

UPDATE nhan_vien 

SET luong = luong*1.05;



VÝ dô 4.7

T¨ng l¬ng 5% cho nh©n viªn lµm ë ®¬n vÞ cã m· sè “P2”, c©u lÖnh ®îc viÕt nh 

sau:

UPDATE nhan_vien 

SET luong = luong*1.05

WHERE ma_dv = ‘P2’;

 D¹ng DELETE

Có ph¸p cña c©u lÖnh xo¸ mét sè bé khái mét b¶ng lµ:

DELETE FROM <Tªn b¶ng>

[WHERE <§iÒu kiÖn>]

Trong c©u lÖnh trªn, nÕu c©u WHERE kh«ng xuÊt hiÖn th× tÊt c¶ c¸c bé trong 

b¶ng sÏ bÞ xo¸, ngîc l¹i th× chØ nh÷ng bé tho¶ ®iÒu kiÖn bÞ lo¹i bá khái b¶ng.

VÝ dô 4.8

C©u lÖnh sau sÏ xo¸ tÊt c¶ c¸c bé trong b¶ng cong_thang.

DELETE FROM cong_thang 

VÝ dô 4.9

§Ó xo¸ bé nãi vÒ nh©n viªn cã m· sè 5 trong b¶ng nhan_vien, cã thÓ viÕt.

DELETE FROM nhan_vien 

WHERE manv = ‘5’; Sơ lược về ASP

2.1 Giới thiệu về ASP.

ASP (Active Server Page) lµ mét thµnh phÇn më réng cña IIS. Khi cµi 

®Æt, ASP sinh ra c¸c bé xö lý ¶o ®èi víi ng«n ng÷ kÞch b¶n (script engine) t¹i 

server ®Ó IIS cã thÓ xö lý c¸c m· script mµ c¸c m· nµy cã thÓ viÕt ®an xen 

trong c¸c trang HTML. Khi Client gäi ®Õn mét file .asp  trªn Web Server, Web 

Server lËp tøc gäi ®Õn Script engine ®Ó xö lý. Script engine sÏ thùc hiÖn c¸c 

lÖnh script ®Ó biÕn trang ASP thµnh trang HTML råi göi l¹i Client. Chó ý r»ng 

qu¸ tr×nh nµy thùc hiÖn t¹i  server chø kh«ng ph¶i t¹i Client. V× vËy chóng ta 

kh«ng ph¶i quan t©m tíi viÖc browser xö lý c¸c trang Web nh− thÕ nµo. Nh− 

vËy thùc sù qu¸ tr×nh nµy ®−îc thùc hiÖn theo m« h×nh Client-Server. 



ASP lµ c«ng nghÖ Web Server míi cña Microsoft, nã ®−îc thiÕt kÕ ®Ó 

gióp  ng−êi ph¸t triÓn øng dông trªn Web  x©y dùng c¸c trang Web øng dông 

nhanh  chãng vµ dÔ dµng. ASP lµ mét phÇn tÝch hîp cña  c«ng nghÖ c¬ së 

Active (Active  Platform), lµ h¹t nh©n trong chiÕn l−îc internet cña Microsoft. 

Active Platform lµ mét tËp hîp c¸c ng«n ng÷, c¸c chuÈn vµ c¸c dÞch vô cã thÓ 

®−îc sö dông ®Ó ph¸t triÓn c¶ øng dông Active Desktop(b¶n Client) vµ Active 

Server (b¶n Server) trong m« h×nh CSDL tÝnh to¸n Client / Server. M« h×nh 

Active Platform gióp cho ng−êi  ph¸t triÓn øng dông x©y dùng øng dông hiÖu 

qu¶ vÒ gi¸ thµnh, më réng kh¶ n¨ng cña c¸c øng dông ch¹y trªn Server còng nh− 

ch¹y trªn Client vµ n©ng cao kü n¨ng ph¸t triÓn øng dông cña hä. §ång thêi, nã 

còng lµm viÖc chuyÓn ®æi tõ øng dông Desktop sang øng dông Client/Server 

®Çy ®ñ, dÔ dµng.

2.2 ASP  file là gì?

File ®îc t¹o víi phÇn më réng.ASP. Trong file nµy chøa c¸c thÎ HTML, C¸c 

kÞch  b¶n  Scripting  nh VBSCript,  JavaScript  hay  c¸c   lêi  gäi  ®Õn  c¸c 

components(Nh DLL vµ ActiveX control) C¸c script cña ASP ®îc n»m trong cÆp 

thÎ <% ……….. %>

Khi cÇn söa ®æi c¸c file ASP ta chØ cÇn ghi l¹i trªn server th«i. Vµo nh-

ng lÇn sau khi trang A ®îc gäi, c¸c Script trong file ASP tù ®éng biªn dÞch l¹i.

C«ng nghÖ ASP ®îc x©y dng trùc tiÕp bªn trong  IIS(WinNT, 2000, XP), 

Personal Webserver. ASP làm việc như thế nào

Trang HTML tÜnh:

Trang Web ®éng (Dynamic):



VÝ dô vÒ trang ASP

<html>
<body>
<%
response.write("Hello World!")
%>
</body>
</html>

<html>
<body>
<%="Hello World!"%>
</body>
</html>

2.4 Tạo và xem một file ASP

Chóng  ta  sö  dông  nh÷ng  c«ng  cô  cña  Microsoft  nh−:  Microsoft 

Frontpage, Notepad hoÆc Dreamweaver ®Ó t¹o mét file ASP . 



§Ó xem mét file ASP, chóng ta kh«ng thÓ göi nã ®Õn tr×nh duyÖt nh− 

mét trang HTML bëi v× Browser kh«ng nhËn biÕt ®−îc c¸c file ASP. Lý do lµ c¸c 

file nµy cÇn ph¶i ®−îc th«ng dÞch trªn Server tr−ãc khi göi ra Browser. 

Chóng ta cã thÓ sö dông IE hoÆc Nescape Navigator ®Ó xem kÕt qu¶ 

cña c¸c file ASP nh−ng chóng ta cÇn ch¾c ch¾n r»ng Server mµ chóng ta xö lý 

c¸c m· cã cµi ®Æt ASP vµ ®ang ch¹y IIS hoÆc Personal Web Server (PWS).  

   Trang ASP lµ mét d¹ng text cã kiÓu lµ .asp, cã cÊu tróc gÇn gièng nh− 

file HTML. TÊt c¶ c¸c thÎ cã trong HTML th× ®Òu dïng ®−îc trong ASP. Nh−ng 

ngoµi c¸c thÎ th«ng th−êng cña HTML, trong file asp cßn cã thÓ viÕt c¸c thÎ kh¸c  

n÷a ®Ó thÓ hiÖn c¸c dßng lÖnh cña Script ®Ó lµm viÖc víi d÷ liÖu cã s½n hay 

cã thÓ tÝnh to¸n ngay bªn trong nh− lµ mét ng«n ng÷ lËp tr×nh thùc sù. 

C¬ chÕ ho¹t ®éng cña ASP nh− sau: Client sö dông mét Web Browser 

göi  yªu cÇu HTTP tíi  mét Server ch¹y Microsoft Internet Information Server 

(IIS). Sau khi nhËn biÕt ®ã lµ yªu cÇu cÇn xö lý cña trang ASP, IIS chuyÓn yªu 

cÇu nµy tíi ASP engine, t¹i ®©y néi dung file .asp ®−îc xö lý, c¸c m· HTML ®−îc 

®Ó nguyªn cßn c¸c Script ®−îc tÝnh dùa theo c¸c yªu cÇu vµ ®−îc chuyÓn ®æi 

thµnh c¸c m· HTML. NÕu trong c¸c Script cã c¸c c©u lÖnh gäi d÷ liÖu, nã sÏ liªn 

kÕt tíi Database Server vµ lÊy c¸c d÷ liÖu theo yªu cÇu. Sau ®ã, c¸c kÕt qu¶ 

cña viÖc thùc hiÖn c¸c Script (cã thÓ lµ HTML tÜnh hoÆc ®éng) ®−îc göi tr¶ l¹i 

Client Browser. 

XÐt mét vÝ dô ®Ó lµm râ c¬ chÕ nµy:

    <HTML> 

      <HEAD> 

         <TITLE>Example</TITLE> 

      </HEAD> 

      <BODY> 

         <% For i=5 to 7%> 

            <FONT SIZE=<%=i%>>Chµo b¹n!<BR></FONT> 

         <% Next %> 

      </BODY> 

   </HTML>

KÕt qu¶ lµ tr×nh duyÖt sÏ hiÓn thÞ 3 dßng Chµo b¹n! víi kÝch th−íc t¨ng dÇn 
nh− sau 

Chµo b¹n! 



Chµo b¹n! 

Chµo b¹n! 

Trong vÝ dô nµy chóng ta míi ®Ò cËp ®Õn nguyªn lý lµm viÖc cña ASP 

mµ ch−a nãi ®Õn c¬ chÕ t¹o Web ®éng tøc lµ c¸ch t¹o c¸c trang Web thay ®æi 

theo th«ng tin t−¬ng t¸c mµ ng−êi sö dông cung cÊp. Trong vÝ dô ta sÏ lµm viÖc 

nh− sau: 

T¹o mét trang Web cã mét form ®Ó ng−êi sö dông nhËp vµo hä, tªn vµ 

giíi tÝnh qua Textbox vµ option. Ng−êi sö dông còng ®¸nh vµo mét sè tù nhiªn. 

Khi nhËn ®−îc, ASP sÏ göi l¹i mét trang Web víi mét lêi chµo phï hîp víi giíi tÝnh 

vµ tªn ng−êi ®· ®−îc cung cÊp ®ång thêi cho ra tÊt c¶ c¸c −íc sè cña sè nµy.  

Sau ®©y lµ ®o¹n m· cña hai trang ASP thùc hiÖn hiÖu øng nµy. Cã mét 

sè c©u lÖnh script cã thÓ cßn l¹ nh−ng ý nghÜa hoµn toµn râ rµng.

<HTML> 

  <HEAD> 

    <TITLE>Example</TITLE> 

  </HEAD> 

  <BODY> 

    <P>Vi du ve form de trao doi thong tin theo phuong thuc 

       POST</P>

    <FORM method="post" action="chao.asp"> 

      <P> Ho dem: <input type ="text" name="Hodem" 

                   size=20></P> 

      <P>Ten:<input type ="text" name="Ten" size=20></P> 

<P> Gioi tinh: Nam <input type ="radio" value="Nam" 

    checked name="Gioitinh" size=20> 

      Nu <input type ="radio" value ="Nu" name="Gioitinh" 

             size=20></P> 

<P>Cho so n <input type ="Text" name="So" size=8></P> 

<P><input type="submit" value ="Gui di" name="B1">

   <input type="reset"  name="B2"></P> 



   </FORM> 

 </BODY> 

</HTML>

H×nh 4.2 Form sö dông ASP

 

§©y lµ néi dung tÖp Chao.asp m« t¶ øng xö khi ta bÊm nót Göi ®i t−¬ng øng víi  

ho¹t ®éng Submit cña Form 

<HTML> 

  <HEAD> 

     <TITLE>Example</TITLE>

  </HEAD> 

  <BODY> 

     <% ho=request.Form("hodem") 

   ten=request.Form("ten") 

        so=request.Form("so") 

        gioitinh=request.form("gioitinh") 

        if gioitinh="Nam" then 

           gioitinh="Ong" 

   else  

gioitinh="Ba" 

        end if   



        response.Write "Xin chao " & gioitinh & " " & ho 

                        &" " & ten &" <br>" 

        response.Write "Day la ket qua tinh " & "<br>" 

         for i=1 to so-1 

            if so mod i =0 then 

               response.Write i & "<br>" 

            end if 

         next   

        %> 

    </BODY> 

</HTML>



2. Các lệnh liên kết CSDL trong ASP

3.1 ADO là gì? 

ADO Cã thÓ dïng ®Ó truy cËp d÷ liÖu tõ trang web. 

­ ADO lµ c«ng nghÖ cña Microsoft  

­ ADO ®îc viÕt t¾t lµ ActiveX Data Objects  

­ ADO lµ mét thµnh phÇn cña Active-X  

­ ADO tù ®éng cµi ®Æt khi cµi IIS  

­ ADO lµ m«i trêng lËp tr×nh giao tiÕp víi CSDL- database  

3.2 Cách truy xuất database bằng ADO trong ASP. 

C¸ch th«ng thêng ®Ó truy cËp CSDL tõ trang web ASP nh sau:

1.      Khëi t¹o mét kÕt nèi ADO tõ c¬ së d÷ liÖu. 

2.      Më kÕt nèi c¬ së d÷ liÖu.  

3.      Khëi t¹o mét  ADO recordset  

4.      Më recordset  

5.      TrÝch (lÊy) d÷ liÖu chóng ta cÇn tõ recordset.

6.      §ãng recordset  

7.      §ãng kÕt nèi  

3.3 Tạo kết nối ADO (ADO Connection). 

Tríc khi truy cËp d÷ liÖu, chóng ta ph¶i thiÕt lËp kÕt nèi ®Õn CSDL ®ã. Cã 02 

c¸ch ®Ó thiÕt lËp kÕt nèi. 

� KÕt nèi trùc tiÕp( DSN-less Database Connection) 

§©y lµ c¸ch ®¬n gi¶n nhÊt thêng kÕt nèi víi Microsoft Access database. 

Gi¶ sö chóng ta cã mét Database cã tªn  "northwind.mdb"  ®Æt t¹i  th môc 

"c:/webdata/",  chóng ta cã thÓ kÕt nèi ®Õn CSDL nh sau:

 <% 

set conn=Server.CreateObject("ADODB.Connection") 

     conn.Provider="Microsoft.Jet.OLEDB.4.0" 

     conn.Open "c:/webdata/northwind.mdb" 



  %>

� KÕt nèi th«ng qua ODBC(ODBC Database Connection)

Víi  kÕt nèi  ODBC connection, Chóng ta  cã thÓ kÕt nèi  ®Õn bÊt kú 

CSDL nµo vµ ë bÊt kú  m¸y nµo trong hÖ thèng m¹ng cña chóng ta, miÔn lµ 

ODBC connection tån t¹i. C¸ch t¹o ODBC Connection víi  MS Access Database 

1.       Vµo  Control  Panel  ->  Administrative  Tools  ->  Data  Sources 

(ODBC).  

2.      Chän b¶ng (tab) System DSN.  

3.      Click vµo nót  Add trong b¶ng System DSN.  

4.      Lùa chän Microsoft Access Driver. Click Finish.  

5.      Trong mµn h×nh tiÕp theo, click vµo Select ®Ó chän c¬ së d÷ liÖu. 

6.      §Æt tªn cho c¬ së d÷ liÖu trong « Data Source Name (DSN).  

7.      Click OK.  

Sö dông ADO Recordset 

§Ó cã  thÓ ®äc  d÷ liÖu  tõ database,  ®Çu  tiªn  d÷ liÖu  ph¶i  ®îc  n¹p  vµo 

recordset.  

 C¸ch t¹o ADO Recordset 

Sau khi   ADO Database Connection ®· ®îc t¹o,  tiÕp theo ta  ph¶i  t¹o  ADO 

Recordset.    Gi¶ sö ta cã database cã tªn "Northwind", Chóng ta cã thÓ truy 

cËp d÷ liÖu tõ b¶n "Customers" nh sau:

  <% 

set conn=Server.CreateObject("ADODB.Connection") 

conn.Provider="Microsoft.Jet.OLEDB.4.0" 

conn.Open "c:/webdata/northwind.mdb" 

set rs=Server.CreateObject("ADODB.recordset") 

rs.Open "Customers", conn 

  %>

 C¸ch t¹o ADO SQL Recordset 

Chóng ta cã thÓ truy cËp d÷ liÖu tõ b¶n "Customers" sö dông c©u lÖnh SQL:



  <% 

set conn=Server.CreateObject("ADODB.Connection") 

conn.Provider="Microsoft.Jet.OLEDB.4.0" 

set conn=Server.CreateObject("ADODB.Connection")  

     conn.Open "northwind" 

conn.Open "c:/webdata/northwind.mdb" 

set rs=Server.CreateObject("ADODB.recordset") 

rs.Open "Select * from Customers", conn 

  %>

LÊy d÷ liÖu tõ Recordset 

Sau khi recordset ®îc më, chóng ta cã thÓ lÊy d÷ liÖu recordset. Chóng 

ta cã thÓ truy xuÊt d÷ liÖu tõ b¶n Customers trong CSDL Northwind nh sau:

  <% 

set conn=Server.CreateObject("ADODB.Connection") 

conn.Provider="Microsoft.Jet.OLEDB.4.0" 

conn.Open "c:/webdata/northwind.mdb" 

set rs=Server.CreateObject("ADODB.recordset") 

rs.Open "Select * from Customers", conn 

for each x in rs.fields 

   response.write(x.name) 

   response.write(" = ") 

   response.write(x.value) 

next 

  %>

3. M t s  bài t p  ng d ng m uộ ố ậ ứ ụ ẫ



TÊt c¶ c¸c vÝ dô trong ch¬ng nµy ®Òu sö dông CSDL qlnv, ngêi häc 

cÇn yªu cÇu gi¸o viªn cung cÊp CSDL qlnv ®Ó thùc hiÖn bµi thùc hµnh.

4.1 Hiển thị tên Field và giá trị của Field  

Chúng ta có thể truy xuất dữ liệu từ bảng NHANVIEN  trong CSDL qlnv như sau:

<html> 

   <body> 

<% 

    set conn=Server.CreateObject("ADODB.Connection") 

    conn.Provider="Microsoft.Jet.OLEDB.4.0"

    conn.Open "...\Database\qlsv.mdb" 

    set rs = Server.CreateObject("ADODB.recordset") 

    rs.Open "SELECT * FROM SINHVIEN", conn 

    do until rs.EOF 

    for each x in rs.Fields 

    Response.Write(x.name)

    Response.Write(" = ") 

    Response.Write(x.value & "<br />")  

     next 

  Response.Write("<br />") 

  rs.MoveNext 

loop 

rs.close 

conn.close 

  %> 

     </body> 

  </html>

K  ế  t qu  ả  



Hiển thị tên Field và giá trị của Field trong HTML table

<html> 

  <body> 

    <% 

      set conn=Server.CreateObject("ADODB.Connection") 

      conn.Provider="Microsoft.Jet.OLEDB.4.0" 

      conn.Open "...\Database\qlsv.mdb" 

      set rs = Server.CreateObject("ADODB.recordset") 

      rs.Open "SELECT Masv, Hodem, Ten FROM SINHVIEN", 

                conn 

    %>

    </table> 

  </body> 

KÕt qu¶



Thªm mét b¶n ghi vµo b¶ng cña csdl.

Chóng ta cã thÓ thªm 1 b¶n ghi míi vµo CSDL qlsv. Tríc tiªn chóng ta ph¶i t¹o ra 

01 form nhËp liÖu:

<html> 

  <body> 

    <form method="post" action="c6_demo_add.asp"> 

      <table> 

        <tr> 

          <td>M· m«n häc:</td> 

          <td><input name="Mamh"></td> 

        </tr><tr> 

          <td>Tªn m«n häc:</td> 

          <td><input name="Tenmh"></td> 

        </tr><tr> 

          <td>Sè tiÕt:</td> 

          <td><input name="Sotiet"></td> 

        </tr>

      </table> 

      <br /><br /> 

      <input type="submit" value="Add New">  

      <input type="reset" value="Cancel"> 

    </form> 

<table border="1" width="30%"> 

       <%do until rs.EOF%> 

         <tr> 



           <%for each x in rs.Fields%> 

              <td><%Response.Write(x.value)%></td> 

            <%next 

        rs.MoveNext%> 

      </tr> 

       <%loop 

     rs.close 

     conn.close 

   %> 

  </table> 

 </body> 

</html>

K  ế  t qu  ả  :  

VÉn yªu cÇu gièng phÇn trªn nhng t¹o thªm tiªu ®Ò cho cét.

<html> 

  <body> 

    <% 

      set conn=Server.CreateObject("ADODB.Connection") 

      conn.Provider="Microsoft.Jet.OLEDB.4.0" 

      conn.Open "...\Database\qlsv.mdb" 

      set rs = Server.CreateObject("ADODB.recordset") 

      rs.Open "SELECT Masv, Hodem, Ten FROM SINHVIEN", 

                conn 

    %>

<table border="1" width="30%"> 

       <tr> 

  <%for each x in rs.Fields 



       response.write("<th>" & x.name & "</th>") 

  next%> 

    </tr>

       <%do until rs.EOF%> 

         <tr> 

           <%for each x in rs.Fields%> 

              <td><%Response.Write(x.value)%></td> 

            <%next 

        rs.MoveNext%> 

      </tr> 

       <%loop 

     rs.close 

     conn.close 

   %> 

  </table> 

 </body> 

</html>

Kết quả:

 



4.2 Truy vấn 

HiÓn thÞ d÷ liÖu ®îc chän.

Chóng ta chØ hiÓn thÞ nh÷ng b¶n ghi tõ b¶ng "SINHVIEN" mµ trêng "Ten" b¾t 

®Çu b»ng ch÷ H.  

<html> 

  <body> 

    <% 

      set conn=Server.CreateObject("ADODB.Connection") 

      conn.Provider="Microsoft.Jet.OLEDB.4.0" 

      conn.Open "...\Database\qlsv.mdb" 

      set rs = Server.CreateObject("ADODB.recordset")  

      sql="SELECT Hodem, Ten FROM SINHVIEN WHERE 

            Ten LIKE 'h%'" 

rs.Open sql , conn 

   %> 

   <table border="1" width="30%"> 

     <tr> 

       <%for each x in rs.Fields 

          response.write("<th>" & x.name & "</th>") 

       next%> 

    </tr> 

    <%do until rs.EOF%> 

    <tr> 

       <%for each x in rs.Fields%> 

     <td><%Response.Write(x.value)%></td> 

      <%next 

      rs.MoveNext%> 

    </tr> 

   <%loop 

   rs.close 

   conn.close%> 

  </table> 

 </body> 

</html>



Kết quả

S¾p xÕp d÷ liÖu

HiÓn thÞ "Hodem" vµ "Ten" tõ b¶ng "SINHVIEN", s¾p xÕp bëi  Ten theo chiÒu 

t¨ng dÇn víi thø tù tù ®iÓn.

<html> 

  <body> 

    <% 

set conn=Server.CreateObject("ADODB.Connection") 

conn.Provider="Microsoft.Jet.OLEDB.4.0" 

conn.Open "...\Database\qlsv.mdb" 

set rs = Server.CreateObject("ADODB.recordset")   

sql="SELECT Hodem, Ten FROM SINHVIEN ORDER BY Ten" 

rs.Open sql , conn 

    %> 

    <table border="1" width="30%"> 

      <tr> 

        <%for each x in rs.Fields 

          response.write("<th>" & x.name & "</th>") 

        next%> 

      </tr> 

      <%do until rs.EOF%> 

      <tr> 

        <%for each x in rs.Fields%> 

      <td><%Response.Write(x.value)%></td> 

     <%next 

     rs.MoveNext%> 

    </tr> 



  <%loop 

  rs.close

  conn.close%>

  </body> 

</html>

KÕt qu¶

Khi  chóng  ta  bÊm  vµo  nót  submit(add  New)  sÏ chuyÓn  sang  file 

"c6_demo_add.asp".   "c6_demo_add.asp"  chøa ®o¹n m· thªm 01 record míi 

vµo b¶ng MONHOC nh sau:

<html> 

  <body> 

    <%

      set conn=Server.CreateObject("ADODB.Connection") 

      conn.Provider="Microsoft.Jet.OLEDB.4.0" 

      conn.Open "...\Database\qlsv.mdb" 

      sql="INSERT INTO MONHOC (Mamh, Tenmh, Sotiet)" 

      sql=sql & " VALUES " 

      sql=sql & "('" & Request.Form("Mamh") & "'," 

      sql=sql & "'" & Request.Form("Tenmh") & "'," 

      sql=sql & "'" & Request.Form("Sotiet") & "')" 

      on error resume next 

      conn.Execute sql,recaffected 

      if err<>0 then 

         Response.Write("Kh«ng cho phÐp cËp nhËt!") 

      else  

         Response.Write("<h3>" & recaffected & "

                     B¶n ghi ®· ®îc thªm vµo CSDL</h3>") 

      end if 

      conn.close 



    %>  

   </body> 

KÕt qu¶

4. Bài t p cu i ch ngậ ố ươ
1. HiÓn thÞ th«ng tin c¸c b¶ng DIEM, LOP, MONHOC, THOIKHOABIEU 

trong csdl qlsv.

2. S¾p xÕp b¶ng DIEM trong csdl qlsv theo thø tù t¨ng dÇn vÒ ®iÓm.

3. CËp nhËt mét b¶n ghi trong b¶ng MONHOC cña csdl qlsv. Víi mçi record 

lÊy Mamh lµm tham sè.

4. Xãa mét b¶n ghi trong b¶ng MONHOC cña csdl qlsv. Víi mçi record lÊy 

Mamh lµm tham sè.



Chương 6

Thiết kế Web động bằng Macromedia 
Dreamweaver

Trong ch¬ng 5 chóng ta ®· ®îc t×m hiÓu vÒ ASP, chóng ta ®· cã thÓ 

thiÕt kÕ ra ®îc mét trang web ®éng c¬ b¶n. Ch¬ng nµy sÏ gióp chóng ta t¹o ra 

®îc mét trang web ®éng ®¬n gi¶n nhanh h¬n nhê vµo c¸c chøc n¨ng trùc quan 

cña Dreamweaver.

Môc tiªu

1. VËn dông ®îc chøc n¨ng Master – Detail  Page Set ®Ó thiÕt kÕ mét 

trang web ®éng.

2. T¹o ®îc kÕt nèi CSDL trong Dreamweaver.

3. T¹o ®îc c¸c trang Insert, c¸c ®èi tîng cña Form.



1. Xây d ng trang Master­Detail Page Setự

Master-Detail Page set lµ mét øng dông web cã tr×nh bµy c¸c th«ng tin 

®îc trÝch xuÊt tõ mét c¬ së d÷ liÖu trong hai ®Þnh d¹ng. Trang chñ (master)sÏ 

hiÓn thÞ mét danh s¸ch cña tÊt c¶ c¸c b¶n ghi truy xuÊt nh lµ mét kÕt qu¶ cña 

t×m kiÕm c¬ së d÷ liÖu. Mét trang chi tiÕt (Detail) liªn kÕt tõ trang chñ trang 

web vµ thêng cung cÊp thªm c¸c chi tiÕt cô thÓ vÒ mét môc ®· chän trong 

trang chñ.

Chóng ta cã thÓ hoµn tÊt phÇn híng dÉn nµy trong m« h×nh m¸y chñ 

sau ®©y -ColdFusion, ASP, JSP. Trong phÇn híng dÉn nµy, chóng ta sÏ x©y 

dùng mét master and detail page set. Nh÷ng híng dÉn mÊt kho¶ng 20 phót ®Ó 

hoµn thµnh, tïy thuéc vµo kinh nghiÖm cña chóng ta, vµ sÏ d¹y cho chóng ta 

c¸ch lµm c¸c nhiÖm vô sau:

1.  “T¹o mét master-detail page set” trªn trang 144

2.  “T¹o mét database recordset” trªn trang 145

3.  “ChÌn mét ®èi t¬ng øng dông vµo Master-Detail Page Set” trªn trang 148

4.  “HiÓn thÞ trang cña chóng ta” trªn trang 150

1.1 Tạo một master-detail page set

Mét ®iÓm xuÊt ph¸t tèt ®Ó ph¸t triÓn mét øng dông c¬ së d÷ liÖu lµ ®Ó 

hiÓn thÞ mét danh s¸ch nh÷ng b¶n ghi ®îc lu tr÷ trong mét c¬ së d÷ liÖu. Trang 

master-detail page set chóng ta ph¸t triÓn sÏ liÖt kª nh÷ng  vÞ trÝ cho thuª « t« 

cña c«ng ty,còng nh  th«ng tin chi tiÕt vÒ mçi vÞ trÝ, nh sè ®iÖn tho¹i vµ ®Þa 

chØ.

TÊt c¶ c¸c th«ng tin vÒ c¸c ®Þa ®iÓm toµn cÇu nµy ®îc lu gi÷ trong mét 

tËp tin c¬ së d÷ liÖu Microsoft Access “ global.mdb”. Chóng ta nªn ch¾c ch¾n 

r»ng cã mét kÕt nèi vµo c¬ së d÷ liÖu nµy. øng dông c¸c trang web sÏ kh«ng ®-

îc cËp nhËt mµ kh«ng cã mét kÕt nèi vµo c¬ së d÷ liÖu nµy.

H·y b¾t ®Çu b»ng viÖc lùa chän mét trang ®Ó lµm viÖc.

1) Thùc hiÖn mét trong c¸c c¸ch sau ®Ó më panel Site:

 Trong nhãm panel Files, click vµo mòi tªn më réng, sau ®ã chän tab 

Site nÕu nã cha ®îc më.



 Chän Window -> Site.

 Ên F8.

Panel Site ®îc më.

2) Trong tr×nh ®¬n pop-up Site, lùa chän site GlobalCar mµ chóng ta ®· 
®Þnh nghÜa.

3) Trong panel Site, click ®óp vµo file locationMaster ®Ó më nã.

Tµi liÖu më trong cöa sæ Document. Chóng ta sÏ tõng phÇn cña trang 
®· hoµn thµnh.

1.2 Tạo một bản ghi (recordset) cơ sở dữ liệu

B©y giê chóng ta sÏ t¹o mét recordset ®Ó hiÓn thÞ d÷ liÖu ®· ®îc lu tr÷ trong 

mét c¬ së d÷ liÖu. Mét  recordset lµ mét nhãm c¸c th«ng tin trÝch xuÊt  tõ mét 

c¬ së d÷ liÖu b»ng viÖc  truy vÊn mét c¬ së d÷ liÖu. (Trong ASP.NET, mét 

recordset ®îc biÕt ®Õn nh mét DataSet.) Mét truy vÊn c¬ së d÷ liÖu bao gåm 

c¸c tiªu chÝ t×m kiÕm, trong ®ã 



x¸c ®Þnh nh÷ng g× ®îc bao gåm trong recordset. Chóng ta h·y sö dông nh÷ng 

th«ng tin ®îc trÝch xuÊt nh lµ mét nguån d÷ liÖu cho c¸c trang web ®«ng cña 

chóng ta. Dreamweaver MX cung cÊp mét giao diÖn ®¬n gi¶n - dÔ sö dông 

®Ó t¹o ra c¸c truy 

vÊn SQL –chóng ta kh«ng cÇn ph¶i biÕt SQL ®Ó t¹o ra mét recordset trong 

Dreamweaver.

Chóng ta sÏ t¹o mét recordset ®Ó lùa chän tÊt c¶ c¸c gi¸ trÞ tõ b¶ng Location.

1) Trong Dreamweaver, më hép tho¹i Recordset hoÆc DataSet (ASP.NET) 

b»ng c¸ch thùc hiÖn mét trong c¸c bíc sau:

 Trong thanh Insert chän Tab Application, click vµo nót Recordset 

hoÆc DataSet (ASP.NET).

 Chän Window -> Bindings ®Ó më panel Binding, sau dã click vµo 

nót (+) vµ lùa chän Recordset hoÆc DataSet.

 Trong nhãm panel Application, chän panel Binding, sau ®ã click 

vµo nót céng (+) vµ lùa chän Recordset hoÆc DataSet.

Hép tho¹i Recordset hoÆc DataSet xuÊt hiÖn. Nh÷ng mµn h×nh díi ®©y 

cho thÊy hép tho¹i recordset cña ColdFusion. (Trong ASP.NET ®©y lµ hép tho¹i 

DataSet, hÇu hÕt c¸c tïy chän recordset ®ang cã cïng mét m« h×nh cho tÊt c¶ 

c¸c lo¹i m¸y chñ.)

2) Trong « textbox Name, nhËp rsLocations. 

§©y lµ tªn cña recordset mµ chóng ta ®Þnh nghÜa.

3) Trong tr×nh  ®¬n pop-up Data  Source  (ColdFusion)  hoÆc tr×nh  ®¬n 

pop-up Connection (C¸c lo¹i trang phôc vô kh¸c), lùa chän connGlobal.



Hép tho¹i Recordset hoÆc DataSet cËp nhËt vµ hiÓn thÞ th«ng tin cho 

b¶ng ®Çu tiªn trong c¬ së d÷ liÖu Global.

Chó ý: NÕu kÕt n«i connGlobal kh«ng xu¸t hiÖn trong tr×nh ®¬n, click  

vµo nót Define ®Ó t¹o nã.

Chän  REGION_ID, sau ®ã click vµo nót trõ (-). 

1) Click OK.

Dreamweaver cËp nhËt c¸c trang master  vµ detail, vµ thªm vµo tÊt c¶ 

c¸c kÞch b¶n mµ phÝa m¸y chñ cÇn vµ truy vÊn c¶ trang danh s¸ch vµ 

trang detail. 

Trang master ®îc cËp nhËt. Nã bao gåm mét b¶ng cho c¬ së d÷ liÖu, 

mét b¶ng cho ®Þnh híng trang recordset, vµ mét b¶n ghi thiÕt lËp ®Õm.

Trang detail còng cËp nhËt. Nã bao gåm mét b¶ng chÝnh lµ danh s¸ch 

chi tiÕt cho mçi b¶n ghi trong trang master.

1.4 Hiển thị các trang

TiÕp theo, chóng ta sÏ lu c¸c trang l¹i, sau ®ã më chóng ra ®Ó thÊy c¸c øng 

dông chóng ta ph¸t triÓn ho¹t ®éng nh thÕ nµo. 

1) Trong cöa sæ  Document,  chän tµi  liÖu locationDetail,  vµ chän File > 

Save ®Ó lu l¹i c«ng viÖc cña chóng ta. 

2) Trong panel  Site, chän tµi liÖu locationDetail, sau ®ã click vµo nót Put 

Files (mòi  tªn quay lªn mµu xanh) ®Ó  copy file côc bé tíi  server cña 

chóng ta.

3) Trong cöa sæ Document, chän tµi liÖu locationMaster, vµ chän File > 

Save ®Ó lu nã l¹i.



4) Trong panel  Site, chän tµi liÖu locationMaster, sau ®ã click vµo nót Put 

Files (mòi tªn quay lªn mµu xanh) ®Ó  copy file côc bé tíi  server cña 

chóng ta.



5) Víi tµi liÖu locationMaster vÉn ®îc lùa chän, Ên F12 ®Ó xem trang trong 

tr×nh duyÖt. KiÓm tra liªn kÕt tõ trang Master tíi trang Detail.

6) PhÝa díi b¶ng d÷ liÖu, click Next ®Ó thiÕt lËp tiÕp theo cña 10 b¶n ghi. 

B¶ng d÷ liÖu, thanh ®Þnh híng vµ ®Õm b¶n ghi ®îc cËp nhËt.

7) Click mét trong sè c¸c tªn vÞ trÝ ®Ó thÊy trang detail. 

Trang master ®i qua khãa chÝnh ®Õn server, server xö lý truy vÊn vµ 

trang detail më ra vµ hiÓn thi d÷ liÖu cho vÞ trÝ ®îc lùa chän.

8) Ên  nót  Locations  ë  vÞ  trÝ  phÝa  trªn  trang  ®Ó  quay  l¹i  danh  s¸ch 

locations.

9) §ãng cöa sæ tr×nh duyÖt khi chóng ta xem xong trang web. 

10) Trong  Dreamweaver, ®ãng trang web l¹i.

2. Xây d ng và chèn trang Record ự

PhÇn nµy híng dÉn chóng ta ®i qua c¸c bíc x©y dùng mét Form ®Ó chÌn 

c¸c th«ng tin vµo mét c¬ së d÷ liÖu. Chóng ta sÏ t×m hiÓu lµm thÕ nµo ®Ó chÌn 

vµ ®Þnh nghÜa c¸c trêng cña Form. Chóng ta còng sÏ t×m hiÓu c¸ch ®Ó t¹o ra 

mét trêng form cho phÐp ngêi sö dông chÌn thªm c¸c th«ng tin tù ®éng ®îc t¹o 

ra b»ng c¸ch sö dông mét tr×nh ®¬n. Chóng ta cã thÓ hoµn thµnh phÇn híng 

dÉn nµy trong tÊt c¶ c¸c m« h×nh server  ®îc hç trî bëi Dreamweaver MX - Cold 

F usion, ASP, AS P. NE T, JSP, vµ PHP.

Trong phÇn nµy chóng ta sÏ hoµn thµnh c¸c nhiÖm vô sau:

1.  T¹o mét trang Insert 

2.  Thªm c¸c ®èi tîng vaog Form

3.  §Þnh nghÜa mét  Insert Record server behavior



4.  KiÓm tra trang

2.1 Tạo một trang Insert

Trang web mµ chóng ta sÏ t¹o ra c¸c trang web cho phÐp qu¶n trÞ viªn 

míi chÌn xe cho thuª ®Þa ®iÓm th«ng tin trong c¬ së d÷ liÖu Global Car Rental.

Chóng ta sÏ b¾t ®Çu trong mét phÇn hoµn thµnh trang web. Däc theo 

con ®êng chóng ta sÏ thªm c¸c h×nh thøc ®èi tîng vµ n¨ng ®éng néi dung cho 

trang web.

H·y b¾t ®Çu b»ng viÖc lùa chän mét trang web ®Ó lµm viÖc:

2) Thùc hiÖn mét trong c¸c c¸ch sau ®Ó më panel Site.

 Trong nhãm panel Files, click vµo mòi tªn më réng, sau ®ã lùa chän 

tab Site nÕu nã cha ®îc lùa chän.

 Chän Window -> Site.

 Ên F8.

Panel Site ®îc më.

3) Trong tr×nh ®¬n pop-up, lùa chän site Global Car mµ chóng ta ®· ®Þnh 

nghÜa.

4) Trong panel Site, click ®óp chuét vµo tµi liÖu insertLocation ®Ó më nã.

Tµi liÖu ®îc më trong cöa sæ Document.





2.2 Thêm các đối tượng Form

Mét b¶ng vµ mét sè c¸c trêng cña Form ®· ®îc thªm vµo trang nµy. Mét 

mµu ®á  h×nh ch÷ nhËt xuÊt hiÖn trong tµi liÖu, ®©y lµ ranh giíi cña Form. 

Dreamweaver sÏ tù ®éng chÌn mét ranh giíi Form trong mét tµi liÖu khi chóng ta 

chÌn thªm mét  ®èi tîng Form.

B©y giê chóng ta sÏ thªm vµo c¸c trêng  cßn l¹i  cña  Form : Mét trêng 

list/menu, mét nót submit, vµ mét nót reset.

Chóng ta còng sÏ cung cÊp c¸c nh·n cho c¸c trêng cña Form. ViÖc t¹o ra tªn 

c¸c trênglµ kh¸ ®¬n gi¶n ®Ó chóng ta nhËn d¹ng nh÷ng trêng mµ chóng ta 

®ang lµm viÖc sau khi kÕt nèi Form Fields tíi c¸c trêng cña c¬ së d÷ liÖu.

Chóng ta sÏ b¾t ®Çu b»ng c¸ch xem mét trong nh÷ng form fields cã s½n.

1) Më phÇn gi¸m s¸t Property (Window > Properties),nÕu nã cha ®îc më.

2) Di chuyÓn con trá tíi « trªn cïng bªn ph¶i, click vµo trêng Form ®Ó lùa 

chän nã. 

PhÇn gi¸m s¸t Property cËp nhËt c¸c thuéc tÝnh trêng cña Form.

Trêng Name bao gåm tªn cña ®èi tîng Form, vµ trêng Char Width thiÕt 

lËp chiÒu réng cña trêng ®Õn 30 ký tù. Chóng ta sÏ cËp nhËt hai trêng 

nµy trong c¸c trêng text chóng ta ®· thªm vµo trong Form.

3) Trong tµi liÖu, ®Æt mét ®iÓm chÌn trong « phÝa ph¶i cña nh·n  State 

hoÆc Country , sau ®ã thùc hiÖn mét trong c¸c c¸ch sau ®Ó chÌn mét 

text field:

 Trong thanh Inssert,  click vµo tab Forms, sau ®ã click vµo nót 

Text Field hoÆc kÐo nã tõ thanh Insert tíi « cña b¶ng.

 Chän Insert > Form Objects > Text Field

§èi tîng text field cña Form ®· ®îc chÌn trong tµi liÖu.

4) Text field  vÉn  ®îc  lùa  chän,  trong  phÇn  gi¸m  s¸t  Property,  nhËp 

state_contrry trong « TextField vµ nhËp 30 trong « Char Width.



5) Trong tµi liÖu, ®Æt ®iÓm cÇn chÌn trong « phÝa ph¶i cña nh·n Region, 

sau ®ã lµm mét trong c¸c c¸ch sau ®Ó chÌn mét List/Menu:

 Trong môc Form cña thanh Insert, click vµo nót List/Menu hoÆc kÐo nã 

tõ thanh Insert tíi « cña b¶ng.

 Chän Insert > Form Objects > Text Field.

§èi tîng Form List/Menu ®îc chÌn vµo tµi liÖu.

6) Trong b¶ng gi¸m s¸t Property, nhËp region_id trong « List/Menu.

7) ChÌn mét Text Field cho   Telephone, sau ®ã trong môc TextField cña 

phÇn gi¸m s¸t Property ®iÒn lµ  telephone, vµ trong trêng Char Width 

nhËp 30.

8) ChÌn mét Text Field cho Fax, sau ®ã trong môc TextField cña b¶ng gi¸m 

s¸t Property ®iÒn lµ fax, vµ trong Char Width nhËp 30.

9) Trong tµi liÖu, ®Æt ®iÓm chÌn trong « cña b¶ng.

10) Thªm mét nót submit cho Form b»ng mét trong c¸c c¸ch sau:

 Trong môc Form cña thanh Insert, click vµo nót Button hoÆc kÐo nã tõ 

thanh Insert tíi « cña b¶ng.

 Chän Insert > Form Objects > Button.

Mét nót  Submit  ®îc  chÌn vµo tµi  liÖu.  Trong phÇn gi¸m s¸t  Property, 

Submit lµ mét nh·n vµ Action lµ ®Ó thiÕt lËp tíi Form Submit.



11) LÆp bíc 10 ®Ó thªm mét nót kh¸c cho Form. Chóng ta sÏ thªm nót resest 

®Ó ngêi dïng x¸c lËp l¹i Form nÕu hä cÇn.

12) Trong phÇn gi¸m s¸t Property, t¹i phÇn Action chän Reset form.

13) Trong « textbox Button Name, nhËp Reset.

Form cña chóng ta b©y giê ®· hoµn thµnh vµ nã sÏ gièng nh thÕ nµy:

14)Lu tµi liÖu l¹i.

2.3 Định nghĩa các trường của form List/Menu

Giê chóng ta sÏ cËp nhËt thªm th«ng tin cho trêng list/menu mµ sÏ ®Ó cho mét 

ngêi sö dông lùa chän trong phÇn region. Vµ cËp nhËt c¬ së d÷ liÖu víi gi¸ trÞ 

sè cña nã. B»ng c¸ch nµy mét ngêi sö dông kh«ng cÇn ph¶i kiÓm tra x¸c minh 

sè nµo phï hîp víi tªn nµo

1) Trong tµi liÖu, click vµo trêng Region_Id list/menu ®Ó lùa chän nã.

PhÇn gi¸m s¸t Poperty cËp nhËt th«ng tin vÒ ®èi tîng.

2) Trong phÇn gi¸m s¸t Property, click vµo nót List Values.

Hép tho¹i List/Menu xuÊt hiÖn.

3) Trong hép tho¹i List Values, thªm Item Labels vµ Values ®Ó phï hîp víi 

d÷ liÖu trong b¶ng c¬ së d÷ liÖu REGIONS.

4) Trong Item Label, nhËp North America, Ên Tab vµ trong Value nhËp 1.

5) Click  vµo  nót  céng  (+)  ®Ó  thªm  c¸c  môc  nhËp  kh¸c,  sau  ®ã  nhËp 

South/Central America, ÊnTab, sau ®ã nhËp 2.



6) LÆp bíc 4 vµ bíc 5 cho ®Õn khi chóng ta nhËp tÊt c¶ c¸c vïng nh b¶ng 

hép tho¹i sau.

7) Click OK ®Ó ®ãng hép tho¹i.

2.4 Định nghĩa một InsertRecord server behavior.

Chóng ta sÏ sö dông mét hµnh vi phôc vô ®Ó t¹o ra nh÷ng kÞch b¶n server cÇn 

thiÕt cho øng dông. Chóng ta sÏ t¹o ra mét kÕt nèi gi÷a d÷ liÖu cña trêng Form 

vµ d÷ liÖu c¬ së d÷ liÖu ®Ó hoµn thµnh Form  vµ khi click vµo nót Submit sÏ 

chÌn th«ng tin vµo trong c¬ së d÷ liÖu.

1) Trong panel Server Behaviors (Window > Server Behaviors), click vµo 

nót céng (+) vµ chän Insert Record tõ tr×nh ®¬n pop-up.

B¶ng hép tho¹i Insert Record xuÊt hiÖn.

2) Trong Data Source (ColdFusion)  hoÆc tr×nh ®¬n pop-up Connection 

(c¸c m« h×nh server kh¸c), chän connGlobal.

3) Trong tr×nh ®¬n pop-up Insert Into Table, chän LOCATIONS.



Danh s¸ch Columns cËp nhËt th«ng tin vÒ c¸c trêng cña Form liªn quan ®Õn 

c¸c trêng cña c¬ së d÷ liÖu nh thÕ nµo.

4) H·y ch¾c ch¾n r»ng gi¸ trÞ cña REGION_ID ®îc thiÕt lËp lµ Number 

hoÆc Integer (ASP.NET), Region ID lµ mét gi¸ trÞ sè h¬n  lµ mét gi¸ trÞ 

text.

5) Trong  After Inserting, Go To hoÆc On Success, Go To (ASP.NET), click 

Browse vµ trong b¶ng hép tho¹i xuÊt hiÖn lùa chän file LocationOK, sau 

®ã click OK ®Ó ®ãng b¶ng hép tho¹i. 

6) Click OK ®Ó ®ãng b¶ng hép tho¹i Insert Record.

Trong cöa sæ Document,  form updates vµ panel Server Behaviors chØ 

ra hµnh vi Insert Record ®· ®îc thªm vµo.

7) Lu tµi liÖu l¹i.

2.5 Test trang

TiÕp theo, chóng ta sÏ hoµn thµnh trang vµo server, sau ®ã më nã trong 

mét tr×nh duyÖt vµ chÌn thªm mét sè th«ng tin.

1) Trong panel Site, lùa chän insertLocation, sau ®ã click vµo nót Put Files 

(mòi tªn quay lªn mµu xanh) ®Ó copy file côc bé tíi server. Chän Yes khi 

®îc hái ®Ó copy c¸c file phô thuéc. 

2) Sau khi lùa chän  InsertLocation, trong cöa sæ Document, chän File > 

Preview in Browser hoÆc Ên F12 (Windows) ®Ó xem tµi liÖu. 

3) NhËp test data trong form, sau ®ã click vµo nót Submit.

Trang locationOK xuÊt hiÖn chØ ra th«ng tin ®· ®îc chÌn thµnh c«ng 

trong c¬ së d÷ liÖu Global.

4) §Ó xem c¸c môc  mµ chóng ta ®· thªm vµo c¬ së d÷ liÖu lµm theo c¸c  

c¸ch sau:

Trong nhãm panel Application, lùa chän panel Databases. X¸c ®Þnh vÞ trÝ 

cña c¬ së d÷ liÖu connGlobal, sau ®ã bÊm vµo dÊu céng (+) ë phÝa tríc cña 

nã, ®Ó më réng nã. NhÊp vµo céng (+) ë phÝa tríc Tables ®Ó xem c¬ së d÷ 

liÖu cña b¶ng . Right-click (Windows) vµo b¶ng LOCATIONS vµ sau ®ã chän 

View Data. C¸c b¶n ghi cña C¬ së d÷ liÖu xuÊt hiÖn, b¶n ghi míi ë phÝa díi 

cïng trong c¬ së d÷ liÖu.



3. Th c hànhự

Sö dông CSDL qlsv vµ Dreamweaver thùc hiÖn c¸c yªu cÇu sau:

1. ThiÕt kÕ mét Form d¨ng nhËp ®Ó ®¨ng nhËp vµo hÖ thèng gièng h×nh 

sau:

2. T¹o trang master trong ®ã cã liªn kÕt ®Õn c¸c trang detail gièng h×nh 

sau:

3. HiÓn thÞ c¸c chøc n¨ng cña trang detail khi ta click vµo bÊt kú mét liªn 

kÕt nµo, ch¼ng h¹n khi ta click vµo liªn kÕt “Thªm sinh viªn míi” ch¬ng 

tr×nh sÏ cho ta mét trang “Thªm sinh viªn míi” nh sau:
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